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1 Introduction

1.1 Purpose of the Operating Guide
The purpose of this operating guide is to describe the VLT® Integrated Servo Drive ISD 510/DSD 510 System.

This operating guide contains information about:

Installation

Commissioning

Programming

Operation

Troubleshooting

Service and Maintenance

This operating guide is intended for use by quali�ed personnel. Read the operating guide in full to use the servo system safely and
professionally, and pay particular attention to the safety instructions and general warnings.

This operating guide is an integral part of the servo system and also contains important service information. Therefore always keep
this operating guide available with the servo system.

Compliance with the information in the manual is a prerequisite for:

Trouble-free operation

Recognition of product liability claims

Therefore, read this operating guide before working with the VLT® Integrated Servo Drive ISD 510/DSD 510 system.

1.2 Additional Resources
Table 1: Additional Resources

Manual Description

VLT® Integrated Servo Drive System ISD 510, DSD 510
Operating Instructions

Information about the installation, commissioning, and operation of the
ISD 510/DSD 510 servo system.

VLT® Servo Drive System ISD 510, DSD 510, MSD 510
(VLT® Flexmotion™) Design Guide

Information about the setup of the ISD 510/DSD 510 servo system and
detailed technical data.

VLT® Servo Drive System ISD 510, DSD 510, MSD 510
(VLT® Flexmotion™) Programming Guide

Information about the programming of the ISD 510, DSD 510, and
MSD 510 servo systems.

1.3 Copyright
VLT® and ISD® are Danfoss registered trademarks.

1.4 Approvals and Certi�cations
The VLT® Servo Drive Systems ISD 510, DSD 510, MSD 510 comply with the standards and directives detailed in Table 2.

Table 2: Product and System Approvals and Certi�cations

Certi�cation Description

IEC/EN 61800-3 Adjustable speed electrical power drive systems.

Part 3: EMC requirements and speci�c test methods.

IEC/EN 61800-5-1 Adjustable speed electrical power drive systems.

Part 5-1: Safety requirements - Electrical, thermal, and energy.

IEC/EN 61800-5-2 Adjustable speed electrical power drive systems.

Part 5-2: Safety requirements - Functional.

IEC/EN 61508-1 Functional safety of electrical/electronic/programmable electronic safety-related systems.
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Certi�cation Description

Part 1: General requirements.

IEC/EN 61508-2 Functional safety of electrical/electronic/programmable electronic safety-related systems.

Part 2: Requirements for electrical/electronic/programmable electronic safety-related systems.

EN ISO 13849-1 Safety of machinery - Safety-related parts of control systems.

Part 1: General principles for design.

EN ISO 13849-2 Safety of machinery - Safety-related parts of control systems.

Part 2: Validation.

IEC/EN 60204-1 Safety of machinery - Electrical equipment of machines.

Part 1: General requirements.

IEC/EN 62061 Safety of machinery - Functional safety of safety-related electrical, electronic, and programmable elec-
tronic control systems.

IEC/EN 61326-3-1 Electrical equipment for measurement, control, and laboratory use - EMC requirements.

Part 3-1: Immunity requirements for safety-related systems and for equipment intended to perform safe-
ty-related functions (functional safety) - General industrial applications.

IEC/EN 60529 Degrees of protection provided by enclosures (IP Code).

UL 508C UL Standard for Safety for Power Conversion Equipment.

(Only applies to ISD 510 servo drive sizes 1 and 2.)

UL 61800-5-1 Adjustable speed electrical power drive systems.

Part 5-1: Safety requirements - Electrical, thermal, and energy.

ISD 510 servo drive sizes 3 and 4 and DSD 510:

MSD 510:

CSA C22.2 No.
274-13 (2013)

Standard specifying requirements for adjustable speed drives with respect to electrical, thermal, and en-
ergy safety considerations.

Applies to ISD 510 sizes 1 and 2.

CSA C22.2 No.
274-17 (2017)

Standard specifying requirements for adjustable speed drives with respect to electrical, thermal, and en-
ergy safety considerations.

Applies to:

ISD 510 sizes 3 and 4

DSD 510

MSD 510

CE
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Certi�cation Description

2014/30/EU Electromagnetic Compatibility (EMC) Directive.

2014/35/EU Low Voltage Directive (LVD).

(2011/65/EU) amen-
ded (EU) 2015/863

Restriction of Hazardous Substances (RoHS).

2006/42/EC Machinery Directive (MD).

EtherCAT® Ethernet for Control Automation Technology. Ethernet-based �eldbus system.

Ethernet POWER-
LINK®

Ethernet-based �eldbus system.

PROFINET RT/IRT® Ethernet-based �eldbus system.

PLCopen® Technical speci�cation. Function blocks for motion control (formerly Part 1 and Part 2) Version 2.0 March
17, 2011.

1.5 Firmware Updates
Updates to the �rmware, VLT® Servo Toolbox software, and PLC libraries may be available. When updates are available, they can be

downloaded from the Danfoss website (http://drives.danfoss.com). Use the VLT® Servo Toolbox software or the PLC libraries to install

the �rmware on the servo drives or on the PSM 510 and DAM 510.

1.6 Terminology
Table 3: Terminology

Term Description

ACM 510 Auxiliary Capacitors Module

DAM 510 Decentral Access Module that connects the Danfoss decentral servo drives (ISD 510 and DSD 510) to
the servo system via a hybrid cable.

DSD 510 Decentral Servo Drive

DSD 510 system compo-
nents

Includes DSD 510 servo drives, PSM 510, DAM 510, and the optional ACM 510 and EXM 510.

EXM 510 Expansion module for splitting system modules between 2 control cabinets.

Feed-in cable Hybrid cable for connection from the DAM 510 to the 1st servo drive.

ISD 510 Integrated Servo Drive

ISD 510 system compo-
nents

Includes ISD 510 servo drives, PSM 510, DAM 510, and the optional ACM 510 and EXM 510.

LCP Local Control Panel

Loop cable Hybrid cable for connecting servo drives in daisy-chain format.

PLC Programmable Logic Controller (external device for controlling the servo system).

PSM 510 Power Supply Module that generates a 565–680 V DC supply.

System modules Includes PSM 510, DAM 510, and the optional ACM 510.

VIN PSM Input of PSM 510 (V AC).
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Term Description

VOUT PSM Output of PSM 510 (V DC).
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2 Safety

2.1 Safety Symbols
The following symbols are used in this guide:

W A R N I N G
Indicates a potentially hazardous situation that could result in death or serious injury.

C A U T I O N
Indicates a potentially hazardous situation that could result in minor or moderate injury. It can also be used to alert against unsafe

practices.

N O T I C E
Indicates important information, including situations that can result in damage to equipment or property.

2.2 Important Safety Warnings
The following safety instructions and precautions relate to the ISD 510/DSD 510 servo system. Read the safety instructions carefully
before starting to work in any way with the servo system or its components. Pay particular attention to the safety instructions in the
relevant sections of this manual.

W A R N I N G
HAZARDOUS SITUATION

If the ISD 510/DSD 510 system components, or the bus lines are incorrectly connected, there is a risk of death, serious injury, or

damage to the unit.

Always comply with the instructions in this manual and national and local safety regulations.

W A R N I N G
HIGH VOLTAGE

The servo system contains components that operate at high voltage when connected to the electrical supply network. There are

no indicators on the components that indicate the presence of mains supply. Incorrect installation, commissioning, or mainte-

nance may lead to death or serious injury.

Installation, commissioning, and maintenance may only be performed by quali�ed personnel.

W A R N I N G
LEAKAGE/GROUNDING CURRENT HAZARD

Leakage/grounding currents are >3.5 mA. Improper grounding of the ISD 510/DSD 510 servo drives and the system modules may

result in death or serious injury.

For reasons of operator safety, use a certi�ed electrical installer to ground the system correctly in accordance with the appli-
cable local and national electrical standards and directives, and the instructions in this manual.
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W A R N I N G
DISCHARGE TIME

The servo system contains DC-link capacitors that remain charged for some time after the mains supply is switched o� at the

Power Supply Module (PSM 510). Failure to wait the speci�ed time after power has been removed before performing service or

repair work could result in death or serious injury.

To avoid electrical shock, fully disconnect the Power Supply Module (PSM 510) from the mains and wait for the capacitors to
fully discharge before carrying out any maintenance or repair work on the servo system or its components.

Minimum waiting time (minutes)

15

D A N G E R

Risque du choc électrique. Une tension dangereuse peut être présentée jusqu’à 15 min après avoir coupé l’alimentation.

W A R N I N G
UNINTENDED START

The servo system contains servo drives, the PSM 510, and DAM 510 that are connected to the electrical supply network and can

start running at any time. This may be caused by a �eldbus command, a reference signal, or clearing a fault condition. Servo

drives and all connected devices must be in good operating condition. A de�cient operating condition may lead to death, serious

injury, damage to equipment, or other material damage when the unit is connected to the electrical supply network.

Take suitable measures to prevent unintended starts.

W A R N I N G
UNINTENDED MOVEMENT

Unintended movement may occur when parameter changes are carried out immediately, which may result in death, serious in-

jury, or damage to equipment.

When changing parameters, take suitable measures to ensure that unintended movement cannot pose any danger.

C A U T I O N
DANGER OF BURNS

The surface of the servo drives can reach high temperatures of over 90°C during operation.

Do not touch the servo drives until they have cooled down.

N O T I C E
RCD COMPATIBILITY

The servo system contains components that can cause a DC current in the protective earthing conductor, which may result in

malfunction in any devices connected to the system.

Where a residual current-operated protective (RCD) or monitoring (RCM) device is used for protection in case of direct or
indirect contact, use a type B RCD or RCM device on the supply side of the system components.
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N O T I C E
CONNECTING/DISCONNECTING HYBRID CABLES

Never connect or disconnect the hybrid cable to or from the servo drives when the servo system is connected to mains or auxili-

ary supply, or when voltage is still present. Doing so damages the electronic circuitry. Ensure that the mains supply is disconnec-

ted and the required discharge time for the DC-link capacitors has elapsed before disconnecting or connecting the hybrid cables

to the PSM 510.

To avoid electrical shock, fully disconnect the PSM 510 from the mains and wait for the discharge time to elapse before dis-
connecting or connecting the hybrid cables or disconnecting cables from the PSM 510.

2.3 Safety Instructions and Precautions
Compliance with the safety instructions and precautions is necessary at all times.

Orderly and proper transport, storage, �tting, and installation, as well as careful operation and maintenance, are essential for the
trouble-free and safe operation of the servo system and its components.

Only suitably trained and quali�ed personnel may work on the servo system and its components or in its vicinity.

Only use accessories and spare parts approved by Danfoss.

Comply with the speci�ed ambient conditions.

The information in this manual about the use of available components is provided solely by way of examples of applications
and suggestions.

The plant engineer or system engineer is personally responsible for checking the suitability of the supplied components and the
information provided in this manual for the speci�c application concerned:

For compliance with the safety regulations and standards relevant to the speci�c application.

For implementing the necessary measures, changes, and extensions.

Commissioning the servo system or its components is not allowed until it has been ascertained that the machine, system, or
plant in which they are installed conforms to the statutory provisions, safety regulations, and standards that apply to the appli-
cation in the country of use.

Operation is only allowed in compliance with the national EMC regulations for the application concerned.

Compliance with the limit values speci�ed by national regulations is the responsibility of the producer of the plant, system, or
machine.

Compliance with the speci�cations, connection conditions, and installation conditions in this manual is mandatory.

The safety regulations and safety provisions of the country in which the equipment is used must be observed.

To protect the user against electrical shock and to protect the servo system against overload, protective grounding is obligatory
and must be performed in accordance with local and national regulations.

2.3.1 Operational Safety
Operational safety

Safety-related applications are only allowed if they are explicitly and unambiguously mentioned in this manual.

All applications that can cause hazards to people or damage to property are safety-related applications.

The stop functions implemented in the software of the PLC do not interrupt the mains supply to the Power Supply Module
(PSM 510). Therefore, they must not be used for electrical safety for the servo system.

The servo system can be brought to a stop by a software command or a zero speed setpoint, however DC voltage remains
present on the servo drives and/or mains voltage in the PSM 510. Also, when the system is stopped, it may start up again on its
own if the circuitry is defective or after the elimination of a temporary overload, a problem with the supply voltage, or a prob-
lem with the system. If personal safety considerations (for example, risk of personal injury caused by contact with moving ma-
chine parts after an unintended start) make it necessary to ensure that an unintended start cannot occur, these stop functions
are not su�cient. In this case, ensure that the servo system is detached from the mains network, and prevent unintended motor
starting, for example by using the Safe Torque O� function.
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The servo system may start running unintentionally during parameter con�guration or programming. If this poses a risk to per-
sonal safety (for example, risk of personal injury due to contact with moving machine parts), prevent unintended motor starting,
for example by using the Safe Torque O� function, or by safe disconnection of the servo drives.

In addition to the L1, L2, and L3 supply voltage inputs on the PSM 510, the servo system has other supply voltage inputs, includ-
ing external auxiliary voltage. Before commencing repair work, check that all supply voltage inputs have been switched o� and
that the necessary discharge time for the DC-link capacitors has elapsed.

2.4 Quali�ed Personnel
Installation, commissioning, and maintenance may only be carried out by quali�ed personnel. For the purposes of this manual and
the safety instructions in this manual, quali�ed personnel are trained personnel who are authorized to �t, install, commission,
ground, and label equipment, systems, and circuits in accordance with the standards for safety technology and who are familiar
with the safety concepts of automation engineering.

Additionally, the personnel must be familiar with all the instruction and safety measures described in this manual. They must have
suitable safety equipment and be trained in �rst aid.

2.5 Due Diligence
The operator and/or fabricator must ensure that:

The servo system and its components are used only as intended.

The components are operated only in a perfect operational condition.

The operating instructions are always available near the servo system in complete and readable form.

The servo system and its components are �tted, installed, commissioned, and maintained only by adequately quali�ed and au-
thorized personnel.

These personnel are regularly instructed on all relevant matters of occupational safety and environmental protection, as well as
the contents of the operating instructions and the instructions it contains.

The product markings and identi�cation markings applied to the components, as well as safety and warning instructions, are
not removed and are always kept in a legible condition.

The national and international regulations regarding the control of machinery and equipment, that are applicable at the place
of use of the servo system, are complied with.

The users always have all current information relevant to their interests about the servo system and its use and operation.

2.6 Intended Use
The components of the servo system are intended to be installed in machines used in industrial environments in accordance with
local laws and standards.

N O T I C E

In a domestic environment, this product may cause radio interferences, in which case supplementary mitigation measures
may be required.

To ensure that the product is used as intended, the following conditions must be ful�lled before use:

Everyone who uses Danfoss products in any manner must read and understand the corresponding safety regulations and the
description of the intended use.

Do not alter hardware from its original state.

Do not reverse-engineer software products or alter their source code.

Do not install or operate damaged or faulty products.

Ensure that the products are installed in conformance with the regulations mentioned in the documentation.

Observe any speci�ed maintenance and service intervals.

Comply with all protective measures.

Only �t or install the components described in this operating guide. Third-party devices and equipment may be used only in
consultation with Danfoss.

2.6.1 Prohibited Application Areas
The servo system may not be used in the following application areas:
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Areas with potentially explosive atmospheres.

Mobile or portable systems.

Floating or airborne systems.

Inhabited facilities.

Sites where radioactive materials are present.

Areas with extreme temperature variations or in which the maximum rated temperatures may be exceeded.

Under water.

2.7 Forseeable Misuse
Any use not expressly approved by Danfoss constitutes misuse. This also applies to failure to comply with the speci�ed operating
conditions and applications. Danfoss assumes no liability of any sort for damage attributable to improper use.

2.8 Service and Support
Contact the local service representative for service and support.
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3 System Description

3.1 Overview of the ISD 510/DSD 510 System

AC 400–480 V . . .

ISD 510

UDC + Real-Time Ethernet Bus + STO + UAUX

UDC + Real-Time Ethernet Bus + STO + UAUX

DSD 510

. . .
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Illustration 1: Overview of the VLT® Integrated Servo Drive ISD 510/DSD 510 System

1 AC line choke

The VLT® Servo Drive System ISD 510/DSD 510 is a high-performance decentral servo motion solution. In this decentral system, the

ISD 510/DSD 510 servo drives are operated in a DC group and controlled by a PLC. The decentralization of the drive unit o�ers
bene�ts in mounting, installation, and operation.

Hybrid cables are used to connect the ISD 510/DSD 510 servo drives, making installation fast and simple. These hybrid cables con-
tain the DC-link supply, the Real-Time Ethernet, UAUX, and STO signals.

The ISD 510/DSD 510 system is designed to accommodate various servo drives and consists of:

VLT® Integrated Servo Drive ISD® 510.

VLT® Decentral Servo Drive DSD 510.

A central power supply: Power Supply Module (PSM 510).

Decentral Access Module (DAM 510).

Auxiliary Capacitors Module (ACM 510), optional

Expansion Module (EXM 510), optional

Cabling infrastructure.

Blind caps

Software
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Firmware for the servo drive

Firmware for the PSM 510, DAM 510, and ACM 510

PC software tool: VLT® Servo Toolbox

PLC libraries

DanfossMotion library for ISD 510/DSD 510 system for AutomationStudio™.

DanfossMotion library for ISD 510/DSD 510 system for TwinCAT® 2 and 3.

DanfossMotion library for ISD 510/DSD 510 system for SIMOTION SCOUT® and TiA Portal.

The system modules PSM 510, DAM 510, and ACM 510 are mounted to a backplate located in the control cabinet. DC link and the
control voltage supply are integrated in the backplate. The 'click and lock' backplate concept o�ers easy mounting and installation.

The ISD 510 servo drives are self-contained distributed drives, whereby the drive electronics is housed together with the motor in
the same casing. The DSD 510 servo drives are decentral servo drives for mounting close to the servo motor.

There are 2 versions of the ISD 510/DSD 510 servo drive:

Version ISD 510/DSD 510

Standard With 2 hybrid connectors (M23) that connect power and communication signals from a hybrid cable.

Advanced As standard plus 3 additional interfaces for external encoder or I/Os, �eldbus devices, and for the local control panel
(LCP) to be connected directly.

The motion control is integrated into the servo drive so that the motion sequences can take place independently. This reduces the
required computing power of the central PLC and o�ers a highly �exible drive concept. Danfoss o�ers libraries for various IEC
61131-3 programmable PLCs. Due to the standardized and certi�ed �eldbus interfaces of the devices, any PLC with an EtherCAT®

master functionality, or Ethernet POWERLINK® or PROFINET® managing node functionality according to the standards can be used.

N O T I C E

The ISD 510/DSD 510 servo drives cannot be used in servo systems from other manufacturers without changing the cabling
infrastructure.

Drives from other manufacturers cannot be used in the ISD 510/DSD 510 system when using Danfoss hybrid cables.

Size 1 and 2 ISD 510 servo drives cannot be combined on the same line with size 3 and 4 ISD 510 servo drives and DSD 510
servo drives.

Only the components described in this manual may be �tted or installed. Third-party devices and equipment may be used
only in consultation with Danfoss.

Contact Danfoss for further information.

3.1.1 Application Examples
There are numerous potential areas of application for the servo system as per the following examples.

Beverage machines

Labeling

Capping

Filling

PET blow-moulding

Digital bottle printing

Food and beverage packaging machines:

Flow wrapping

Bag maker

Tray sealing

Shrink wrapping

Industrial and pharmaceutical packaging machines:
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Palletization

Top loader

Cartoning

Tube �lling

Blister machine

Liquid �lling

Solid dosing

3.2 VLT® Integrated Servo Drive ISD 510

3.2.1 Overview of the ISD 510 Servo Drive
ISD is the abbreviation of integrated servo drive, which is a compact drive with an integrated permanent magnet synchronous mo-
tor (PMSM). This means that the entire power drive system consisting of motor, position sensor, mechanical brake, and also power
and control electronics is integrated into 1 housing. Additional circuits, such as low voltage supply, bus drivers, and functional safety
are implemented within the servo drive electronics. All ISD 510 servo drives have 2 hybrid connectors (M23) that connect power and
communication signals from a hybrid cable. The advanced version has 3 additional interfaces for external encoder or I/Os, �eldbus
devices, and for the local control panel (LCP) to be connected directly.

LEDs on the top of the ISD 510 servo drive show the current status. Data transfer takes place via Real-Time Ethernet.
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1 Operating LEDs

2 Connectors

3.2.2 Motor and Flange Sizes
Table 4: Motor and Flange Sizes

Size 1, 1.5

Nm

Size 2, 2.1

Nm

Size 2, 2.9

Nm

Size 2, 3.8

Nm

Size 3, 5.2

Nm

Size 3, 6.0

Nm

Size 4, 11.2

Nm

Size 4, 13.0

Nm(1)

Flange
size

76 mm 84 mm 110 mm 138 mm –

1 In preparation

3.2.3 ISD 510 Servo Drive Types

N O T I C E

The Drive Con�gurator shows the valid con�guration of servo drive variants. Only valid combinations are shown. Therefore,
not all variants detailed in the type code are visible.
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Table 5: Type Code ISD 510

1–3 4–6 7 8 9–12 13–14 15–17 18–20 21–22 23–25 26 27–30 31–32 33–35 36 37 38 39–40

ISD 510 T D6 T SX

Table 6: Legend to Type Code

[01–03] Product group [18–20] Drive feedback [33–35] Motor speed

ISD VLT® Integrated Servo Drive FRX Resolver N46 Rated speed 4600 RPM

[04–06] Product variant FS1 Single-turn feedback 17 bit N40 Rated speed 4000 RPM

510 ISD® 510 FM1 Multi-turn feedback 17 bit N30 Rated speed 3000 RPM

[07] Hardware con�guration [21–22] Bus system N29 Rated speed 2900 RPM

A Advanced PL Ethernet POWERLINK® N24 Rated speed 2400 RPM

S Standard EC EtherCAT® N20 Rated speed 2000 RPM

[08] Drive torque PN PROFINET® [36] Mechanical brake

T Torque [23–25] Firmware X Without brake

[09–12] Torque SXX Standard B With brake

01C5 1.5 Nm SC0 Customized [37] Motor shaft

02C1 2.1 Nm [26] Safety S Standard smooth shaft

02C9 2.9 Nm T Safe Torque O� (STO) K Standard �tted key

03C8 3.8 Nm [27–30] Flange size [38] Motor sealing

05C2 5.2 Nm F076 76 mm X Without sealing

06C0 6.0 Nm F084 84 mm S With sealing

11C2 11.2 Nm F108 108 mm [39–40] Surface coating

13C0 13.0 Nm(1) F138 138 mm SX Standard

[13–14] DC voltage [31–32] Flange type CX Customized

D6 600 V DC-link voltage SX Standard

[15–17] Drive enclosure C0 Customized

E54 IP54

E67 IP67 (shaft IP65)

1 In preparation

3.2.4 Motor Components

3.2.4.1 Shaft
The shaft transfers the motor force (torque) to the machine coupled to the shaft. The shaft material is C45+C or equivalent according
to EN 10277-2. Depending on the mounting position, the ISD 510 servo drives can be sealed by a shaft seal (optional) to achieve
IP65 on the A-side of the motor (see 11.11.1 Protection Ratings for ISD 510 Servo Drive for further information).
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3.2.4.2 Brake (Optional)
The optional mechanical holding brake is designed as a single-disc brake. The emergency stop function can be initiated at most
once every 3 minutes and up to 2000 times in total, depending on the load.

The e�ective holding torque is:

Size 1: 2.5 Nm

Size 2: 5.3 Nm

Size 3: 14.5 Nm

Size 4: 25 Nm

The brake operates as a holding brake according to the fail-safe principle closed when no current. It is powered from the 24 V DC
auxiliary supply. This enables low-backlash load holding when no current is present.

Electrical data: Power consumption:

Size 1: 1.5 W

Size 2: 1.8 W

Size 3: 3.5 W

Size 4: 5 W

N O T I C E

Do not misuse the holding brake as a working brake because this causes increased wear, resulting in premature failure.

Using ISD 510 servo drives with brakes can reduce the number of drives allowed, depending on the total length of each
hybrid line.

3.2.4.3 Cooling
The ISD 510 servo drives are self-cooling. Cooling (heat dispersal) is primarily via the �ange, with a small amount dispersed by the
housing.

3.2.4.4 Thermal Protection
Thermal sensors monitor the maximum allowable temperature of the motor winding and switch the motor o� if the limit of 150 °C is
exceeded. Thermal sensors are also present in the drive to protect the electronics against overtemperature. An error message is sent
via Real-Time Ethernet to the higher-level PLC and is also shown on the LCP.

3.2.4.5 Built-in Feedback Devices
The built-in feedback device measures the rotor position. There are 3 feedback variants available:

Resolver

BiSS-B 17 bit single-turn encoder

BiSS-B 17 bit multi-turn encoder

Data/type Resolver Single-turn encoder Multi-turn encoder

Signal Sin/cos BiSS-B BiSS-B

Accuracy ±10 arcmin ±1.6 arcmin ±1.6 arcmin

Resolution 14 bit 17 bit 17 bit

Maximum number of turns – – 4096 (12 bit)

3.2.5 Drive Components

3.2.5.1 Connectors on the ISD 510 Servo Drives
This section details all possible connections for the standard and advanced servo drive.

There are 5 connectors on the ISD 510 servo drives.
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Illustration 2: Connectors on the ISD 510 Servo Drive

Table 7: Connectors on the ISD 510 Servo Drive

Connector Description

X1 M23 connector for feed-in or loop hybrid cable input

X2 M23 connector for loop hybrid cable output or �eldbus extension cable

X3 (advanced version only) M8 connector for Ethernet cable (minimum CAT5, shielded)

X4 (advanced version only) M12 connector for I/O and/or encoder cable (shielded)

X5 (advanced version only) M8 connector for LCP cable (shielded)

N O T I C E

Detailed information on each of the connectors can be found in 11.8 Connectors on the ISD 510/DSD 510 Servo Drive.

3.3 VLT® Decentral Servo Drive DSD 510

3.3.1 Overview of the DSD 510 Servo Drive
DSD is the abbreviation of decentral servo drive, which is a servo drive for mounting close to the servo motor. In this way, the servo
motor has no impact to the DSD 510 servo drive from a thermal point of view.

The DSD 510 servo drive extends the selection of a decentral servo drive concept. It delivers rated power up to 4.5 kW and can be
used with a wide range of permanent magnet servo motors and motor feedback encoders.

LEDs on the top of the DSD 510 servo drive show the current status. Data transfer takes place via Real-Time Ethernet.

3.3.2 DSD 510 Servo Drive Types

N O T I C E

The Drive Con�gurator shows the valid con�guration of servo drive variants. Only valid combinations are shown. Therefore,
not all variants detailed in the type code are visible.

Table 8: Type Code DSD 510

1–3 4–6 7 8–12 13–14 15–17 18–20 21–22 23–25 26 27–28 29–30 31–38 39–40

DSD 510 C08A0 D6 E67 SXX T F2 XXXXXXXX
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Table 9: Legend to Type Code

[01–03] Product group [18–20] (continued) Drive feedback (continued)

DSD VLT® Decentral Servo Drive FHD HIPERFACE DSL()

[04–06] Product variant [21–22] Bus system

510 DSD 510 PL Ethernet POWERLINK®

[07] Hardware con�guration EC EtherCAT®

A Advanced PN PROFINET®

S Standard [23–25] Firmware

[08–12] Current rating SXX Standard

C08A0 8.0 Arms [26] Safety

[13–14] DC voltage T Safe Torque O� (STO)

D6 600 V DC-link voltage [27–28] Frame size

[15–17] Protection rating F2 (F2) Frame size 2

E67 IP67 [29–30] Motor connection

[18–20] Drive feedback S1 (S1) Single plug version motor side

FXX Without feedback/Sensorless() S2 (S2) Dual plug version motor side

FRX Resolver [31–38] Reserved

FS1 BiSS single-turn feedback 17 bit – Reserved

FM1 BiSS multi-turn feedback 17 bit [39–40] Surface coating

FE1 EnDat 2.1 SX Standard

FE2 EnDat 2.2 CX Customized

FHF HIPERFACE

3.3.3 Connectors on the DSD 510 Servo Drives
The DSD 510 servo drives have the same X1-X5 connectors as the ISD 510 servo drives (see 3.2.5.1 Connectors on the ISD 510 Servo
Drives). In addition to the X1-X5 connectors, the DSD 510 servo drives have 2 further connectors: X6 and X7.
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Illustration 3: X6 and X7 Connectors on the DSD 510 Servo Drive

Table 10: Connectors on the DSD 510 Servo Drive

Connector Description

X6 M23 8-pole motor power connector

X7 M23 17-pole motor feedback connector

The maximum cable length from the DSD 510 to the motor is 5 m.

N O T I C E

The DSD 510 servo drives are available with single plug version for speci�cations HIPERFACE DSL, EnDat 2.2, and sensorless.
This plug is for a hybrid cable containing both the motor and the feedback cables.

All other speci�cations use the double plug version with separate motor and feedback cables.

3.4 Power Supply Module (PSM 510)

3.4.1 Overview
PSM is the abbreviation for Power Supply Module. It is the power supply to the servo system. The PSM 510 supplies a DC power
voltage and guarantees high-density output. The DC-link and 24/48 V DC are distributed via the backlink in the backplates to all
system modules. The PSM 510 can be controlled via Ethernet-based �eldbus.

LEDs on the front of the PSM 510 show the operating status and warnings.

N O T I C E

The system modules are designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at
least IP54.

The PSM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

The PSM 510 may be damaged if exposed to �uids.

All power cables are wired into the PSM 510, therefore at least 1 PSM 510 is required for each system.

The PSM 510 also performs service functions, such as voltage measuring, and is cooled by an internal fan.

The PSM 510 is available in 3 power sizes and delivers an output power of 10 kW, 20 kW, or 30 kW with 200% overload capacity for 3
seconds. To achieve an output power of up to 60 kW, 2 PSM 510 modules can be used in parallel.

An example type code for the PSM 510 is: MSD510PSM510F2P10C0D6E20PLSXXXXXXXXXXXXX.
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Illustration 4: PSM 510

1 Backplate

2 24/48 V input connector

3 Cable relief and shielding

4 Connectors: I/O, STO, relay, and Ethernet

5 Operating LEDs

6 LCP connector

7 PE screw

8 AC mains supply connector

9 Internal/external brake resistor connector

3.5 Decentral Access Module (DAM 510)

3.5.1 Overview
DAM is the abbreviation for Decentral Access Module. The DAM 510 is a central interface/gateway to the decentral servo system. It is
used to connect the Danfoss VLT® Integrated Servo Drives ISD 510 and VLT® Decentral Servo Drives DSD 510 to the servo system via

a hybrid feed-in cable.

The DAM 510 supplies the decentral servo drives with DC-link, UAUX, STO, and the Ethernet-based �eldbus via the hybrid feed-in

cable. The DAM 510 provides functions, such as:

Overcurrent protection of the hybrid cable

Overvoltage protection

Charging circuit of the DC-link

External encoder connection

DC-link capacitance bu�er for the decentral servo drives

The DAM 510 can be controlled via Ethernet-based �eldbus.

LEDs on the front of the DAM 510 show the operating status and warnings.
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N O T I C E

The system modules are designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at
least IP54.

The DAM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

The DAM 510 can be damaged if exposed to �uids.

An example type code for the DAM 510 is: MSD510DAM510F1C015AD6E20PLSXXXXXXXXXXXXX.
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Illustration 5: DAM 510

1 Connectors: STO, Ethernet, and external encoder

2 Operating LEDs

3 LCP connector

4 PE screw

5 Connectors: UDC, AUX, STO out, and Ethernet

3.6 Auxiliary Capacitors Module (ACM 510)

3.6.1 Overview
ACM is the abbreviation for Auxiliary Capacitors Module. The ACM 510 can be connected to the ISD 510 system to store energy,
enabling a controlled machine stop in emergency situations.

N O T I C E

The ACM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

The ACM 510 can be damaged if exposed to �uids.
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An example type code for the ACM 510 is: MSD510ACM510F1E00C8D6E20PLSXXXXXXXXXXXXX.
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CAP ST

NET ST

X1

X2

LCP

LINK/ACT

DEV

STATUS ACM

Illustration 6: ACM 510

1 Connectors: I/O, relay, and Ethernet

2 Operating LEDs

3 LCP connector

4 PE screw

3.7 Expansion Module EXM 510
The EXM 510 supports modular machine setup by splitting the system modules into 2 control cabinets. The maximum length of the
cable between the EXM 510 modules is 5 m.

See 5.13 Connecting the Expansion Module EXM 510 for further information.
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Illustration 7: EXM 510

1 EMC Shielding Plate

2 Backplate

3 PE screw

4 Expansion connector

N O T I C E

The system modules are designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at
least IP54.

The EXM 510 has a protection rating of IP20 according to IEC/EN 60529.

The EXM 510 may be damaged if exposed to �uids.

An example type code for the EXM 510 is:

MSD510EXM510F1C062AD6E20XXXXXXXXXXXXXXXX
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3.8 Local Control Panel (LCP)

3.8.1 Overview of the Local Control Panel
The LCP is the graphical user interface that can be connected to the PSM 510, DAM 510, and ACM 510 for diagnostic and operating
purposes using an optional cable (M8 to LCP D-SUB extension cable). The LCP is available as an option and can also be connected to
the advanced version servo drives using the same optional cable.

The LCP display provides the operator with a quick view of the state of the ISD 510/DSD 510 servo drive or module, depending on
which device it is connected to. The display shows parameters and alarms/errors and can be used for commissioning and trouble-
shooting. It can also be used to perform simple functions, for example activating and deactivating the output lines on the Decentral
Access Module.

The LCP can be mounted on the front of the control cabinet and then connected to the modules via SUB-D cables.

3.8.2 Layout of the Local Control Panel
The local control panel is divided into 4 functional groups:

A: Display area

B: Display menu keys

C: Navigation keys and indicator lights (LEDs)

D: Operation keys and reset

To adjust the display contrast, press [Status] and the [▵]/[▿] keys.

3.8.2.1 A: Display area
The values in the display area di�er depending on whether the LCP is connected to a Danfoss servo drive or system module.

The display area is activated when the servo drive or module it is connected to receives power from the mains supply, a DC bus
terminal, or UAUX.
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Illustration 8: Display Area when Connected to an ISD 510 Servo Drive

1 Actual torque

2 Temperature drive module
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Illustration 9: Display Area when Connected to the PSM 510 and DAM 510

1 UAUX line voltage

2 Temperature power board

3 Actual UDC (current)

4 Power consumption

5 Actual UDC (voltage)
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Illustration 10: Display Area when Connected to the ACM 510

1 Temperature power board

2 Temperature capacitor bank 1

3 Temperature capacitor bank 2

4 UAUX line voltage

5 Actual UDC (voltage)

3.8.2.2 B: Display menu keys
Menu keys are used for menu access for parameter set-up, toggling through status display modes during normal operation, and
viewing fault log data.

Table 11: Display Menu Keys

Key Function

6 Status Shows operational information.

7 Quick Menu Allows access to parameters.

8 Main Menu Allows access to parameters.

9 Alarm Log Shows the last 10 alarms.

3.8.2.3 C: Navigation keys and indicator lights (LEDs)
Navigation keys are used for moving the display cursor and provide operation control in local operation. There are also 3 status LEDs
in this area.
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Table 12: Navigation Keys

Key Function

10 Back Reverts to the previous step or list in the menu structure.

11 Cancel Cancels the last change or command as long as the display mode is not changed.

12 Info Press for a de�nition of the function being shown.

13 Navigation keys Use the 4 navigation keys to move between items in the menu.

14 OK Use to access parameter groups or to enable a selection.

Table 13: Indicator Lights (LEDs)

LED Color Function

15 On Green The On LED activates when the servo drive or module it is connected to receives power from UAUX.

16 Warn Yellow When warning conditions are met, the yellow Warn LED activated and text appears in the display area
identifying the problem.

17 Alarm Red A fault condition causes the red Alarm LED to �ash and an alarm text is shown.

3.8.2.4 D: Operation keys and reset
The operation keys are located at the bottom of the LCP.

Table 14: Operation Keys and Reset

Key Function

18 Hand On Enables the connected ISD 510/DSD 510 servo drive or PSM 510 to be controlled via the LCP.

Switching between Hand On and Auto On modes is only possible in certain states (see the VLT® Servo Drive Sys-

tem ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming Guide for further information).

19 O� Puts the ISD 510/DSD 510 servo drive into state Switch on Disabled and the PSM 510 into state Standby.

This only works in Hand On mode.

O� mode enables transition from Hand On mode to Auto On mode.

20 Auto On Puts the system in remote operational mode.

In Auto On mode, the device is controlled by �eldbus (PLC). Switching between Auto On and Hand On modes is

only possible when the drive is in state Switch on Disabled and/or the PSM 510 is in state Standby.

21 Reset Resets the ISD 510/DSD 510 servo drive or PSM 510 after a fault has been cleared.

The reset is only possible when in Hand On mode.

3.9 Cables

3.9.1 Hybrid Cable
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Illustration 11: Hybrid Loop Cable
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Pre-con�gured hybrid cables are used to connect the ISD 510/DSD 510 servo drives to the Decentral Access Module (DAM 510).

There are 2 types of hybrid cables that are available with both angled and straight M23 connectors:

Feed-in cable for connecting the 1st ISD 510/DSD 510 servo drive of a group to the connection point on the Decentral Access
Module (DAM 510).

Loop cable for connecting the ISD 510/DSD 510 servo drives in daisy-chain format in an application.

Both these cables are provided by Danfoss and are available in various lengths. See the VLT® Servo Drive System ISD 510, DSD 510,

MSD 510 (VLT® Flexmotion™) Design Guide for further information.

Both ends of the loop cable are �tted with M23 connectors.

The feed-in cable is �tted with an M23 connector at the output end for connection to the 1st ISD 510/DSD 510 servo drive. At the
input end it is pigtailed and the connectors are mounted on the corresponding terminals on the Decentral Access Module (DAM
510).

Table 15: Hybrid Cables

Cable type Shielded/unshielded Notes

Feed-in cable Shielded Hybrid cable (overall shield with additional �eldbus and safety section shield).

Loop cable

N O T I C E

Hybrid cables are available in 2 cross-sections: 2.5 mm2 (15 A) and 4 mm2 (25 A for CE and UL, 20 A for CSA).

See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Design Guide for further information.
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VLT® ISD 510 Hybrid xxxx Cable

Length: xxxx

Ordering no. 175Gxxxx

1 7 5 G 8 9 X X

Specification no. 175Rxxxx Rev. xxx

Signal rating Ethernet: 2 x 2 x AWG24 300V

Production: dd.mm.yyyy

Power rating: 5 x 2.5mm2    1000V 15A
Signal rating: 2 x 0.5mm2     300V 

Illustration 12: Example of a Hybrid Cable Nameplate

1 Cable type

2 Ordering code

3 Revision of speci�cation

4 Manufacturing date

5 Length

6 Power rating

7 Signal rating

8 Signal rating for Ethernet

9 Barcode

10 Manufacturer logo

3.9.1.1 Minimum Bending Radius for Hybrid Cable
The maximum number of bending cycles is 5 million at 7.5 x  cable diameter (15.6 mm).

Permanently �exible: 12 x cable diameter

Permanently installed: 5 x cable diameter
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3.9.2 Motor and Feedback Cable
Pre-con�gured motor and feedback cables are used to connect the DSD 510 servo drive to a PM motor. Both ends of the cable are
�tted with M23 connectors.

These cables are provided by Danfoss and are available in 2.5 m and 5 m lengths (see the VLT® Servo Drive System ISD 510,

DSD 510, MSD 510 (VLT® Flexmotion™) Design Guide for further information).

The maximum length between the DSD 510 and the motor is 5 m.

There are di�erent types of cables available according to the feedback and motor variant used. Refer to the following tables for
details of the abbreviations used in the descriptions.

Table 16: Motor and Feedback Cable Types

Ordering number Description

175G8945 Motor Cable DSD M01 CT01 2.5 m OR

175G8946 Motor Cable DSD M01 CT01 5.0 m OR

175G8947 Feedback Cable DSD M01 CT03 RES 2.5 m GN

175G8948 Feedback Cable DSD M01 CT03 RES 5.0 m GN

175G8949 Feedback Cable DSD M01 CT04 ENC 2.5 m GN

175G8950 Feedback Cable DSD M01 CT04 ENC 5.0 m GN

Table 17: Connector Types (CT)

Type Variant Description

CT0 – M23

CT0 1 Motor standard with HIPERFACE DSL

CT0 2 Reserved

CT0 3 M23 Resolver

CT0 4 M23 Encoder

Table 18: Motor/Cable Con�guration

M01 AKM Pinout

M02 –

Table 19: Cable Colors

OR Orange

GN Green

3.9.2.1 Minimum Bending Radius for Motor Cable
The maximum number of bending cycles is 5 million at 7.5 x  cable diameter (14.8 mm).

Permanently �exible: 10 x cable diameter

Permanently installed: 5 x cable diameter

3.9.2.2 Minimum Bending Radius for Feedback Cable
The maximum number of bending cycles is 5 million at 7.5 x  cable diameter (11.7 mm).

Permanently �exible: 7.5 x cable diameter

Permanently installed: 5 x cable diameter
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3.9.3 I/O and/or Encoder Cable
This cable connects the I/O and/or encoder to the ISD 510/DSD 510 servo drive (X4 connector). The cable is not included with the
servo drives.

I/O and/or encoder cables with M12 connectors can be used for the ISD 510/DSD 510 system if they comply with the form factor
de�ned in IEC 61076-2-101.

3.9.4 Fieldbus Extension Cable
Cable length: 2 m

Maximum length to next port: 100 m

If this cable is not used, �t the M23 blind cap to the X2 female connector on the last ISD 510/DSD 510 servo drive in the application.

3.9.5 LCP Cable
The LCP cable connects the LCP to the advanced ISD 510/DSD 510 servo drive and the system modules via an M8 connector.

The LCP cable can be purchased from Danfoss (see the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™)

Design Guide for further information and ordering numbers).

3.10 Cable Layout and Routing
The ISD 510/DSD 510 servo drives are interconnected by hybrid loop cables. A hybrid feed-in cable with quick-release connectors
provides the supply voltage from the Decentral Access Module (DAM 510) to the 1st servo drive.

Routing in drag chains

The hybrid cable is compatible with drag chains and therefore suitable for use in moving systems. The number of bending cycles is
dependent on individual conditions and must therefore be determined in advance for each application, see 3.9.1 Hybrid Cable for
further information.

3.10.1 Standard Cabling Concept for 2 Lines
This cabling concept is for 2 lines, without redundancy for ISD 510/DSD 510 servo drives in an application. For each additional line of
servo drives, 1 additional DAM 510 is required. For cabling concepts with only 1 line, only 1 DAM 510 is required.

N O T I C E

For cabling with redundancy, see the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Design

Guide.
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Illustration 13: Standard Cabling Concept for 2 Lines

1 M23 feed-in cable

2 M23 loop cable

3 AC line choke

3.11 Software
The software for the servo system comprises:

The �rmware of the ISD 510/DSD 510 that is already installed on the device.

The �rmware of the system modules that is already installed on the modules.

A package of PLC libraries for Automation Studio™ for operating the ISD 510/DSD 510 servo drives and the system modules (see

6.10.2 Creating an Automation Studio™ Project for further information).

A PLC library for TwinCAT® 2 and 3 for operating the ISD 510/DSD 510 servo drives and the system modules (see 6.11.2 Creating

a TwinCAT® Project for further information).

A PLC library for SIMOTION SCOUT® for operating the ISD 510/DSD 510 servo drives and the system modules (see 6.13.3 Creating

a SIMOTION SCOUT® Project).

A PLC library for TIA Portal for operating the ISD 510/DSD 510 servo drives and the system modules.

VLT® Servo Toolbox: A Danfoss PC-based software tool for commissioning and debugging the devices.

3.12 Fieldbus
The servo system has an open system architecture realized by fast Ethernet (100BASE-T) based communication. The system sup-

ports EtherCAT®, Ethernet POWERLINK®, and PROFINET® �eldbuses. See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510

(VLT® Flexmotion™) Programming Guide for further information.

In productive environments, communication to the devices always takes place via a PLC that acts as a master. The ISD 510/DSD 510
servo drives and the system modules can be controlled by these communication methods:
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Using the VLT® Servo Motion libraries (available for TwinCAT®, Automation Studio™, SIMOTION SCOUT®, and TiA Portal).

Using the NC axis functionality of TwinCAT® (ISD 510/DSD 510 only).

Using the CANopen® CiA DS 402 standard by reading and writing to objects.

Using application class 1 (AC1) and 4 (AC4), PROFINET® only.

The ISD 510/DSD 510 servo drives and the system modules can be operated with the following cycle times.

EtherCAT® and Ethernet POWERLINK® �eldbuses:

400 µs and multiples of it (for example, 800 µs and 1200 µs).

500 µs and multiples of it (for example, 1 ms).

PROFINET® �eldbus

500 µs and multiples of it (for example, 1 ms).

When the cycle time is a multiple of 400 µs and 500 µs, the time base of 500 µs is used.

The ISD 510/DSD 510 servo drives and the system modules are certi�ed for �eldbuses according to the corresponding rules and
regulations. The servo drives conform to the CANopen® CiA DS 402 Drive Pro�le.

3.12.1 EtherCAT®
The ISD 510/DSD 510 servo drives and the system modules support the following EtherCAT® protocols:

CANopen over EtherCAT® (CoE)

File Access over EtherCAT® (FoE)

Ethernet over EtherCAT® (EoE)

The ISD 510/DSD 510 servo drives and the system modules support distributed clocks. To compensate for the failure of a communi-

cation cable section in the system, cable redundancy is available for all �eldbuses. See the VLT® Servo Drive System ISD 510,

DSD 510, MSD 510 (VLT® Flexmotion™) Design Guide for further information.
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Slave  Controller 
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LAN 1 (B)

O
U

T  2
 (C
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IN  0
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Illustration 14: EtherCAT™ Port Assignment for the ISD 510/DSD 510 Servo Drive

X1 M23 hybrid cable connector to Decentral Access
Module (DAM 510) or previous servo drive.

X2 M23 hybrid cable connector to the next servo drive.

X3 M8 Ethernet cable connector to other EtherCAT®

slaves, for example EtherCAT® encoder.

The connector is only available on the advanced ser-
vo drives.
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Illustration 15: EtherCAT™ Port Assignment for the Decentral Access Module (DAM 510)

X1 RJ45 cable connector to the previous slave.

X2 RJ45 to M23 hybrid feed-in cable to the 1st ISD 510/
DSD 510 servo drive.

X3 RJ45 cable connector to the PLC (cable redundancy)
or next slave.
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Illustration 16: EtherCAT™ Port Assignment for the Power Supply Module (PSM 510), Auxiliary Capacitors Module (ACM 510), and ISD 510/

DSD 510 Servo Drives

X1 RJ45 cable connector to the PLC or previous slave.

X2 RJ45 cable connector to the PLC (cable redundancy) or next slave.

3.12.2 Ethernet POWERLINK®
The ISD 510/DSD 510 servo drives and the system modules are certi�ed according to DS 301 V1.1.0 and support the following fea-
tures:

Work as controlled node

Can be operated as multiplexed stations

Support of cross-communication

Ring redundancy supported for media redundancy

Speci�c ports are not assigned for Ethernet POWERLINK®.

3.12.3 PROFINET®
The ISD 510/DSD 510 servo drive and system modules support PROFINET® conformance class C as per IEC 61158-5-10:2014,

IEC 61158-6-10:2014, IEC 61784-2:2014, and IEC 61784-5-3:2013. All the system components (servo drives and system modules) act
as I/O devices in a PROFINET® network.

The following features are supported:

I/O-Device - Device that is being controlled by I/O-Controller

Dynamic module con�guration

Net load class II

Ring redundancy (MRP) as client

PROFINET® �eldbus devices are always connected as network components via switches that are integrated in the �eldbus device.

There are 2 ports on the ISD 510/DSD 510 servo drives, the PSM 510, and the ACM 510. There are 3 ports on the DAM 510. Only 2 can
be used for Isochronous Real-Time (IRT) protocol, whereas all 3 can be used for Real-Time (RT) protocol. If the DAM 510 with IRT is
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ordered, a RJ45 cover will be mounted to the X3 OUT port. Remove this cover to enable use of the X3 OUT port required for switch-
ing to RT protocol.

The wiring concept for the use of multiple DAM 510 modules in a single application is shown in Illustration 17.
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Illustration 17: Wiring Concept for Multiple DAM 510 Modules

1 AC line choke

2 Customer cable

3 Fieldbus extension cable
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4 Mechanical Installation

4.1 Items Supplied
The items supplied for the ISD 510/DSD 510 servo systems are:

ISD 510/DSD 510 servo drives

Power Supply Module (PSM 510) including connectors

Decentral Access Module (DAM 510) including connectors

Auxiliary Capacitors Module (ACM 510) including connectors, optional

Expansion Module (EXM 510), optional

Local control panel (LCP), optional

This operating guide

Feed-in (hybrid) cable

Loop (hybrid) cable

LCP cable, optional

Fieldbus extension cable, optional

Blind caps for connectors M8, M12, and M23

The packaging unit depends on the number of servo drives delivered. Save the packaging for use in the event of product return.

4.2 Transport

Always use means of transport and lifting gear with su�cient load capacity to transport the servo system components.

Avoid vibration during transport.

Avoid heavy impacts and blows.

4.3 Inspection on Receipt

Procedure

After receiving the delivery, immediately check whether the items supplied match the shipping documents. Danfoss does
not honor claims for faults registered later.

Register a complaint immediately with the carrier if there is visible transport damage.

Register a complaint immediately with the responsible Danfoss representative if there are visible defects or the delivery is
incomplete.

4.4 Safety Measures during Installation
Always observe the safety instructions in this manual during installation. Pay particular attention to ensuring that the following
points are always observed:

Installation may only be performed by quali�ed personnel.

Installation must be performed with due care and attention.

All safety regulations and protective measures must be complied with, and the environmental conditions must be observed.

The manual is read and understood.

4.5 Installation Environment

4.5.1 Overview
The installation must provide the following environmental conditions to allow the ISD 510/DSD 510 system to be operated safely
and e�ciently.

Contact Danfoss if it is not possible to comply with these environmental conditions.
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4.5.2 ISD 510/DSD 510 Servo Drive

The allowable operating ambient temperature range and vibration levels must not be exceeded. (See 11.10.1 ISD 510/DSD 510
Servo Drive.)

The allowable relative humidity range is 3–93%, non-condensing.

Unrestricted ventilation must be available.

The mounting structure must be suitable for the application, for example, adequately rigid and able to cope with temperatures
over 90 °C.

4.5.3 System Modules
The environmental conditions for the PSM 510, DAM 510, and ACM 510 are:

The allowable operating ambient temperature range and vibration levels must not be exceeded (see 11.10.2 System Modules).

The allowable relative humidity range is 5–93%, non-condensing.

The minimum space required above and below the system modules is detailed in 4.7.3 Space Requirements for System Modules.

4.6 Preparation for Installation

4.6.1 ISD 510/DSD 510 Servo Drive
Make the following preparations to ensure that the servo system can be installed reliably and e�ectively.

Always �t couplings and other transfer components in accordance with local regulations.

Procedure

Provide a suitable mounting arrangement for the application. This depends on the type, weight, and power size of the ISD
510/DSD 510 servo drives.

For the ISD 510 servo drives, seat the motor �ange �ush against the mounting surface before �xing the servo drive. Mis-
alignment shortens the life of the bearings and the coupling components and reduces heat transfer from the servo drive.

For the DSD 510 servo drives, seat the bottom side of the DSD 510 to the mounting surface before �xing the servo drive.
Misalignment reduces heat transfer from the servo drive.

Provide contact protection according to local regulations if hot surfaces can be expected during operation.

Ground the servo drive.

4.6.2 System Modules
Make the following preparations to ensure that the servo system can be installed reliably and e�ectively.

Always �t the system modules in accordance with local regulations.

Procedure

Provide a suitable mounting arrangement for the application. This depends on the type and weight of the modules.

To avoid misalignment, ensure that the backplates are perfectly level.

To ensure su�cient cooling, pay attention to the speci�ed minimum space requirements.

Ground the modules.
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4.6.3 Drilling Templates
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Illustration 18: Drilling templates for 50 mm and 100 mm System Modules

4.7 Installation Procedure

4.7.1 Space Requirements for ISD 510 Servo Drive
In addition to its own dimensions, the ISD 510 servo drive needs space for the hybrid cable.

4.7.1.1 Minimum Distance for M23 Straight Connector on ISD 510 shows the straight connector installed on a size 2 ISD 510 servo
drive.

4.7.1.2 Minimum Distance for M23 Angled Connector on ISD 510 shows the angled connector installed on a size 2 ISD 510 servo
drive.

The illustrations show the minimum distance from the servo drive to the next object, and the minimum allowable bending radius
Rmin for permanently installed cable. For cable installation, allow the height of the connector plus an additional 30 mm for the cable.

The minimum distance is measured from the electronic housing as this is the same for all motor variants.

4.7.1.1 Minimum Distance for M23 Straight Connector on ISD 510
The minimum distance for the straight connector is calculated as follows:

0.5 x cable diameter + connector height + Rmin = 7.8 mm + 112 mm + 78 mm = 197.8 mm ≈ 200 mm
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Illustration 19: Minimum Distance for M23 Straight Connector

4.7.1.2 Minimum Distance for M23 Angled Connector on ISD 510
The minimum distance for the angled connector is calculated as follows:

0.5 x cable diameter + connector length measured from electronic housing + Rmin = 7.8 mm + 51.4 mm + 78 mm = 137.8 mm ≈

140 mm
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Illustration 20: Minimum Distance for M23 Angled Connector

4.7.2 Space Requirements for DSD 510 Servo Drive
In addition to its own dimensions, the DSD 510 servo drive needs space for the hybrid cable.

4.7.2.1 Minimum Distance for M23 Straight Connector on DSD 510 shows the straight connector installed on a DSD 510 servo drive.

4.7.2.2 Minimum Distance for M23 Angled Connector on DSD 510 shows the angled connector installed on a DSD 510 servo drive.

The illustrations show the minimum distance from the servo drive to the next object, and the minimum allowable bending radius
Rmin for permanently installed cable. For cable installation, allow the height of the connector plus an additional 30 mm for the cable.
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4.7.2.1 Minimum Distance for M23 Straight Connector on DSD 510
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Illustration 21: Minimum Distance for M23 Straight Connector

4.7.2.2 Minimum Distance for M23 Angled Connector on DSD 510

88.4
[3.48]

88.4
[3.48]

150 min
[5.9]

150 min
[5.9]

27.8
[1]

10
5 

m
in

[4
]

80
 m

in

[3
.1

4]

27.8
[1]

Rmin Rmin

e3
0b

i0
01

.1
0

Illustration 22: Minimum Distance for M23 Angled Connector

4.7.3 Space Requirements for System Modules
The modules can be mounted next to each other but require a minimum space at the top and bottom for cooling.
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Illustration 23: Minimum Space Required at the Top and Bottom
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Illustration 24: Minimum Space Required at the Sides

4.7.4 Installation Aids and Tools Required
For installation of the ISD 510 servo drives, the tools corresponding to the �xings screws (not included) are required.

4.7.5 Fitting Instructions for ISD 510 Servo Drive

4.7.5.1 Overview
The ISD 510 servo drives are delivered with an M23 transport protection cap. The M23 blind cap used for IP protection must be
ordered separately. The advanced version of the ISD 510 servo drive is delivered additionally with M8 and M12 blind caps. These
blind caps prevent contamination of the servo drive and are necessary to achieve the relevant IP protection rating. Always mount
these caps if the connector is not used.

N O T I C E

Ensure the machine surface that comes in contact with the servo drive �ange is unpainted in order to guarantee good ther-
mal behavior of the servo drive. The surface contact must also provide su�cient grounding protection.

4.7.5.2 Clamping the ISD 510 Servo Drive
Observe the following �tting instructions to ensure the reliable and e�ective �tting of the ISD 510 servo drive.

Procedure

Check the counterface of the motor mount and ensure that it has su�cient heat dispersion capacity. An unpainted surface
is mandatory.

Remove the protective end cap from the shaft.

Fix the servo drive with 4 screws using the 4 mounting holes provided for this purpose in the machine unit as shown.

Always use the designated mounting holes in the mounting �ange to �x the servo drive.

Do not modify the mounting holes.

Always use all 4 mounting holes. The motor may run unevenly if fewer mounting holes are used.
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Illustration 25: Mounting of Size 1, 1.5 Nm, Size 2, 2.9 Nm, Size 2, 3.8 Nm, Size 3, and Size 4 ISD 510 Servo Drives
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Illustration 26: Mounting of Size 2, 2.1 Nm ISD 510 Servo Drives

4.7.5.3 Coupling the ISD 510 Servo Drive
Observe the following safety warnings before coupling the ISD 510 servo drive.

N O T I C E

Do not machine the shaft.

Do not use the ISD 510 servo drive if the shaft does not match the coupling arrangement.
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N O T I C E
DO NOT USE EXCESSIVE FORCE DURING THE FITTING PROCEDURE:

Do not exceed the speci�ed vibration limits.

Do not exceed the speci�ed permitted forces.

Procedure

Align the clamping set to the axis of the ISD 510 servo drive.

Insert the shaft in the clamping set.

Screw the clamping set together.

4.7.5.4 Tightening Torques for Fixing Screws
Always tighten the screws uniformly and crosswise.

Servo drive size Thread type/

hole size

Maximum thread length Tightening torque

Size 1, 1.5 Nm Ø 5.8 mm – 5 Nm

Size 2, 2.1 Nm M6 pitch 1 mm 23 mm 6 Nm

Size 2, 2.9 Nm Ø 7 mm – 6 Nm

Size 2, 3.8 Nm Ø 7 mm – 6 Nm

Size 3, 5.2 Nm Ø 9 mm – 14 Nm

Size 3, 6.0 Nm Ø 9 mm – 14 Nm

Size 4, 11.2 Nm Ø 11 mm – 28 Nm

Size 4, 13.0 Nm In preparation – In preparation

N O T I C E

The �xing screws are not supplied and must be selected according to the machine �xings.

4.7.6 Fitting Instruction for DSD 510 Servo Drive

4.7.6.1 Clamping the DSD 510 Servo Drive
Observe the following �tting instructions to ensure the reliable and e�ective �tting of the DSD 510 servo drive.

Procedure

Check the mounting surface and ensure that it has su�cient heat dispersion capacity. An unpainted surface is mandatory.

Drill the holes for mounting the DSD 510 (see 11.3.3 Dimensions of DSD 510 Servo Drive ).

Mount the DSD 510 to the mounting plate using M5 screws.

The tightening torque is 3 Nm

Always use all 4 mounting holes.
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Illustration 27: Mounting of DSD 510 Servo Drive

4.7.7 Fitting Instructions for System Modules

N O T I C E

Mount the system module with the highest output power next to the PSM 510. Mount the remaining system modules in
descending order of output power.

Procedure

Drill the holes for mounting the backplate as per the drilling template (see 4.6.3 Drilling Templates).

Connect the backplates and the end cap via the click and lock method.
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Illustration 28: Connecting the Backplates

1 Backplate End Cap
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Mount the backplates to the mounting plate in the control cabinet using M5 screws with a minimum head diameter or
washer diameter of 9.5 mm. The tightening torque is 3 Nm.
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Illustration 29: Mounting the Backplates in the Control Cabinet

Slide the module onto the carrier at the bottom of the backplate.

Press the 1st module onto the backlink connector at the top of the backplate.
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Illustration 30: Pressing the Module onto the Backlink Connector

To secure the module, pull down the holding clamp ([1] in Illustration 31) at the top of the backplate.
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Illustration 31: Pulling Down the Holding Clamp at the Top of the Backplate

Repeat steps 4, 5, and 6 for the remaining modules, ensuring that the lip at the left side of the 2nd module is inside the
guiding groove at the right side of the 1st module ([1] in Illustration 32).
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Illustration 32: Guiding Groove
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5 Electrical Installation

5.1 Warnings for Electrical Installation
During electrical installation, observe the relevant local and national regulations in addition to the information in this manual.

W A R N I N G
LEAKAGE/GROUNDING CURRENT HAZARD

Leakage/grounding currents are >3.5 mA. Improper grounding of the ISD 510/DSD 510 servo drives and the system modules may

result in death or serious injury.

For reasons of operator safety, use a certi�ed electrical installer to ground the system correctly in accordance with the appli-
cable local and national electrical standards and directives, and the instructions in this manual.

W A R N I N G
HIGH VOLTAGE

The servo system contains components that operate at high voltage when connected to the electrical supply network. There are

no indicators on the components that indicate the presence of mains supply. Incorrect installation, commissioning, or mainte-

nance may lead to death or serious injury.

Installation, commissioning, and maintenance may only be performed by quali�ed personnel.

W A R N I N G
HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

Before working on the power connectors (disconnecting or connecting the cable), disconnect the PSM 510 from the mains
and wait for the discharge time to elapse.

5.2 Electrical Environmental Conditions
Compliance with the following electrical environmental conditions is necessary to enable safe and e�ective operation of the servo
system:

Only for use in TN-S, TN-C, TN-CS, TT (not corner earthed) supply earthing system

Prospective short-circuit current: 5 kA

Protective class I

Grounded 3-phase mains network, 400–480 V AC ±10%

3-phase frequency 44–66 Hz

3-phase lines and PE line

External supply for auxiliary voltage, 24–48 V DC (PELV) ±10%

AC choke (see 5.10.1 AC Line Choke)

Observe the national statutory provisions.

The leakage current is >3.5 mA.

N O T I C E
RCD COMPATIBILITY

The servo system contains components that can cause a DC current in the protective earthing conductor, which may result in

malfunction in any devices connected to the system.

Where a residual current-operated protective (RCD) or monitoring (RCM) device is used for protection in case of direct or
indirect contact, use a type B RCD or RCM device on the supply side of the system components.
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N O T I C E

The PSM 510, DAM 510, and ACM 510 (optional) must be mounted in a control cabinet.

5.3 EMC-Compliant Installation
To achieve an EMC-compliant installation, follow the instructions provided in 5.4.2 Grounding for EMC-Compliant Installation and
the steps de�ned for connecting the ISD 510/DSD 510 servo drives, PSM 510, DAM 510, and ACM 510.

5.4 Grounding

5.4.1 Grounding for Electrical Safety

Ground the DSD 510 servo drives with the PE wire of the feed-in cable. There is a dedicated PE screw on the front and another
on the back of the DSD 510 servo drive.
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Illustration 33: Grounding the DSD 510 Servo Drive

1 PE Screw

Ensure that the machine frame has a proper electrical connection to the ISD 510 and DSD 510 servo drives:

For ISD 510: Use the �ange surface on the front side. Ensure PE connection on that part of the machine.

For DSD  510: Use the PE screw shown in Illustration 33.

For the ISD 510/DSD 510 servo drives, ensure a minimum ground wire cross-section of at least 10 mm2 (minimum 70 °C, Cu) or 2

separate ground wires both complying with the dimensioning rules. See EN/IEC 61800-5-1 for further information.

Use a dedicated ground wire for input power and control wiring.

Do not ground the modules in daisy-chain format.

Keep the ground wire connections as short as possible.

Follow the wiring requirements in this manual.

For system modules:

To comply with CE requirements, ensure a minimum ground wire cross-section of at least 16 mm2 (minimum 70 °C, Cu).

To comply with UL requirements, ensure a minimum ground wire cross-section of at least 6 AWG (minimum 60 °C, Cu).

If a PSM 510 module with 10 kW is used, the cable cross-section can be reduced to:

10 mm2 (minimum 70 °C, Cu) to comply with CE requirements

8 AWG (minimum 60 °C, Cu) to comply with UL requirements

5.4.2 Grounding for EMC-Compliant Installation

Establish electrical contact between the cable shield and the enclosure using the I/O shielding plate on each module.
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Illustration 34: Cable Shielding on the Top of the System Modules

1 Cable

2 Cable tie

3 I/O shielding plate
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Illustration 35: Cable Shielding on the Bottom of the System Modules
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1 Cable tie

2 EMC metal shielding plate

3 PE screw

Use a cable with a shielding that has a high-coverage to reduce electrical interference.

Do not use pigtails to connect the shielding. A 360° wire connection is recommended.

N O T I C E
POTENTIAL EQUALIZATION

There is a risk of electrical interference when the ground potential between the servo system and the machine is di�erent.
Install equalizing cables between them. The recommended cable cross-section is 16 mm2.

N O T I C E
EMC INTERFERENCE

Use shielded cables for control wiring and separate cables for power and control wiring. Failure to isolate power and control
wiring can result in unintended behavior or reduced performance.

Ensure a minimum clearance of 200 mm between signal and power cables.

Only cross cables at 90°.

5.5 Mains Supply Requirements
Ensure that the supply has the following properties:

TN-S, TN-C, TN-CS, TT (not corner earthed) supply earthing system.

Prospective short-circuit current: 5 kA.

Protective class I.

Grounded 3-phase mains network, 400–480 V AC ±10%.

3-phase lines and PE line.

3-phase frequency: 44–66 Hz

Maximum input current for 1 PSM 510 at 30 kW: 55 Arms

5.5.1 Fuses

N O T I C E

Use fuses on the supply side of the Power Supply Module PSM 510 that comply with CE and UL requirements (see Table 20).

When 2 PSM 510 modules are used, each PSM 510 must have its own dedicated set of fuses.

Table 20: Fuses

Model and power rating CE Compliance (IEC 60364) UL Compliance (NEC 2014)

Maximum fuse type Maximum fuse type

PSM 510 (10 kW) gG 25 A 30 A (class T or J only)

PSM 510 (20 kW) gG 50 A 50 A (class T or J only)

PSM 510 (30 kW) gG 63 A 80 A (class T or J only)

5.5.2 Circuit Breakers
Use a type B or type C circuit breaker with a capacity of 1.5 times the rated current of PSM 510 to ful�ll CE requirements.
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N O T I C E

Circuit breakers are not allowed in installations where C-UL is required. Only UL recommended fuses are allowed.

5.6 Auxiliary Supply Requirements
Supply the Power Supply Module (PSM 510) with a power supply unit with an output range of 24–48 V DC ±10%. The output ripple

of the power supply unit must be <250 mVpp. Only use supply units that conform to the PELV speci�cation. Refer to the VLT® Servo

Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Design Guide for power rating shell diagrams.

N O T I C E

Only use supply units that conform to the PELV speci�cation.

Use a supply that is CE-marked according to the standards EN 61000-6-2 and EN 61000-6-4 or similar for industrial use.

The secondary circuit must be supplied from an external isolated source.

The power supply unit must be dedicated to the ISD 510/DSD 510 servo system, meaning that the supply is used exclusively for
powering the PSM 510. The maximum cable length between the supply unit and the PSM 510 is 3 m.

5.6.1 Fuses
UL listed fuses are recommended to protect the wiring on 24–48 V DC.

Table 21: Fuses

CE Compliance (IEC 60364) UL Compliance (NEC 2014)

Maximum fuse type Maximum fuse type

50 A(1) 63 A(2)

1 If the maximum current is lower, a fuse with lower current rating can be used. Rating of IEC fuses: according to 100% of maximum current. Use a

time delay fuse rated according to the DC voltage used.

2 If the maximum current is lower, a fuse with lower current rating can be used. Rating of UL fuses: according to 125% of maximum current. Use a

time delay fuse rated according to the DC voltage used.

5.7 Safety Supply Requirements
Supply the STO line with a 24 V DC supply with the following properties:

Output range: 24 V DC ±10%

Maximum current: 1 A

Use a 24 V supply unit that is CE marked for industrial use. Ensure that the supply ful�lls the PELV speci�cation and is only used for
the system safety input.

A common supply for auxiliary and safety supply can be used, provided the only connection point of the 2 circuits is near to the
supply. This is intended to avoid interference due to a common voltage drop. The maximum cable length between the 24 V supply
unit and the servo system is 3 m.

The safety supply can be looped from PSM 510 to the other system modules except for ACM 510. The cable for this is not provided.
For further information, see 8.6 Installation.

N O T I C E

Ensure reinforced isolation between safety signals and other signals, supplies (mains supply), and exposed conductive parts.
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5.8 UL Requirements

N O T I C E

Integral solid-state short-circuit protection does not provide branch circuit protection. Branch circuit protection must be pro-
vided in accordance with the National Electrical Code/Canadian Electrical Code, and any additional local codes or equivalent.

Suitable for use on a circuit capable of delivering not more than 5000 rms symmetrical amperes, 480 V maximum when pro-
tected by maximum 80 A class J or T fuses.

To meet the UL (Underwriters Laboratories) regulations, use a UL-approved copper cable with a minimum heat-resistance of
60 °C. Use Class 1 wire only. For PSM 510 rated 30 kW and EXM 510, use a minimum heat resistance of 75 °C.

Control Circuit Overcurrent Protection is required.

5.9 Connecting the ISD 510/DSD 510 Servo Drive

5.9.1 Electrical Installation Warnings for ISD 510/DSD 510 Servo Drive

W A R N I N G
HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

Before working on the power or signal connectors (disconnecting or connecting the cable), or performing any maintenance
work, disconnect the Power Supply Module (PSM 510) from the mains and wait for the discharge time to elapse.

W A R N I N G
DISCHARGE TIME

The servo system contains DC-link capacitors that remain charged for some time after the mains supply is switched o� at the

Power Supply Module (PSM 510). Failure to wait the speci�ed time after power has been removed before performing service or

repair work could result in death or serious injury.

To avoid electrical shock, fully disconnect the Power Supply Module (PSM 510) from the mains and wait for the capacitors to
fully discharge before carrying out any maintenance or repair work on the servo system or its components.

Minimum waiting time (minutes)

15

5.9.2 General Instructions for Cable Installation
Avoid mechanical tension for all cables, especially regarding the range of motion of the installed servo drive.

Secure all cables in accordance with regulations and depending on conditions on site. Ensure that cables cannot come loose, even
after prolonged operation.

If the X3, X4, and X5 connectors are not used, always mount the corresponding blind cap.

N O T I C E

Never connect or disconnect the hybrid cables to or from the servo drive when the supply voltage is present. Doing so dam-
ages the electronic circuitry. Observe the discharge time for the DC-link capacitors.

Do not forcefully connect or �t the connectors. Incorrect connection causes permanent damage to the connector.

Table 22: Tightening Torques

Connector Tightening Torque [Nm]

M8 0.2

M12 0.4
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7.

8.

9.

Connector Tightening Torque [Nm]

M23 0.8

5.9.3 Connecting Hybrid Cables

Procedure

Align the female connector of the M23 feed-in cable to the male input connector (X1) of the 1st ISD 510/DSD 510 servo
drive.

Fully rotate the threaded ring of the cable connector counterclockwise. Use the marking OPEN as a reference for the cable
connector.

Ensure the marking OPEN on the cable connector is facing the servo drive.

Press the connector towards the electronic housing on the servo drive until the sealing on the connector is entirely cov-
ered.

Tighten the M23 feed-in cable connector by rotating the threaded ring clockwise out of the �at area around the OPEN
marking.
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Illustration 36: Connecting the M23 Feed-In Cable

To add more servo drives in daisy-chain format, connect the male connector of the loop cable to the female connector (X2)
of the 1st servo drive.

Connect the female connector of the loop cable to the male connector (X1) of the next servo drive, and so on.

Tighten the threaded rings by hand as described in step 5.

Ensure that there is no mechanical tension on the cables.
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Illustration 37: Adding ISD 510 Servo Drives in Daisy-Chain Format

1 X1 Male connector

2 X2 Female connector

3 M23 Metal blind cap

Screw the M23 metal blind cap onto the unused M23 female output connector (X2) on the last servo drive in the servo
system.

Tighten the metal blind cap until the sealing on the connector is covered.
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Illustration 38: Mounting the M23 Blind Cap
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C A U T I O N

RISK OF INJURY AND/OR EQUIPMENT DAMAGE

Failure to use the M23 metal blind cap may result in injury to the operator and/or damage to the ISD 510/DSD

510 servo drive.

Always �t the M23 metal blind cap as described in steps 10 and 11.

N O T I C E

An angled version of the M23 connector is also available. The procedure for connecting the angled M23
connector is the same as for the straight connector.

5.9.4 Disconnecting Hybrid Cables

Procedure

Disconnect the Power Supply Module (PSM 510) from its power source (mains network and UAUX).

Wait for the minimum discharge time to elapse.

Remove the connector of the feed-in cable from the Decentral Access Module (DAM 510).

Rotate the threaded ring on the feed-in cable connector on the servo drive counterclockwise until the marking OPEN on
the cable connector is facing the servo drive.

Pull the connector away from the electronic housing.

Protective blind caps are provided for the X1 and X2 connectors. Mount the blind caps after removing the corresponding
connector.

5.9.5 Connecting Cables to Ports X3, X4, and X5

5.9.5.1 Cable Routing Recommendations
Avoid mechanical tension for all cables, especially regarding the range of motion of the installed servo drive.

Secure all cables in accordance with regulations and depending on conditions on site. Ensure that cables cannot come loose, even
after prolonged operation.
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5.9.5.2 Connecting I/O and/or Encoder Cables to Port X3
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Illustration 39: Connecting the I/O and/or Encoder Cable

Procedure

Align the connector on the cable (not supplied) with the connector marked X4 on the servo drive.

Press the connector towards the electronic housing of the servo drive and tighten the threaded ring of the connector by
turning it clockwise. The maximum tightening torque is 0.4 Nm.
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5.9.5.3 Connecting the LCP Cable to Port X5
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Illustration 40: Connecting the LCP Cable

Procedure

Align the connector on the LCP cable (not supplied) with the LCP connector marked X5 on the ISD 510/DSD 510 servo drive.

Press the connector towards the electronic housing of the servo drive and tighten the threaded ring of the connector by
turning it clockwise. The maximum tightening torque is 0.2 Nm.

The LCP cable can be ordered as an accessory.
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5.9.5.4 Connecting the 3rd Ethernet Device Cable to Port X3
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Illustration 41: Connecting the 3rd Ethernet Device Cable

Procedure

Align the connector on the cable with the Ethernet connector marked X3 on the ISD 510/DSD 510 servo drive.

Press the connector towards the electronic housing of the servo drive and tighten the threaded ring by turning it clockwise.
The maximum tightening torque is 0.2 Nm.

5.9.6 Disconnecting Cables from Ports X3, X4, and X5
Loosen the threaded ring of the connector by turning it counterclockwise.

Disconnect the cable from the servo drive.

Protective blind caps are provided for the X3, X4, and X5 connectors. Mount the blind caps after removing the respective
connector.

5.10 Connecting the Power Supply Module PSM 510

5.10.1 AC Line Choke
It is mandatory to use a 3-phase AC line choke (see 5.10.1.1 Connecting 1 PSM 510 to the AC Choke and 5.10.1.2 Connecting 2 PSM
510 Modules to the AC Choke).

Table 23: Line Choke Characteristics for 1 PSM 510

Model Minimum Irms [A] Urms [V] Inductance [mH]

PSM 510 (10 kW) 20 500 Minimum: 0.47

Maximum: 1.47

PSM 510 (20 kW) 40 500 Minimum: 0.47

Maximum: 1.47

PSM 510 (30 kW) 60 500 0.47 ±10%
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If 2 PSM 510 modules are installed in parallel, use an AC choke as speci�ed in Table 24. See 5.10.1.2 Connecting 2 PSM 510 Modules
to the AC Choke for further information.

Table 24: Line Choke Characteristics for 2 PSM 510 installed in parallel

Model Minimum Irms [A] Urms [V] Inductance [mH]

PSM 510 (2 x 30 kW) 125 500 0.24 ±10%

Danfoss recommends mounting the AC line choke close to the PSM 510.

The maximum cable length depends on the cross-section, and the required voltage and current at the DC-link.

If the AC line chokes are mounted away from the PSM 510, the maximum cable distance is 5 m.

5.10.1.1 Connecting 1 PSM 510 to the AC Choke
Connect the PSM 510 to the electric grid with the correct AC choke for the power size of the PSM 510.
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Illustration 42: Connecting 1 PSM 510 to the AC Choke

5.10.1.2 Connecting 2 PSM 510 Modules to the AC Choke
Connect the PSM 510 modules to the same AC choke as shown in Illustration 43.

Ensure the choke used is the correct size based on the combined power of the PSM 510 modules.

When 2 PSM 510 modules are used, the wiring between the AC line choke and each PSM 510 must be the same length within a
tolerance of 0.5 m.

Connect each PSM 510 to the AC choke directly. Parallel wiring is not permitted.

AQ262449648484en-000201 / 175R1135 | 73Danfoss A/S © 2020.10

Electrical Installation

VLT® Servo Drive System ISD 510/DSD 510

Operating Guide



STATUS PSM
DEV
SVS ST
NET ST

LINK/ACT
X1
X2

LCP

STATUS PSM
DEV
SVS ST
NET ST

LINK/ACT
X1
X2

LCP
LCP

STATUS DAM
DEV
SVS ST
NET ST
AUX

LINK/ACT
X1
X2
X3

PS
M

 5
10

PS
M

 5
10

D
A

M
 5

10

e3
0b

i2
36

.1
1

...

Illustration 43: Connecting 2 PSM 510 Modules to the AC Choke

5.10.1.3 Connecting 2 PSM 510 Modules to the AC Choke with System Splitting
Connect the PSM 510 modules to the same AC choke regardless of the load position (for example, before or after the system split-
ting) as shown in Illustration 44.

Ensure the choke used is the correct size based on the combined power of the PSM 510 modules.

When 2 PSM 510 modules are used, the wiring between the AC line choke and each PSM 510 must be the same length within a
tolerance of 0.5 m.

Connect each PSM 510 to the AC choke directly. Parallel wiring is not permitted.
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Illustration 44: Connecting 2 PSM 510 Modules to the AC Choke with System Splitting

If 2 AC chokes are used (1 per PSM 510) and both PSM 510 modules are mounted at the same side of the system splitting, the setup
is permitted with derating equal to the AC choke's tolerance referred to 60 kW. For example, 10% derating is 54 kW.

If 2 AC chokes are used (1 per PSM 510) where 1 PSM 510 module is mounted before the splitting and 1 after the splitting, the loads
must be balanced equally. Otherwise, the derating of both PSM 510 modules is equal to the AC choke's tolerance. For example,
tolerance 10% + 10% means –20% derating.

If 2 AC chokes are used (1 per PSM 510) and 1 PSM 510 module is mounted before the splitting and 1 after the splitting and half of
the loads are set before the system splitting and half are set after the system splitting, the setup is permitted with derating equal to
the AC choke's tolerance referred to 60 kW. For example, 10% derating is 54 kW.

N O T I C E

Further information on the EXM 510 module and wiring can be found in 11.9.13 Expansion Module Connector.

5.10.2 Connecting the Cables on the Power Supply Module PSM 510

5.10.2.1 Connecting the Cables on the Top of the Power Supply Module PSM 510

1 2

34567

e3
0b

g4
65

.1
1

Illustration 45: Connectors on the Top of PSM 510
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4.

5.

6.

7.

8.

9.

10.

1.

2.

3.

a.

b.

4.

1 Ethernet connector IN (X1 IN)

2 Ethernet connector OUT (X2 OUT)

3 24/48 V IN connector (INPUT 24/48 V)

4 STO connector IN (STO PSM)

5 STO connector OUT (STO PSM)

6 I/O connector (I/O PSM)

7 Relay connector (REL PSM)

Procedure

Connect the Ethernet cable from the PLC to the Ethernet input connector (X1 IN) [1].

Connect the Ethernet cable from the Ethernet output connector (X2 OUT) [2] to the next module.

Insert the wires into the 24/48 V IN (INPUT 24/48 V) connector.

Insert the 24/48 V IN connector [3].

Insert the wires into the STO connector IN (STO PSM) connector.

Insert the STO connector IN connector [4].

Insert the wires into the STO connector OUT (STO PSM) connector.

Insert the STO connector OUT connector [5].

If I/Os are required, insert the wires into the I/O connector and insert the connector (I/O PSM) [6].

If a relay is required, insert the wires into the relay connector and insert the connector (REL PSM) [7].

5.10.2.2 Connecting the Cables on the Bottom of the Power Supply Module PSM 510

2
1

3

4

e3
0b

g4
66

.1
0

Illustration 46: Connectors on the Bottom of PSM 510

1 Holder for internal brake resistor connector when
not in use

2 AC mains supply connector

3 PE screws

4 Internal/external brake resistor connector

Procedure

Insert the wires into the AC mains supply connector.

Insert the AC mains supply connector [2].

If an external brake resistor is required:

Unplug the internal brake resistor connector [4] and insert the external brake connector in its place.

Plug the internal brake resistor connector to the internal brake connector holder [1].

Connect the PSM 510 to PE using one of the PE screws on the front side [3] and a PE wire. The tightening torque is 3 Nm.
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5.11 Connecting the Decentral Access Module (DAM 510)

5.11.1 Connecting the Cables on the Top of the Decentral Access Module DAM 510

1 2
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g
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Illustration 47: Connectors on the Top of DAM 510

1 Ethernet connector IN (X1 IN)

2 Ethernet connector OUT (X3 OUT)

3 STO connector IN (STO DAM)

4 STO connector OUT (STO DAM)

5 External encoder connector (E DAM)

Procedure

Connect the Ethernet cable from the output of the previous module to the input connector (X1 IN) [1].

Insert the wires from the STO output of the previous module into the 24 V IN (STO input) connector, see 11.9.9.2.1 STO
Connectors on the Top of DAM 510.

Insert the 24 V IN (STO connector IN (STO DAM)) connector [3] into the DAM 510.

If required, connect the external encoder connector [5].

5.11.2 Connecting the Feed-In Cable
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Illustration 48: Connectors on the Bottom of DAM 510

1 Ethernet connector

2 AUX connector

3 STO out connector

4 UDC connector

AQ262449648484en-000201 / 175R1135 | 77Danfoss A/S © 2020.10

Electrical Installation

VLT® Servo Drive System ISD 510/DSD 510

Operating Guide



1

26

117
80

10
20

87

18

10

7

2
3

4
5

6
7

8

9

e3
0b

g8
06

.1
0

Illustration 49: Feed-In Cable

1 Shielded area

2 UDC+ (black, 2.5 mm2/4 mm2)

3 UDC– (gray, 2.5 mm2/4 mm2)

4 STO+ (pink, 0.5 mm2)

5 STO– (gray, 0.5 mm2)

6 AUX+ (red, 2.5 mm2)

7 AUX– (blue, 2.5 mm2)

8 Ethernet/�eldbus (green, RJ45 connector)

9 PE (yellow/green, 2.5 mm2/4 mm2, fork lug)
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0b

g8
07

.1
0

Illustration 50: Connecting the Feed-In Cable

1 Feed-in cable PE screws

2 Bus connector

3 Cable tie for feed-in cable

4 Cable tie for STO cable

5 EMC plate

6 EMC plate screw
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1.

2.

3.

4.

Procedure

Insert the wires into the UDC, AUX, and STO connectors.

Secure the feed-in cable using the cable ties [3], ensuring that the shielded area is positioned exactly under the cable tie.

Secure the STO cable using the cable tie [4], ensuring that the shielded area is positioned exactly under the cable tie.

Insert the connectors on the feed-in cable into their corresponding terminal block on the DAM 510.

Tighten the screw on the EMC plate [6]. The tightening torque is 3 Nm.

Insert the RJ45 bus connector [2].

Connect the DAM 510 to PE using one of the PE screws on the front side [1] and a PE wire. The tightening torque is 3 Nm.

5.12 Connecting the Auxiliary Capacitors Module ACM 510

e3
0b

h3
50

.1
11 2

4

5

3

Illustration 51: Connectors on the Top of ACM 510

1 Ethernet connector IN (X1 IN)

2 Ethernet connector OUT (X2 OUT)

3 I/O connector (I/O ACM)

4 Relay connector (REL ACM)

Procedure

Connect the Ethernet cable from the output of the previous system module to the input connector (X1 IN) [1].

If I/Os are required, insert the wires into the I/O connector (I/O ACM) and insert the connector [3].

If a relay is required, insert the wires into the relay connector (REL ACM) and insert the connector [4].

Connect the ACM 510 to PE using one of the PE screws on the front side [5] and a PE wire.. The tightening torque is 3 Nm.

5.13 Connecting the Expansion Module EXM 510
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Illustration 52: Expansion Module Cable

1 24/48 V

2 GND

3 Functional earth

4 DC–

5 DC–

6 DC+

7 DC+

8 Shielded area
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Illustration 53: Connecting the Expansion Module EXM 510

1 EMC shielding plate screw

2 PE screw

3 DC cables

4 Functional earth cable

5 GND cable

6 24/48 V cable

7 Cable tie

N O T I C E

If 2 separate backlinks are used (connected via 1 or 2 pairs of EXM 510 modules), the 2 grounding bars must be also connec-
ted together with a 16 mm2 (6 AWG) cable cross-section.

For cable cross sections see 11.9.13.1 Cable Cross Sections for EXM 510.

Procedure

Insert wires [3], [4], [5], and [6] into the expansion connector.

Secure the DC cables [3] using the cable tie [7], ensuring that the shielded area is positioned exactly under the cable tie.

Secure the cables [4], [5], and [6] using the cable ties [7].

Plug the connectors into the backplate.

Tighten the screw on the EMC shielding plate [1]. The tightening torque is 3 Nm.

Connect the EXM 510 to PE using the PE screw [2] and a PE wire. The tightening torque is 3 Nm.

5.14 Connecting the Brake Resistor on the PSM 510
The PSM 510 is connected to the internal brake resistor as shown in Illustration 54.

Alternatively, the PSM 510 can be connected to an external brake resistor. In this case, the internal brake resistor on the PSM 510
must remain unconnected and the connector can be placed in the internal brake resistor connector holder.

Paralleling or series of brake resistors is not permitted.
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DEV
SVS ST
NET ST

LINK/ACT
X1
X2

LCP

1
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Illustration 54: Connection of Internal Brake Resistor on 1 PSM 510

1 Internal brake resistor

When using 2 PSM 510 modules, connect each PSM 510 to its own internal brake resistor as shown in Illustration 55 (factory setting).

Alternative permitted con�gurations for 2 PSM 510 modules:

1 PSM 510 is connected to the internal brake resistor and the other is connected to an external brake resistor.

Both PSM 510 modules are connected to an external brake resistor. In this case, the internal brake resistor on the PSM 510 must
remain unconnected and the connector can be placed in the internal brake resistor connector holder (see 5.10.2.2 Connecting
the Cables on the Bottom of the Power Supply Module PSM 510).

Paralleling or series of brake resistors is not permitted.
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Illustration 55: Connection of Brake Resistor on 2 PSM 510 Modules in Parallel

1 Internal brake resistor

AQ262449648484en-000201 / 175R113582 | Danfoss A/S © 2020.10

Electrical Installation

VLT® Servo Drive System ISD 510/DSD 510

Operating Guide



1.

2.

3.

4.

5.

1.

2.

3.

4.

5.

6.

-

6 Commissioning

6.1 Warnings for Commissioning

W A R N I N G
UNINTENDED START

The servo system contains servo drives, the PSM 510, and DAM 510 that are connected to the electrical supply network and can

start running at any time. This may be caused by a �eldbus command, a reference signal, or clearing a fault condition. Servo

drives and all connected devices must be in good operating condition. A de�cient operating condition may lead to death, serious

injury, damage to equipment, or other material damage when the unit is connected to the electrical supply network.

Take suitable measures to prevent unintended starts.

6.2 Pre-Commissioning Checklist
Always complete these checks before initial commissioning and before commencing operation after extended downtime or stor-
age.

Procedure

Check that all the threaded connectors of mechanical and electrical components are �rmly tightened.

Check that the free circulation of cooling air (inlet and outlet) is assured.

Check that the electrical connections are correct.

Ensure that contact protection is in place for rotating parts and surfaces that can become hot.

If using the STO functionality, conduct the functional safety concept commissioning test (see 8.8 Commissioning Test).

6.3 EtherCAT® ID Assignment
EtherCAT® needs no special ID assignment (IP address). Special ID assignment is only required when using indirect communication

via the VLT® Servo Toolbox software.

6.4 Ethernet POWERLINK® ID Assignment

6.4.1 Overview
Ethernet POWERLINK® master communication must not be active when using the VLT® Servo Toolbox to assign IDs to the devices. ID

assignment via the VLT® Servo Toolbox is only possible when acyclic Ethernet POWERLINK® communication is used. If Ethernet POW-

ERLINK® cyclic communication is already started, perform a power cycle to stop it.

Detach the PLC and carry out a power cycle before setting IDs. Alternatively, in the POWERLINK® interface, restart the PLC in Service

Mode while parameter Basic Ethernet in Service Mode is set to Basic Ethernet enabled.

6.4.2 Single Device ID Assignment
When assigning an ID to a single device, use the Device Information window in the VLT® Servo Toolbox (see the VLT® Servo Drive

System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming Guide for further information).

Setting an ID to a device can also be done via the LCP.

6.4.2.1 Setting the Node ID Directly on a Servo Drive or on the System Modules
All IP-related parameters are located in parameter group 12-0* IP Settings. According to the Ethernet POWERLINK® standard, the IP

address is �xed to 192.168.100.xxx. The last number is the value in parameter 12-60 Node ID. For parameter 12-02 Subnet Mask, the IP
address is �xed to 255.255.255.0 and cannot be changed.

Procedure

Attach the LCP to the servo drive or system module for which the Node ID should be changed.

Press the Hand On button for >1 s to make the LCP the controlling interface.

Press the Main Menu button then scroll down to submenu 12-** Ethernet and press OK.

Scroll down to submenu 12-6* Ethernet POWERLINK and press OK.

Change the PSM 510/DAM 510 node ID to the desired value (1–239).

Press OK to con�rm the selection then wait for the ID assignment procedure to complete.
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Carry out a power cycle to ensure that all ID changes are in e�ect and operational on the �eldbus.

6.4.2.2 Setting the Node ID for a Single Servo Drive via the Power Supply Module (PSM 510) or De-
central Access Module (DAM 510) via the LCP
It is also possible to change the Node ID of a servo drive when the LCP is connected to the PSM 510 or DAM 510. This functionality is

contained in parameter group 54-** ID Assignment in subgroup 54-1* Manual.

Procedure

Attach the LCP to the PSM 510/DAM 510 that is connected to the servo drives and system modules for which the Node ID

should be changed.

Press the Hand On button for >1 s to make the LCP the controlling interface for the PSM 510/DAM 510.

Press the Main Menu button then scroll down to submenu 12-** Ethernet and press OK.

Scroll down to submenu 12-6* Ethernet POWERLINK and press OK.

Change the PSM 510/DAM 510 node ID to the desired value (1–239) by pressing the OK button.

Return to the Main Menu and select parameter 54-** ID Assignment.

Select parameter 54-1* Manual.

PSM 510 only: In parameter 54-01 Epl id assignment line, select either Ethernet port X1 or X2. The PSM 510 will assign IDs to
the selected device via the selected port and the �eldbus network. On DAM 510 port, X2 will be used automatically.

Select parameter 54-12 Epl ID assignment start id then select a valid value (1–239). The value will be assigned to the device at
the speci�ed position index. The PSM 510/DAM 510 connected to the LCP is at position 0 and the 1st reachable device on
the selected port is position index 1 and so on.

Select parameter 54-14 Manual Epl ID assignment start and change the status from [0] ready to [1] start.

Press OK to con�rm the selection then wait for the ID assignment procedure to complete.

Check that the ID assignment was completed successfully using parameters:

Parameter 54-15 Epl ID assignment state

Parameter 54-16 Epl ID assignment error code

Parameter 54-17 Epl ID assignment device count

Carry out a power cycle to ensure that all ID changes are in e�ect and operational on the �eldbus.

If an error occurs during ID assignment, the detected error is shown on the LCP. The following errors may be reported:

Invalid NMT state

Invalid comment

Invalid Ethernet port

Invalid node ID

ID assignment failed

Duplicate MAC address

Invalid SW version

Incomplete assignment

No device found

Internal error

6.4.3 Multiple Device ID Assignment
When assigning IDs to several devices (for example, when setting up a new network), use the VLT® Servo Toolbox subtool DAM ID

assignment (see the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming Guide for further

information).

Setting the IDs of all the servo drives connected to a Decentral Access Module (DAM 510) or Power Supply Module (PSM 510) at the
same time can also be done via the LCP when it is connected to the DAM 510/PSM 510.

6.4.3.1 Setting the Node IDs of all Servo Drives and System Modules on a Decentral Access Module
(DAM 510)/Power Supply Module (PSM 510) Line
The automatic PSM 510/DAM 510 ID assignment is used for automatically setting the Node IDs on all servo drives and system mod-

ules for a speci�ed PSM 510/DAM 510 line. This functionality is contained in parameter group 54- ** ID Assignment in subgroup 54-0*

Automatic.
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Procedure

Attach the LCP to the PSM 510/DAM 510 that is connected to the servo drives and system modules for which the Node ID

should be changed.

Press the Hand On button for >1 s to make the LCP the controlling interface for the PSM 510/DAM 510.

Press the Main Menu button then scroll down to submenu 12-** Ethernet and press OK.

Scroll down to submenu 12-6* Ethernet POWERLINK and press OK.

Change the PSM 510/DAM 510 node ID to the desired value (1–239) by pressing the OK button.

Return to the Main Menu and select parameter 54-** ID Assignment.

Select parameter 54-0* Automatic.

PSM 510 only: In parameter 54-01 Epl id assignment line, select either Ethernet port X1 or X2. The PSM 510 will assign IDs to
the selected device via the selected port and the �eldbus network. On DAM 510 port, X2 will be used automatically.

Select parameter 54-02 Epl ID assignment start id then select a valid value (1–239). The value will be assigned to the device at
the speci�ed position index. The PSM 510/DAM 510 connected to the LCP is at position 0 and the 1st reachable device on
the selected port is position index 1 and so on.

Select parameter 54-03 Automatic Epl ID assignment start and change the status from [0] ready to [1] start.

Press OK to con�rm the selection then wait for the ID assignment procedure to complete.

Check that the ID assignment was completed successfully using parameters:

Parameter 54-04 Epl ID assignment state

Parameter 54-05 Epl ID assignment error code

Parameter 54-06 Epl ID assignment device count

Carry out a power cycle to ensure that all ID changes are in e�ect and operational on the �eldbus.

If an error occurs during ID assignment, the detected error is shown on the LCP. The following errors may be reported:

Invalid NMT state

Invalid comment

Invalid Ethernet port

Invalid node ID

ID assignment failed

Duplicate MAC address

Invalid SW version

Incomplete assignment

No device found

Internal error

6.5 PROFINET® ID Assignment
Each PROFINET® device needs a device name and an IP address. The IP address and the device name are assigned by the I/O control-

ler, when the connection to the I/O device is established.

The IP address assignment is also required when using indirect communication via the VLT® Servo Toolbox software (see the VLT®

Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming Guide for further information).

The IP address and the device name can also be assigned using PRONETA, a free tool that supports in the analysis and con�guration
of PROFINET® networks.

6.6 Power-Up Time
The maximum power-up time for the system modules is 15 s. This means the time from supplying the system with auxiliary voltage
to the module being initialized completely.

The power-up time stated is an indicative time. The exact status of the module can be seen via the statusword.
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N O T I C E

Do not operate any of the system modules until they are all powered up correctly.

If 2 PSM 510 modules are mounted in parallel, power up both PSM 510 modules simultaneously (within a maximum delay of
1 second).

6.7 System Module Charging Time
The charging time of the system is determined by the longest charging time of each individual system module.

The exact status of each module can be seen via the statusword.

N O T I C E

Do not operate any of the system modules or decentral drives until they are charged up completely. Wait until PSM 510,

DAM 510, and ACM 510 are in state Operation enabled, before bringing the ISD 510/DSD 510 into state Operation enabled.

Table 25: DC-Link (UDC) Charging Time for PSM 510, DAM 510, and ACM 510

Speci�cation Unit PSM 510 DAM 510 ACM 510

UDC charging time s 2.0 2.0 3.5

6.8 Switching on the ISD 510/DSD 510 System
Complete the cabling of the servo system before applying power to the ISD 510/DSD 510 servo drives. This cabling provides the
supply voltage and the communication signals for the servo system. This is a fundamental requirement for operation of the ISD
510/DSD 510 servo drives.

The servo system can be switched on in 2 ways:

If the Power Supply Module (PSM 510) is supplied with mains, STO, and UAUX, communication to the PSM 510 internal controller

is established and DC-link and UAUX are automatically passed on via the backlink to the DAM 510 and then passed on further to

the connected servo drives.

If the Power Supply Module (PSM 510) is only powered by UAUX, then the PSM 510, DAM 510, and servo drive control units are

running.

6.8.1 Procedure for Switching on the ISD 510/DSD 510 System

Procedure

Switch on UAUX power to enable communication to the PSM 510, DAM 510, and ISD 510/DSD 510 servo drives to be estab-

lished.

Switch on the mains.

Set the PSM 510 to state Normal operation.

Set the DAM 510 to state Normal operation.

Now the PSM 510, DAM 510 and the ISD 510/DSD 510 servo drives are ready for operation.

6.9 Libraries
The libraries provided for the ISD 510 system can be used in:

TwinCAT® V2 and V3

SIMOTION SCOUT® V5.2:

C240 from V4.4

D410-2 from V4.4

D425-2 from V4.4

D435-2 from V4.4

D445-2 from V4.4
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D455-2 from V4.4

P320 from V4.4

Automation Studio™ environment (version 3.0.90 and 4.x, supported platform SG4) to easily integrate the functionality without

the need for special motion run-time on the controller.

TiA from V15

The provided function blocks conform to the PLCopen® standard. Knowledge of the underlying �eldbus communication and/or the

CANopen® CiA DS 402 pro�le is not necessary.

The library contains:

Function blocks for controlling and monitoring the ISD 510/DSD 510 servo drives and the system modules.

Function blocks for all available motion commands of the ISD 510/DSD 510 servo drives.

Function blocks for controlling and monitoring the PSM 510, DAM 510, and ACM 510.

Function blocks and structures for creating Basic CAM pro�les.

Function blocks and structures for creating Labeling CAM pro�les.

6.10 Programming with Automation Studio™

6.10.1 Requirements for Programming with Automation Studio™
The following �les are required to integrate the ISD 510/DSD 510 servo drives and the system modules into an Automation Studio™

project:

Package of libraries for the ISD 510 servo system: Danfoss_VLT_ServoMotion_V_x_y_z.zip

XDD �le (XML Device Description) for the standard ISD 510 servo drive: 0x0300008D_ISD510_S.xdd

XDD �le (XML Device Description) for the advanced ISD 510 servo drive: 0x0300008D_ISD510_A.xdd

XDD �le (XML Device Description) for the standard DSD 510 servo drive: 0x0300008D_DSD510_S.xdd

XDD �le (XML Device Description) for the advanced DSD 510 servo drive: 0x0300008D_DSD510_A.xdd

XDD �le (XML Device Description) for the Power Supply Module (PSM 510): 0x0300008D_PSM.xdd

XDD �le (XML Device Description) for the Decentral Access Module (DAM 510): 0x0300008D_DAM.xdd

XDD �le (XML Device Description) for the Auxiliary Capacitors Module (ACM 510): 0x0300008D_ACM.xdd

6.10.2 Creating an Automation Studio™ Project
The procedures described in this chapter apply to Automation Studio™ Versions 3.0.90 and V4.x unless otherwise speci�ed.

Information on how to install Automation Studio™ can be found in detail in the Automation Studio™ help. Open the B&R Help Ex-

plorer and go to [Automation software → Software Installation → Automation Studio].

Information on how to create a project in Automation Studio™ can be found in detail in the Automation Studio™ help.

V3.0.90:

Open the B&R Help Explorer and go to [Automation Software → Getting Started → Creating programs with Automation Studio →
First project with X20 CPU].

V4.x:

Open the B&R Help Explorer and go to [Automation Software → Getting Started → Creating programs with Automation Studio →
Example project for a target system with CompactFlash].

6.10.3 Including the Servo Motion Libraries into an Automation Studio™ Project

Procedure

In the Logical View, open the menu entry [File → Import...].

In the next window, select the Danfoss_VLT_ServoMotion_V_x_y_z.zip �le (according to the location on the hard drive).

Click on Open.

Assign the libraries to the CPU in the next window.

Click on Finish. Now the libraries are integrated into the Automation Studio™ project.

A new folder containing the ISD libraries is created during integration:

DDS_Drive
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-

Contains program organization units (POUs) de�ned by PLCopen® (name starting with MC_) and POUs de�ned by

Danfoss (name starting with DD_). The Danfoss POUs provide additional functionality for the axis.

It is possible to combine POUs de�ned by PLCopen® with POUs de�ned by Danfoss.

The names of the POUs that target the servo drive all end with _DDS.

DDS_PSM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Power Supply
Module (PSM).

The names of the POUs that target the PSM all end with _PSM.

DDS_DAM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Decentral Ac-
cess Module (DAM).

The names of the POUs that target the DAM all end with _DAM.

DDS_ACM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Auxiliary Ca-
pacitors Module (ACM).

The names of the POUs that target the ACM all end with _ACM.

DDS_BasCam

Contains POUs for the creation of basic CAMs.

DDS_LabCam

Contains POUs for the creation of labeling CAMs.

DDS_Intern

Contains POUs that are needed internally for the libraries.

Do not use these POUs in an application.

When integrating the DDS_Drive package, some standard libraries are integrated automatically, unless they are already
part of the project.
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Illustration 56: Standard Libraries

N O T I C E

Do not remove these libraries otherwise the Danfoss servo motion libraries will not work.

6.10.4 Constants within the DDS_Drive Library
Inside the library, the following lists of constants are de�ned:
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Danfoss_VLT_ServoMotion

Contains the version information of the library.

DDS_AxisErrorCodes

Constants for error codes of the axis.

Error codes can be read using the function block MC_ReadAxisError_DDS and/or DD_ReadAxisWarning_DDS.

DDS_AxisTraceSignals

Constants for the trace signals of the axis.

Intended to be used with the function block DD_Trace_DDS.

DDS_BasCam

Constants for the creation of basic CAMs.

DDS_CamParsingErrors

Constants for parsing problems of a CAM.

Error reason is returned by function block MC_CamTableSelect_DDS.

DDS_FB_ErrorConstants

Constants for errors inside POUs.

The reason is given in an output ErrorInfo.ErrorID that is available in all POUs.

DDS_Intern

Constants which are needed internally for the library.

They are not intended to be used in an application.

DDS_LabCam

Constants for the creation of labeling CAMs.

DDS_SdoAbortCodes

Constants for errors concerning reading and writing of parameters.

The reason is given in an output AbortCode that is available in several POUs.

PSM_ErrorCodes

Constants for error codes of the Power Supply Module (PSM 510).

Error codes can be read using the function block DD_ReadPsmError_PSM and/or DD_ReadPsmWarning_PSM.

PSM_TraceSignals

Constants for the trace signals of the Power Supply Module (PSM 510).

Intended to be used with the function block DD_Trace_PSM.

DAM_ErrorCodes

Constants for error codes of the Decentral Access Module (DAM 510).

Error codes can be read using the function block DD_ReadDamError_DAM and/or DD_ReadDamWarning_DAM.

DAM_TraceSignals

Constants for the trace signals of the Decentral Access Module (DAM 510).

Intended to be used with the function block DD_Trace_DAM.

ACM_ErrorCodes

Constants for error codes of the Auxiliary Capacitors Module (ACM 510).

Error codes can be read using the function block DD_ReadAcmError_ACM and/or DD_ReadAcmWarning_ACM.

ACM_TraceSignals

Constants for the trace signals of the Auxiliary Capacitors Module (ACM 510).

Intended to be used with the function block DD_Trace_ACM.

6.10.5 Instantiating AXIS_REF_DDS in Automation Studio™

Procedure
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Create 1 instance of function block AXIS_REF_DDS (located in folder DDS_Drive) for every servo drive that has to be control-
led or monitored.

To create a link to the physical servo drive, link each instance of AXIS_REF_DDS to 1 physical servo drive. This makes it the
logical representation of 1 physical servo drive.

Open the Logical View.

Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

Initialize each instance of a drive with its DriveType.

Example

Illustration 57: Instantiation of AXIS_REF_DDS and Setting of Initial Values

6.10.6 Instantiating PSM_REF in Automation Studio™

Procedure

Create 1 instance of function block PSM_REF (located in folder DDS_PSM) for every Power Supply Module (PSM) that has to
be controlled or monitored.

To create a link to the physical PSM, link each instance of PSM_REF to 1 physical PSM. This makes it the logical representa-
tion of 1 physical PSM.

Open the Logical View.

Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

6.10.7 Instantiating DAM_REF in Automation Studio™

Procedure

Create 1 instance of function block DAM_REF (located in folder DDS_DAM) for every Decentral Access Module (DAM) that
has to be controlled or monitored.

To create a link to the physical DAM, link each instance of DAM_REF to 1 physical DAM. This makes it the logical representa-
tion of 1 physical DAM.

Open the Logical View.

Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

6.10.8 Instantiating ACM_REF in Automation Studio™

Procedure

Create 1 instance of function block ACM_REF (located in folder DDS_ACM) for every Auxiliary Capacitors Module (ACM) that
has to be controlled or monitored.

To create a link to the physical ACM, link each instance of ACM_REF to 1 physical ACM. This makes it the logical representa-
tion of 1 physical ACM.

Open the Logical View.
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Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

6.10.9 Importing a Servo Drive into Automation Studio™

N O T I C E

For each physical servo drive, add 1 entry to the Physical View of Automation Studio™.

6.10.9.1 Version V3.0.90

Procedure

Select the menu entry [Tools → Import Fieldbus Device...].

Select the XDD �le (for example, 0x0300008D_ISD510_S.xdd or 0x0300008D_ISD510_A.xdd) from its location on the hard
drive. This import only needs to be done once per project. The device is then known to Automation Studio™.

Now add the servo drive to the Ethernet POWERLINK® interface of the controller in the Physical View:

Right-click on the controller in the Physical View and select [Open POWERLINK].

Right-click on the interface and select Insert...

In the Select controller module window, select the servo drive in the group POWERLINK Devices.

Click on Next.

In the next window, enter the node number of the servo drive.
e3
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0

Illustration 58: Adding a Servo Drive to the Project in V3.0.90

6.10.9.2 Version V4.x

Procedure

Select the menu entry [Tools → Import Fieldbus Device...].

Select the XDD �le (for example, 0x0300008D_ISD510_S.xdd or 0x0300008D_ISD510_A.xdd) from its location on the hard
drive. The device is then known to Automation Studio™.

Now add the servo drive to the Ethernet POWERLINK® interface of the controller in the Physical View:

Select the menu entry [Open → System Designer] to show the System Designer.

To add a hardware module to the Physical View or System Designer, select the servo drive in the group POWERLINK in the

Hardware Catalog toolbox.

Drag the selected module to the desired position to connect it to the selected hardware module, network interface, or
slot.

To change the node number, right-click on the device and select [Node Number → Change Node Number].
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Illustration 59: Adding a Servo Drive to the Project in V4.x

6.10.10 Importing PSM 510, DAM 510 and ACM 510 into Automation Studio™

N O T I C E

For each physical Power Supply Module (PSM 510), Decentral Access Module (DAM 510), and Auxiliary Capacitors Module

(ACM 510), add 1 entry to the Physical View of Automation Studio™.

6.10.10.1 Version V3.0.90

Procedure

Select the menu entry [Tools → Import Fieldbus Device...].

Select the XDD �le for the PSM 510, DAM 510, or ACM 510 from its location on the hard drive. This import only needs to be
done once per project. The device is then known to Automation Studio™.

Power Supply Module (PSM 510): 0x0300008D_PSM.xdd

Decentral Access Module (DAM 510): 0x0300008D_DAM.xdd

Auxiliary Capacitors Module (ACM 510): 0x0300008D_ACM.xdd

Now add the PSM 510, DAM 510, or ACM 510 to the Ethernet POWERLINK® interface of the controller in the Physical View:

Right-click on the controller in the Physical View and select [Open POWERLINK].

Right-click on the interface and select Insert....

In the Select controller module window, select the PSM 510, DAM 510, or ACM 510 in the group POWERLINK Devices.

Click on Next.

In the next window, enter the node number of the PSM 510, DAM 510, or ACM 510.
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Illustration 60: 1 PSM 510, 1 DAM 510, and 2 ISD 510 Servo Drives Added to the Ethernet POWERLINK® Interface in V3.0.90

6.10.10.2 Version V4.x

Procedure

Select the menu entry [Tools → Import Fieldbus Device...].

Select the XDD �le for the PSM 510, DAM 510, or ACM 510 from its location on the hard drive. The device is then known to
Automation Studio™.
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Power Supply Module (PSM 510): 0x0300008D_PSM.xdd

Decentral Access Module (DAM 510): 0x0300008D_DAM.xdd

Auxiliary Capacitors Module (ACM 510): 0x0300008D_ACM.xdd

Now add the PSM 510, DAM 510, or ACM 510 to the Ethernet POWERLINK® interface of the controller in the Physical View:

Select the menu entry[Open → System Designer] to show the System Designer.

To add a hardware module to the Physical View or System Designer, select the PSM 510, DAM 510, or ACM 510 in the

group POWERLINK in the Hardware Catalog toolbox.

Drag the selected module to the desired position to connect it to the selected hardware module, network interface, or
slot.

To change the node number, right-click on the device and select [Node → Change Node Number].

PSM: Danfoss _VLT_R_PSM

DAM: Danfoss _VLT_R_DAM

ACM: Danfoss _VLT_R_ACM
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Illustration 61: 1 PSM 510, 1 DAM 510, and 2 ISD 510 Servo Drives Added to the Ethernet POWERLINK® Interface in V4.x

6.10.11 I/O Con�guration and I/O Mapping

Procedure

Parameterize the I/O con�guration of the ISD 510/DSD 510 servo drives so that the library has access to all necessary ob-
jects.

Right-click on the entry of the ISD 510/DSD 510 servo drive and select Open I/O Con�guration in V3.0.90 and Con�gura-

tion in V4.x.

In the Channels section, change the Cyclic transmission of the following objects:

All sub-indexes of object 0x5050 (Lib pdo rx_I5050 ARRAY[]) to Write.

All sub-indexes of object 0x5051 (Lib pdo tx_I5051 ARRAY[]) to Read.

Parameterize the I/O con�guration of the Power Supply Module (PSM 510), Decentral Access Module (DAM 510), and Auxili-
ary Capacitors Module (ACM 510) so that the library has access to all necessary objects.

Right-click on the entry of the PSM/DAM/ACM and select Open I/O Con�guration in V3.0.90 and Con�guration in V4.x.

In the Channels section, change the Cyclic transmission of the following objects:

All sub-indexes of object 0x5050 (Lib pdo rx_I5050 ARRAY[]) to Write.

All sub-indexes of object 0x5051 (Lib pdo tx_I5051 ARRAY[]) to Read.

These settings con�gure the cyclic communication with the device. These parameters are required for the library to work.

N O T I C E

It is possible to use copy and paste to apply the same I/O con�guration to multiple devices of the same type.

Set Module supervised to o� for the servo drives and the PSM/DAM/ACM. The parameter is found in the I/O con�guration of
the device.
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Illustration 62: I/O Con�guration of an ISD 510 Device
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Illustration 63: I/O Mapping after Successful Con�guration

Map the inputs and outputs of the instance of the AXIS_REF_DDS function block and the physical data points of the ISD 510

servo drive (here myAxis is an instance of AXIS_REF_DDS):
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Illustration 64: I/O Mapping of an ISD 510 Servo Drive

Map the inputs and outputs of the instance of the PSM_REF, DAM_REF, and ACM_REF function blocks and the physical data
points of the PSM/DAM/ACM accordingly.

6.10.12 Setting the PLC Cycle Time
The minimum cycle time is 400 µs. The servo system devices can run Ethernet POWERLINK® cycle times in multiples of 400 µs and

multiples of 500 µs. The devices are automatically parameterized by the PLC on start-up, depending on the Ethernet POWERLINK®

con�guration of the physical interface. The Ethernet POWERLINK® con�guration can be accessed by right-clicking [CPU → Open IF3

POWERLINK Con�guration] in the Physical View for V3.0.90 or [PLK → Con�guration] for V4.x.

N O T I C E

Ensure that the task cycle times of the PLC program and Ethernet POWERLINK® are the same. Otherwise, data could be lost

and performance reduced.
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Illustration 65: Ethernet POWERLINK<® Con�guration Window to Parameterize Ethernet POWERLINK® Cycle Time

Procedure for setting the PLC time in Automation Studio™

Right-click [CPU → Open Software Con�guration] for V3.0.90 and [CPU → Con�guration → Timing] for V4.x in the Physical

View.

Ensure that the PLC cycle time is the same as the Ethernet POWERLINK® cycle time.

6.10.13 Connecting to the PLC
Information on how to connect to the PLC can be found in detail in the Automation Studio™ Help.

Version V3.0.90:

Open the B&R Help Explorer and go to [Automation Software → Getting Started → Creating programs with Automation Studio →
First project with X20 CPU → Con�gure online connection].

Version V4.x:

Open the B&R Help Explorer and go to [Automation Software → Getting Started → Creating programs in Automation Studio → Ex-
ample project for a target system with CompactFlash].
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6.11 Programming with TwinCAT®

6.11.1 Requirements for Programming with TwinCAT®
To integrate the ISD 510/DSD 510 servo drives and the PSM 510, DAM 510, or ACM 510 into a TwinCAT® project, the following �les

are required:

Library for the ISD 510 servo system: Danfoss_VLT_ServoMotion_V_x_y_z.lib

ESI �le (EtherCAT® Slave Information) for the standard ISD 510 servo drive: Danfoss_ISD510_S.xml

ESI �le (EtherCAT® Slave Information) for the advanced ISD 510 servo drive: Danfoss_ISD510_A.xml

ESI �le (EtherCAT® Slave Information) for the standard DSD 510 servo drive: Danfoss_DSD510_S.xml

ESI �le (EtherCAT® Slave Information) for the advanced DSD 510 servo drive: Danfoss_DSD510_A.xml

ESI �le (EtherCAT® Slave Information) for the Power Supply Module: Danfoss_PSM510.xml

ESI �le (EtherCAT® Slave Information) for the Decentral Access Module: Danfoss_DAM510.xml

ESI �le (EtherCAT® Slave Information) for the Auxiliary Capacitor Module: Danfoss_ACM510.xml

6.11.2 Creating a TwinCAT® Project
Information on how to install TwinCAT® can be found in detail in the Beckho� Information System (https://infosys.beckho�.com/).

Open the information system and select [TwinCAT 2 → TwinCAT Quick Start → Installation].

Information on how to create a project in TwinCAT® can be found in detail in the Beckho� Information System (https://info-

sys.beckho�.com/). Open the information system and select [TwinCAT 2 → TwinCAT Quick Start or TwinCAT 2 → TX1200 TwinCAT
PLC → TwinCAT PLC Control].

6.11.3 Including the TwinCAT® Library into a TwinCAT® Project

Procedure

In the Resources tab of TwinCAT® PLC Control, open the Library Manager.

In the upper left area of the Library Manager window, right-click and select Additional Library....

Select the Danfoss_VLT_ServoMotion_V_x_y_z �le (according to the location on the hard drive).

Click on Open. Now the libraries are integrated into the TwinCAT® PLC control project.
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Illustration 66: Library Manager after Including the ServoMotion Library

Inside the library, the POUs are organized into folders:

DDS_Drive

Contains program organization units (POUs) de�ned by PLCopen® (name starting with MC_) and POUs de�ned by

Danfoss (name starting with DD_). The Danfoss POUs provide additional functionality for the axis.

It is possible to combine POUs de�ned by PLCopen® with POUs de�ned by Danfoss.
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The names of the POUs that target the servo drives all end with _DDS.

DDS_PSM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Power Supply
Module (PSM 510).

The names of the POUs that target the PSM 510 all end with _PSM.

DDS_DAM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Decentral Ac-
cess Module (DAM 510).

The names of the POUs that target the DAM 510 all end with _DAM.

DDS_ACM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Auxiliary Ca-
pacitors Module (ACM 510).

The names of the POUs that target the ACM 510 all end with _ACM.

DDS_BasCam

Contains POUs for the creation of basic CAMs.

DDS_LabCam

Contains POUs for the creation of labeling CAMs.

DDS_Intern

Contains POUs that are needed internally for the libraries.

Do not use these POUs in an application.

When integrating the VLT® Integrated Servo Drive library, some standard libraries are integrated automatically, unless they
are already part of the project.

N O T I C E

Do not remove these libraries otherwise the DDS libraries will not work.

6.11.4 Constants within the DDS_Drive Library
Inside the library, the following lists of constants are de�ned:

Danfoss_VLT_ServoMotion

Contains the version information of the library.

DDS_AxisErrorCodes

Constants for error codes of the axis.

Error codes can be read using the function block MC_ReadAxisError_DDS and/or DD_ReadAxisWarning_DDS.

DDS_AxisTraceSignals

Constants for the trace signals of the axis.

Intended to be used with the function block DD_Trace_DDS.

DDS_BasCam

Constants for the creation of basic CAMs.

DDS_CamParsingErrors

Constants for parsing problems of a CAM.

Error reason is returned by function block MC_CamTableSelect_DDS.

DDS_FB_ErrorConstants

Constants for errors inside POUs.

The reason is given in an output ErrorInfo.ErrorID that is available in all POUs.

DDS_Intern
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Constants which are needed internally for the library.

They are not intended to be used in an application.

DDS_LabCam

Constants for the creation of labeling CAMs.

DDS_SdoAbortCodes

Constants for errors concerning reading and writing of parameters.

The reason is given in an output AbortCode that is available in several POUs.

PSM_ErrorCodes

Constants for error codes of the Power Supply Module (PSM 510).

Error codes can be read using the function block DD_ReadPsmError_PSM and/or DD_ReadPsmWarning_PSM.

PSM_TraceSignals

Constants for the trace signals of the Power Supply Module (PSM 510).

Intended to be used with the function block DD_Trace_PSM.

DAM_ErrorCodes

Constants for error codes of the Decentral Access Module (DAM 510).

Error codes can be read using the function block DD_ReadDamError_DAM and/or DD_ReadDamWarning_DAM.

DAM_TraceSignals

Constants for the trace signals of the Decentral Access Module (DAM 510).

Intended to be used with the function block DD_Trace_DAM.

ACM_ErrorCodes

Constants for error codes of the Auxiliary Capacitors Module (ACM 510).

Error codes can be read using the function block DD_ReadAcmError_ACM and/or DD_ReadAcmWarning_ACM.

ACM_TraceSignals

Constants for the trace signals of the Auxiliary Capacitors Module (ACM 510).

Intended to be used with the function block DD_Trace_ACM.

6.11.5 Instantiating AXIS_REF_DDS in TwinCAT®

Procedure

Create 1 instance of function block AXIS_REF_DDS (located in folder DDS_Drive) for the ISD 510 servo drive that has to be
controlled or monitored.

Repeat step 1 for each additional servo drive.
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Illustration 67: Instantiation of AXIS_REF_DDS

6.11.6 Instantiating PSM_REF in TwinCAT®

Procedure

Create 1 instance of function block PSM_REF (located in folder DDS_PSM) for each Power Supply Module that has to be
controlled or monitored.

Repeat step 1 for each additional PSM 510.

6.11.7 Instantiating DAM_REF in TwinCAT®

Procedure

Create 1 instance of function block DAM_REF (located in folder DDS_DAM) for each Decentral Access Module that has to be
controlled or monitored.

Repeat step 1 for each additional DAM 510.

6.11.8 Instantiating ACM_REF in TwinCAT®

Procedure

Create 1 instance of function block ACM_REF (located in folder DDS_ACM) for each Auxiliary Capacitors Module that has to
be controlled or monitored.

Repeat step 1 for each additional ACM 510.

6.11.9 Adding a PLC Project to TwinCAT® System Manager
To create a link between the TwinCAT® PLC Control project and the TwinCAT® System Manager, connect the saved project, especially

the inputs and outputs, to the TwinCAT® System Manager:

Procedure

To add the project information to the TwinCAT® System Manager, right-click on PLC-Con�guration and select Append PLC

project....

In the Insert IEC 1131 Project window, select the project information �le according to the location on the hard drive. The �le

has the same name as the PLC project, but with the �le extension .tpy.

Click on Open.

6.11.10 Importing Devices to TwinCAT®
The following procedure is an example of how to import an ISD 510 servo drive to TwinCAT®.

Procedure
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Copy the ESI �le Danfoss ISD 510 S.xml into the folder TwinCAT Installation Folder\Io\EtherCAT on the hard drive. This only
needs to be done once per project. The TwinCAT® System Manager automatically searches for ESI �les at this location on

the hard drive during start-up.

To add an EtherCAT® master, right-click on [I/O-Con�guration → I/O Devices] and select Append Device....

In the following window, select [EtherCAT → EtherCAT] and click on OK.
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Illustration 68: Add an EtherCAT Master to the Project

Select Device 1 (EtherCAT) and select the correct Network Adapter on the right side of the window in the Adapter tab.

To add a Power Supply Module, right-click on Device1 (EtherCAT) and select Append Box....

In the Insert EtherCAT Device window, select [Danfoss GmbH → VLT® FlexMotion → VLT® Power Supply Module PSM 510]

and click on OK.

To add a Decentral Access Module, right-click on Device1 (EtherCAT) and select Append Box....

In the Insert EtherCAT Device window, select [Danfoss GmbH → VLT® FlexMotion → VLT® Decentral Access Module] and click

on OK.

To add an Auxiliary Capacitors Module, right-click on Device1 (EtherCAT) and select Append Box....

In the Insert EtherCAT Device window, select [Danfoss GmbH → VLT® FlexMotion → VLT® Auxiliary Capacitors Module] and

click on OK.

To add a servo drive to the Decentral Access Module DAM 510, right-click on Box 1 (VLT® Decentral Access Module) and select

Append Box....

In the Insert EtherCAT Device window, select [Danfoss GmbH → VLT® FlexMotion → VLT®ISD 510 Integrated Servo Drive

Standard] and click on OK.
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Illustration 69: Add a Servo Drive to the Project
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Illustration 70: TwinCAT System Manager after Appending the PLC Project and Adding a Decentral Access Module and 2

ISD 510 Servo Drives

Answer the question if the servo drive is used as an NC axis with No. If the servo drive is to be used as an NC axis, see 6.11.15
Con�guration as a TwinCAT® NC Axis.

N O T I C E

Add 1 entry to the EtherCAT® master of the TwinCAT System Manager for each physical servo drive, PSM 510,

DAM 510, and ACM 510. Add the servo drive to the correct DAM 510 line.

6.11.11 I/O Con�guration and I/O Mapping
When connecting >1 ISD 510/DSD 510 servo drive, connect port C (X2) of the previous servo drive to port A (X1) of the next servo
drive. Also carry out the port assignment for the Decentral Access Module (DAM 510).

If the hardware setup is already present, the TwinCAT® System Manager Scan devices function can be used to automatically add the

connected devices to the con�guration in the correct order.

Using the TwinCAT® System Manager, con�gure the ISD 510/DSD 510 servo drive so that the PDO mapping matches the require-

ments of the library.
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Procedure (Example for an ISD 510 servo drive)

Click on the ISD 510 servo drive entry.

Select the Slots tab on the right side of the window.

Remove the current PDO con�guration by selecting the entry Module 1 (CSV PDO) in the Slot box.

Click on X.

Select Library PDO in the Module box.

Click on <.

e3
0b

g3
53

.1
1

Illustration 71: ISD 510 Servo Drive with Correct I/O Con�guration

6.11.12 Attaching the Input and Output Variables to the Physical Data Points
Use the TwinCAT® System Manager to attach the input and output variables of the PLC program to the physical inputs and outputs

of the device. This ensures that the library has access to all necessary objects.

W A R N I N G

Repeat steps 2–22 for Box 1 (VLT® Power Supply Module) and the instance myPSM.

Repeat steps 2–22 for Box 2 (VLT® Decentral Access Module) and the instance myDAM.

Procedure

Select Library TxPDO via menu [I/O-Con�guration → I/O Devices → Device1 (EtherCAT) → Box 1 (VLT Decentral Access
Module) → Drive 1 (VLT ISD 510 Integrated Servo Drive) → Module 1 (Library PDO) → Library TxPDO].

Select all entries Lib pdo tx1 to Lib pdo tx9 on the right side of the window.
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Illustration 72: Attaching Inputs and Outputs to the Physical Data Points

Right-click and select Change Multi Link....

In the Attach Variable 36.0 Byte(s) (Input) window, select [PLC-Con�guration → MyFirstFlexMotionProject → Standard

→ .myAxis.TPDO]. Ensure that the Matching Size option is selected in the Attach Variable window.

Click on OK.
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Click on library RxPDO via menu [I/O-Con�guration → I/O Devices → Device1 (EtherCAT™) → Box1 (VLT™ Decentral Access

Module) → Drive2 (VLT™ ISD 510 Integrated Servo Drive) → Module1 (Library PDO) → Library RxPDO].

Select all entries Lib pdo rx1 to Lib pdo rx9 on the right side of the window.

Right-click and select Change Multi Link....

In the Attach Variable 36.0 Byte(s) (Output) window, select [PLC-Con�guration → MyFirstIsd510Project → Standard
→ .myAxis.RPDO].

Click on OK.

Right-click on WcState via menu [I/O-Con�guration → I/O Devices → Device1 (EtherCAT™) → Box1 (VLT™ Decentral Access

Module) → Drive2 (VLT™ ISD 510 Integrated Servo Drive) → WcState] and select Change Link....

In the Attach Variable State (Input) window, select [PLC-Con�guration → MyFirstIsd510Project → Standard → .myAx-
is.WcState].

Click on OK.

Right-click on State via menu [I/O-Con�guration → I/O Devices → Device1 (EtherCAT™) → Box1 (VLT™ Decentral Access

Module) → Drive2 (VLT™ ISD 510 Integrated Servo Drive) → InfoData] and select Change Link....

In the Attach Variable State (Input) window, select [PLC-Con�guration → MyFirstIsd510Project → Standard → .myAxis.State].

Click on OK.

Right-click on netId via menu [I/O-Con�guration → I/O Devices Device1 (EtherCAT→) → Box1 (VLT® Decentral Access Mod-

ule) → Drive2 (VLT→ ISD 510 Integrated Servo Drive) → InfoData → AdsAddr] and select Change Link....

In the Attach Variable netId (Input) window, select [PLC-Con�guration → MyFirstIsd510Project → Standard → .myAxis.Ams-
NetId].

Click on OK.

Right-click on Port via [I/O-Con�guration → I/O Devices → Device1 (EtherCAT→) → Box1 (VLT→ Decentral Access Module)

→ Drive2 (VLT→ ISD 510 Integrated Servo Drive) → InfoData → AdsAddr] and select Change Link....

In the Attach Variable port (Input) window, select [PLC-Con�guration → MyFirstIsd510Project → Standard → .myAxis.Node-
Number].

Click on OK.

6.11.13 Transferring the Mappings back to the PLC Program
To transfer the mappings back to the PLC program, select Activate Con�guration... in menu item Actions.

After a rebuild in TwinCAT® PLC Control, the TwinCAT® con�guration is according to Illustration 73 (here myAxis and mySecondAxis

are instances of AXIS_REF_DDS, myPSM is an instance of PSM_REF, and myDAM is an instance of DAM_REF). The concrete addresses
can be di�erent.
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Illustration 73: TwinCAT® Con�guration: I/O Mapping of 2 Servo Drives, 1 PSM 510, and 1 DAM 510
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N O T I C E

Connect the PSM 510, DAM 510, and ACM 510 to 1 SYNC unit and the ISD 510/DSD 510 servo drives to another. This protects
against interruptions in communication to the PSM 510 and DAM 510 if the UAUX supply to the servo drives is switched o�

due to an error.

6.11.14 Setting the PLC Cycle Time in TwinCAT® PLC Control
The minimum cycle time is 400 µs. The ISD 510 devices can run EtherCAT® cycle times in multiples of 400 µs or 500 µs. The devices

are automatically parameterized by the PLC on start-up, depending on the EtherCAT® con�guration of the physical interface. To ac-

cess the system base time, select [SYSTEM-Con�guration → Real-Time Settings] in the TwinCAT® System Manager. Multiples of this

base time can then be used as EtherCAT® cycle times.

N O T I C E

Set the task cycle time of the PLC program to be the same as the EtherCAT® cycle time. Otherwise data may be lost and

performance reduced.

Procedure

Double-click Task con�guration in the Resources tab.

Ensure that the PLC cycle time is the same as the EtherCAT® cycle time.
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Illustration 74: Task Con�guration to Parameterize the PLC Cycle Time

N O T I C E

After changing the task cycle time in TwinCAT® PLC Control, carry out a ReScan of the PLC con�guration in-

side the TwinCAT® System Manager to update the settings. Afterwards, activate the con�guration in the PLC.

6.11.15 Con�guration as a TwinCAT® NC Axis
The servo drives can be used with the built-in NC functionality of TwinCAT®.

Everything that is related to the PSM 510 and DAM 510 must be done as described in 6.11.2 Creating a TwinCAT® Project.

Procedure

In addition to the Danfoss_VLT_ServoMotion_V_x_y_z.lib �le, include the TcMC2.lib �le.

Create 1 instance of AXIS_REF (instead of AXIS_REF_DDS) for each ISD 510/DSD 510 servo drive that is used as an NC axis.

Append the PLC project into the TwinCAT® System Manager, import the devices, and add them to TwinCAT®, however in the

last step, answer the question if the servo drive is used as an NC axis with Yes. Then an NC task is created automatically.

6.11.15.1 I/O Con�guration for Servo Drives used as NC Axes
In the TwinCAT® System Manager, select a di�erent I/O Con�guration for the servo drives used as NC axes.

Procedure
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Depending on the mode of operation to be used, select either the slot CSP PDO or CSV PDO. Per default, CSV PDO is mapped
and pre-selected. Map the following variables if the VLT® Integrated Servo Drive servo drive is required to work with CSP
PDO:

In the Settings Tab of the NC Axis, select [NC-Con�guration → NC-Task 1 SAF → Axes → Axis 1]. Click on the Link To (all

Types)... button and select the desired servo drive.

In the same tab, select the preferred Unit.

Depending on the selected unit, adjust the Scaling Factor for the axis encoder via menu [NC-Con�guration → NC-Task 1 SAF

→ Axes → Axis 1 → Axis 1_Enc] in the Parameter tab. Example: When the unit Degrees is selected, the scaling factor is
360°/220 = 0.00034332275390625.

Set the Reference Velocity in the Parameter tab via menu [NC-Con�guration → NC-Task 1 SAF → Axes → Axis 1 → Axis
1_Enc.

Set the Output Scaling Factor (Velocity) to 125.

Test the functionality and the con�guration in the Online tab of the axis.

6.11.16 Connecting to the PLC
Information on how to connect to the PLC can be found in detail in the Beckho� Information System .

Open the information system and go to [TwinCAT 2 → TwinCAT System Manager → Operation → Controls → Choose Target Sys-
tem].

6.12 Programming Guidelines for Automation Studio™ and TwinCAT®
Recommendations for implementation:

Initialize parameters that usually do not change only once at the beginning of the program. In Automation Studio™, use the

_INIT section.

Call up function blocks that provide status or error information with Enable input at the beginning of the program.

Use 1 instance of the function block MC_Power_DDS for every axis to control its power stage. Call up this function block in every
PLC cycle.

Use 1 instance of the function block DD_Power_PSM for every PSM 510 to control the DC-link voltage on the output. Call up this
function block in every PLC cycle.

Use 1 instance of the function block DD_Power_DAM for every DAM 510 to control the DC-link voltage on the output. Call up
this function block in every PLC cycle.

Use 1 instance of the function block DD_Power_ACM for every ACM 510 to control the connection between the DC-link and the
ACM 510. Call up this function block in every PLC cycle.

Call up function blocks that execute (motion) commands at the end of the program.

Do not use any POUs from the library (folder) DDS_Intern.

Do not change the reference to the axis on a function block while it is busy.

N O T I C E

The full parameter list can be found in the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Pro-

gramming Guide.

6.13 Programming with SIMOTION SCOUT®

6.13.1 Requirements for Programming with SIMOTION SCOUT®
The following �les are required to integrate the servo system modules into a SIMOTION SCOUT® project. In the �lename, 2.xx repre-

sents the version number and yyyymmdd represents the date.

Table 26: Required Files

System Module File required

Whole servo system Package of libraries for the ISD 510 servo system: Danfoss_VLT_ServoMotion_V_x_y_z.zip

Online Help �le(.chm): Programming with SIMOTION SCOUT®
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System Module File required

Servo Drive Module SDM 511/
SDM 512

GSDML �le (General station description):

GSDML-V2.xx-Danfoss-SDM-yyyymmdd.xml

Integrated Servo Drive ISD 510 GSDML �le (General station description):

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

Decentral Servo Drive DSD 510 GSDML �le (General station description):

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

Power Supply Module PSM 510 GSDML �le (General station description):

GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

Decentral Access Module DAM 510 GSDML �le (General station description):

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

Auxiliary Capacitors Module ACM 510 GSDML �le (General station description):

GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

6.13.2 Connecting to the PLC
Information on how to connect to the PLC can be found in detail in the SIMOTION SCOUT® Help.

Open SIMOTION SCOUT® and go to [Help → Help Topics → Getting Started with SIMOTION SCOUT → Download the project to the
target system → Connect to selected target devices → Go online].

6.13.3 Creating a SIMOTION SCOUT® Project
Information on how to install SIMOTION SCOUT®® can be found in detail in the SIMOTION SCOUT® Con�guration Manual.

N O T I C E

SIMATIC STEP 7 V5.5 or higher with HF11 must be installed to create a project.

Information on how to create a project in SIMOTION SCOUT® can be found in detail in the SIMOTION SCOUT® online help. Open

SIMOTION SCOUT® and go to [Help → Help Topics → Getting started with SIMOTION SCOUT → Create SIMOTION device and con�g-

ure PG/PC communication connection].

6.13.4 Including the Servo Motion Libraries into a SIMOTION SCOUT® Project
The folder LIBRARIES in the Project tab contains these libraries:

DDS_Drive

Contains program organization units (POUs) de�ned by PLCopen® (name starting with MC_) and POUs de�ned by Danfoss

(name starting with DD_). The Danfoss POUs provide additional functionality for the servo drive.

It is possible to combine POUs de�ned by PLCopen® with POUs de�ned by Danfoss.

The names of the POUs that target the servo drive all end with _DDS.

DDS_PSM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Power Supply Module
(PSM 510).

The names of the POUs that target the PSM 510 all end with _PSM.

DDS_DAM
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Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Decentral Access Module
(DAM 510).

The names of the POUs that target the DAM 510 all end with _DAM.

DDS_ACM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Auxiliary Capacitors Mod-
ule (ACM 510).

The names of the POUs that target the ACM 510 all end with _ACM.

DDS_BasCam

Contains POUs for the creation of basic CAMs.

DDS_LabCam

Contains POUs for the creation of labeling CAMs.

DDS_Intern

Contains POUs that are needed internally for the libraries.

Do not use these POUs in an application.

When integrating the DDS_Drive package, some standard libraries are integrated automatically, unless they are already part of the
project.
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Illustration 75: Project Tree after Including Danfoss Servo Motion Libraries
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N O T I C E

Do not remove or rename these libraries.

Procedure

Extract the �les from the Danfoss_VLT_ServoMotion_V_x_y_z.zip �le (according to the location on the hard drive).

The DDS_Xxxx.xml �le and XML_DDS_Xxxx folder must be located together in the same folder to import the library.

In the Project tab, right-click on LIBRARIES and select [Export/import → Import folders/objects].
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Illustration 76: Import Library

Select �le DDS_Intern.xml according to the location on the hard drive.

Click on OK. Now the library is integrated into the SIMOTION SCOUT® project.

Repeat steps 2–4 for DDS_BasCam.xml, DDS_Drive.xml, DDS_LabCam.xml, DDS_PSM.xml, DDS_DAM.xml, and DDS_ACM.xml.

6.13.5 Importing Devices into SIMOTION SCOUT®

N O T I C E

For each physical servo drive, PSM 510, DAM 510, or ACM 510, add 1 entry to the PROFINET® Ethernet network in the HW

Con�g tool.

Procedure

Open the HW Con�g tool.

Select [Options → Install GSD File...].

To add a servo drive, select the xml �le (according to the location on the hard drive) and click on Install. In the �lename, 2.xx

represents the version number and yyyymmdd represents the date.

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

Repeat steps 2 and 3 for:

Power Supply Module (PSM 510): GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

Decentral Access Module (DAM 510):
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GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

Auxiliary Capacitors Module (ACM 510): GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

Drag the device Danfoss Drive Servo IRT on to an existing PROFINET® Ethernet network.

Find the servo drive device named Danfoss Drive Servo IRT by expanding the PROFINET IO entry in the hardware
catalog on the right side of the screen and selecting [Additional Field Devices → Drives → VLT® FlexMotion]. If the

device is not visible, update the hardware catalog by selecting [Options → Update catalog).

Expand Drive Object 1 and folder Pro�le in the hardware catalog on the right side of the screen and drag the Danfoss Tele-

gram to the free slot of Drive Object 1 at the bottom of the screen.
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Illustration 77: Dragging the Danfoss Telegram to a Free Slot

To set the communication parameters, double-click on the icon depicting the servo drive in the main window showing the
Ethernet network.

In the General tab, enter a name in �eld Device name.

In the General tab, click on the Ethernet... button to set the IP address of the servo drive and then click on OK.

Repeat steps 6–9 for:

Power Supply Module (PSM 510): VLT PSM IRT

Decentral Access Module (DAM 510): VLT DAM IRT

Auxiliary Capacitors Module (ACM 510): VLT ACM IRT

6.13.6 Assigning IP Con�guration and Device Name

N O T I C E

If more than 1 servo drive is used in the same PROFINET® network, each servo drive must have a di�erent name and IP ad-

dress.

The IP address assignment is also required when using indirect communication via the VLT® Toolbox software (see the VLT®

Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming Guide for further information).

Procedure

Open menu [PLC → Ethernet → Edit Ethernet Node].

In the next window, click on Browse.
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Illustration 78: Edit Ethernet Node

All accessible Ethernet nodes are shown in this window.

The ISD 510 servo drives are listed under device type VLT® ISD 510.

The DSD 510 servo drives are listed under device type VLT® DSD 510.

Select the desired servo drive and click on OK (use the Flash button to identify the speci�c servo drive).

e3
0b

h5
23

.1
0

Illustration 79: Selecting the Servo Drive

In the Edit Ethernet Node window, select the option Use IP parameters.

Enter the IP address and Subnet mask and click on Assign IP con�guration.
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Illustration 80: Entering the IP Address and Assigning the IP Con�guration

Enter the device name that was previously selected and click on Assign Name and then Close.
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Illustration 81: Assigning the Device Name

6.13.7 Creating a Sync Domain
A sync domain is a group of PROFINET® devices synchronized to a common cycle clock. One device has the role of the sync master

(clock generator). All other devices are sync slaves.

N O T I C E

All devices that exchange data via Isochronous Real-Time (IRT) must belong to the same sync domain.

Procedure

Open the HW Con�g tool.

Select the station with the PROFINET® devices to be involved in IRT communication.

Select the PROFINET® I/O interface in the section Station/IO system.

Select the menu [Edit → PROFINET IO → Domain management].
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Illustration 82: Domain management

In the Sync Domain tab, select the station in the upper �eld of the Nodes section.

In the lower �eld of the Nodes section, double-click on the device that should be con�gured as the sync master.

When the Device properties window opens, select Sync master as Synchronization role and click on OK.
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Illustration 83: Device properties: Sync Master

In the Domain management window, select all devices to be con�gured as sync slaves in the Nodes section (keep the CTRL

key depressed to select >1 device).

Click on the Device Properties button.

In the Device Properties window, select Sync slave as Synchronization role and click on OK.
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Illustration 84: Device properties: Sync Slave

In the Domain management window, click on OK.

Select the station with the PROFINET® devices.

Select the menu [Edit → Object Properties].

In the next window, open the Isochronous Tasks tab, select the isochronous mode for I/O data change, and click on OK.
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Illustration 85: Use I/O Data Isochronously to the Servo

Click on the VLT® ISD 510 IRT device.

Double-click on the PN-IRT-Inteface in the Module.

In the next window, open the IO Cycle tab and set �eld Assign IO device in isochronous mode to Servo.
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Illustration 86: Assign IO Device in Isochronous Mode

6.13.8 Con�guring a Topology
The topology must be con�gured and parameterized.

Procedure

Open the HW Con�g tool.

Select the path for the PROFINET® I/O system or PROFINET®module, for example a DanfossISD 510 series.

Select the menu [Edit → PROFINET IO → Topology].

In the next window, select the Graphic view tab.
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Illustration 87: Graphic View Tab in Topology Editor

Connect the PROFINET® device with the station. Establish connections between ports by holding down the left mouse but-

ton and drawing a line between the 2 ports.

Once all connections are made, click on OK.
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6.13.9 De�ning Send Clock and Update Time

6.13.9.1 Con�guring the Send Clock Time

Procedure

Open the HW Con�g tool.

Select the station with the PROFINET® devices to be involved in IRT communication, for example PNxIO.

Select the menu [Edit → PROFINET IO → Domain management].

In the next window, open the Sync Domain tab and in the Send clock time [ms] �eld, select an appropriate time for the proc-

ess, for example 1.000 ms, then click on OK.
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Illustration 88: Con�guring a Send Clock for PROFINET® IRT

6.13.9.2 Con�guring the Update Time

Procedure

Open the HW Con�g tool.

Select the path for the PROFINET® I/O system.

Select the menu [Edit → Object properties].

In the next window, open the Update Time tab, highlight the I/O device and click on the Edit button.

In the next window (Edit Update Time/Mode), select the Update Time and click on OK.
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Illustration 89: Set Update Time
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N O T I C E

The system cycle clocks of the PLC program must be the same as the PROFINET® send clock, otherwise data may be

lost and performance reduced.

6.13.10 Accessing Inputs and Outputs
SIMOTION SCOUT® provides access to the device inputs and outputs of the SIMOTION device via the process image of cyclic tasks

using I/O variables.

Procedure

Open the Project tab and double-click on the ADDRESS LIST element in the device subtree, for example C240 [C240 PN].
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Illustration 90: Address List in the Project Navigator

In the next window (detailed view), create 1 variable for incoming and outgoing PPO data for each device.
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Illustration 91: Address List Detailed View

Set the following properties for each variable:

Name (of the I/O variable)

I/O address

Data type: ARRAY OF BYTE

Array length: 36

Process image: IPOsynchronousTask

N O T I C E

The I/O address must �t the con�guration of the device in the HW Con�g tool.

I/O variables can only be created in o�ine mode.
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6.13.11 Programming using the Danfoss VLT® Servo Motion Library
Before using data types, functions, or function blocks from libraries, the following construct must be used in the interface section:

USELIB DDS_BasCam, DDS_Drive, DDS_LabCam, DDS_PSM, DDS_DAM, DDS_ACM;

More information on how to use data types, functions, and function blocks from libraries can be found in detail in the online help for
SIMOTION SCOUT®. Open the SIMOTION SCOUT® and go to [Help → Help Topics → Programming → Integration of ST in SIMOTION

→ Using libraries → Using data types, functions and function blocks from libraries].

N O T I C E

Do not use the POUs, Constants, and User-De�ned Data Types (UDT) that start with iDD_ in an application.

6.13.12 Instantiating AXIS_REF_DDS in SIMOTION SCOUT®
Create 1 instance of AXIS_REF_DDS (located in folder DDS_Drive) for every servo drive that has to be controlled or monitored. Each

instance of AXIS_REF_DDS is the logical representation of 1 physical servo drive.

N O T I C E

The instance of the AXIS_REF_DDS structure must be created as a global variable (variable in the interface section of a unit

declared with VAR_GLOBAL).

In the AXIS_REF_DDS structure, only assign the variable InputLogAddress once at the beginning of the application program for each
axis. This is to specify the input logical base address of the I/O module from the HW Con�g. For this initialization, use the system

function _getLogicalAddressOfIoVariable(). Only assign the variable InputLogAddress once in the 1st PLC cycle for initialization.

In the AXIS_REF_DDS structure, assign the variable Quality at the beginning of the application program for each axis in every cycle.

Use the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data that was assigned in

the ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_DDS at the beginning of the application program for each device in every cycle. Call the

function DD_UpdateProcessOutput_DDS at the end of the application program for each device in every cycle.

N O T I C E

Only create instructions and other program parts between the calls of DD_UpdateProcessInput and DD_UpdateProcessOutput.

6.13.13 Instantiating PSM_REF in SIMOTION SCOUT®
Create 1 instance of PSM_REF (located in folder DDS_PSM) for every Power Supply Module (PSM 510) that has to be controlled or

monitored. Each instance of PSM_REF is the logical representation of 1 physical PSM.

N O T I C E

The instance of the PSM_REF structure must be created as a global variable (variable in the interface section of a unit de-

clared with VAR_GLOBAL).

In the PSM_REF structure, assign the variable Quality at the beginning of the application program for each Power Supply Module in

every cycle. Use the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data that

was assigned in the ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_PSM at the beginning of the application program for each device in every cycle. Call the

function DD_UpdateProcessOutput_PSM at the end of the application program for each device in every cycle.

N O T I C E

Only create instructions and other program parts between the calls of DD_UpdateProcessInput and DD_UpdateProcessOutput.

6.13.14 Instantiating DAM_REF in SIMOTION SCOUT®
Create 1 instance of DAM_REF (located in folder DDS_DAM) for every Decentral Access Module (DAM 510) that has to be controlled

or monitored. Each instance of DAM_REF is the logical representation of 1 physical DAM.
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N O T I C E

The instance of the DAM_REF structure must be created as a global variable (variable in the interface section of a unit de-

clared with VAR_GLOBAL).

In the DAM_REF structure, assign the variable Quality at the beginning of the application program for each Decentral Access Module

in every cycle. Use the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data that

was assigned in the ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_DAM at the beginning of the application program for each device in every cycle. Call the

function DD_UpdateProcessOutput_DAM at the end of the application program for each device in every cycle.

N O T I C E

Only create instructions and other program parts between the calls of DD_UpdateProcessInput and DD_UpdateProcessOutput.

6.13.15 Instantiating ACM_REF in SIMOTION SCOUT®
Create 1 instance of ACM_REF (located in folder DDS_ACM) for every Auxiliary Capacitors Module (ACM 510) that has to be controlled

or monitored. Each instance of ACM_REF is the logical representation of 1 physical ACM.

N O T I C E

The instance of the ACM_REF structure must be created as a global variable (variable in the interface section of a unit de-

clared with VAR_GLOBAL).

In the ACM_REF structure, assign the variable Quality at the beginning of the application program for each Auxiliary Capacitors Mod-

ule in every cycle. Use the system function _quality.<I/Ovariable>, whereby <I/Ovariable> is the variable containing the cyclic data

that was assigned in the ADDRESS LIST. Carry out this assignment in every PLC cycle.

Call the function DD_UpdateProcessInput_ACM at the beginning of the application program for each device in every cycle. Call the

function DD_UpdateProcessOutput_ACM at the end of the application program for each device in every cycle.

N O T I C E

Only create instructions and other program parts between the calls of DD_UpdateProcessInput and DD_UpdateProcessOutput.

6.13.16 Global Compiler Settings
Activate the global compiler settings Permit language extensions.

Procedure

Open the menu [Options → Settings].

In the next window, select the Compiler tab.

Activate the checkbox Permit language extensions and click on OK.
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Illustration 92: Global Compiler Settings

6.13.17 Assigning Tasks
To guarantee synchronous operation, the application must use a Synchronous Task and a Peripheral Fault Task to evaluate the alarms.

Procedure

Open the Project tab.

Double-click on EXECUTION SYSTEM in the device subtree.
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Illustration 93: Execution System in the Project Navigator

In the next window, expand entry Execution levels and then select OperationLevels and then SynchronousTask in the tree
structure.

In the SynchronousTask window, activate checkbox Use task in execution system.

Click on the new entry IPOsynchronousTask in the tree structure.

In the Program assignment area at the left side of the Synchronous Task window, assign the program by selecting it and

clicking on the [>>] button. The program will then be moved to the Programs used section on the right side.
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Illustration 94: IPOsynchronousTask in Execution System

In the Task con�guration tab, set the Number of level over�ows in the IPO cycle clock to 1 and the IPOsynchronousTask / IPO

cycle clock to 50%.

e
3

0
b

g
3

7
2

.1
0

Illustration 95: IPOsynchronousTasks Con�guration

Expand entry SystemInterruptTasks in the tree structure and select the new entry PeripheralFaultTask.

In the PeripheralFaultTask window, activate checkbox Use task in execution system.

In the Program assignment area at the left side of the PeripheralFaultTask window, assign the program by selecting it and

clicking on the [>>] button. The program will then be moved to the Programs used section on the right side.

Click on Close to save and compile the settings.
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6.14 Programming Guidelines for SIMOTION SCOUT®
Recommendations for implementation:

Only assign the variable InputLogAddress in the AXIS_REF_DDS structure once for each axis at the beginning of the program. Use

the system function _getLogicalAddressOfIoVariable to get this address from the I/O variable of the address list. Use the input
address of the module as the I/O variable. Only assign this variable in the 1st PLC cycle for initialization.

Initialize parameters that usually do not change only once at the beginning of the program.

Only assign the variable Quality in the AXIS_REF_DDS structure once for each axis at the beginning of the program. Use the

system function _quality.var-name. Carry out this check for every PLC cycle.

Call up the function blocks DD_UpdateProcessInput_DDS and DD_UpdateProcessOutput_DDS for every axis to update the proc-
ess image partition of inputs and outputs. Call up these function blocks in every PLC cycle.

Only create instructions and other program parts between calling up function blocks DD_UpdateProcessInput_DDS and DD_Up-

dateProcessOutput_DDS.

Call up function blocks that provide status or error information with Enable input at the beginning of the program.

Use 1 instance of function block MC_Power_DDS for every axis to control its power stage. Call up this function block in every PLC
cycle.

Use 1 instance of function block DD_Power_PSM for every PSM 510 to control the DC-link voltage on the output lines. Call up
this function block in every PLC cycle.

Use 1 instance of function block DD_Power_DAM for every DAM 510 to control the DC-link voltage on the output lines. Call up
this function block in every PLC cycle.

Use 1 instance of function block DD_Power_ACM for every ACM 510 to control the DC-link voltage on the output lines. Call up
this function block in every PLC cycle

Call up function blocks that execute (motion) commands at the end of the program.

Do not use any UDTs, POUs, enumerations, or constants starting with the pre�x iDD_.

Do not change the reference to the axis on a function block while it is busy.

6.15 Programming with TIA

6.15.1 Requirements for Programming with TIA
The following �les are required to integrate the servo system modules into a TIA project. In the �lename, 2.xx represents the version

number and yyyymmdd represents the date.

Table 27: Required Files

System Module File required

Whole servo system Package of libraries for the ISD 510 servo system: Danfoss_VLT_ServoMotion_V_x_y_z.zalxx.

ISD 510 servo drive GSDML �le (General station description):

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

DSD 510 servo drive GSDML �le (General station description):

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

Power Supply Module PSM 510 GSDML �le (General station description):

GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

Decentral Access Module DAM 510 GSDML �le (General station description):

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

Auxiliary Capacitors Module
ACM 510

GSDML �le (General station description):

GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml
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6.15.2 Creating a TIA Project

N O T I C E

TIA V15 or higher with must be installed to create a project.

Information on how to create a project in TIA can be found in detail in the TIA online help. Open TIA and go to [Help → Information
System → Editing projects → Creating and managing projects].

6.15.3 Including the Servo Motion Libraries into a TIA Project
The folder LIBRARIES in the Project tab contains these libraries:

DDS_Drive

Contains program organization units (POUs) de�ned by PLCopen® (name starting with MC_) and POUs de�ned by Danfoss

(name starting with DD_). The Danfoss POUs provide additional functionality for the servo drive.

It is possible to combine POUs de�ned by PLCopen® with POUs de�ned by Danfoss.

The names of the POUs that target the servo drive all end with _DDS.

DDS_PSM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Power Supply Module
(PSM 510).

The names of the POUs that target the PSM 510 all end with _PSM.

DDS_DAM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Decentral Access Module
(DAM 510).

The names of the POUs that target the DAM 510 all end with _DAM.

DDS_ACM

Contains POUs de�ned by Danfoss (name starting with DD_) and provide the functionality for the Auxiliary Capacitors Mod-
ule (ACM 510).

The names of the POUs that target the ACM 510 all end with _ACM.

DDS_BasCam

Contains POUs for the creation of basic CAMs.

DDS_LabCam

Contains POUs for the creation of labeling CAMs.

DDS_Intern

Contains POUs that are needed internally for the libraries.

Do not use these POUs in an application.

When integrating the DDS_Drive package, some standard libraries are integrated automatically, unless they are already part of the
project.

N O T I C E

Do not remove or rename these libraries.
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Illustration 96: Including the Servo Motion Libraries

Procedure

Expand the Libraries window [1], then select and expand the Global libraries section [2].

Right-click on the empty area [3] then select menu entry Retrieve library... [4].

Select the Danfoss_VLT_ServoMotion_V_x_y_z.zal1x �le (according to the location on the hard drive).

6.15.4 Importing Devices into TIA

N O T I C E

For each physical servo drive, PSM 510, DAM 510, or ACM 510, add 1 entry to the PROFINET® Ethernet network in the Hard-

ware Catalog.

Procedure
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Open the Hardware Catalog.

Select [Options → Manage general station description �les]

In tab Installed GSDs [1], select the Source path [2] where the �les are located.

To add a servo drive, select one of the xml �les [3] and click on Install. In the �lename, 2.xx represents the version number

and yyyymmdd represents the date.

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

Repeat steps 2 and 3 for:
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Power Supply Module (PSM 510): GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

Decentral Access Module (DAM 510):

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-yyyymmdd.xml

Auxiliary Capacitors Module (ACM 510): GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

6.15.5 Creating a Network

Procedure

e3
0b

i2
55

.1
0

1
2 3

54

In the Devices window, select Device con�guration [1] and add a PSM.

Assign the PSM to the PLC_1 by dragging the middle square under the PLC icon [2] onto the square at top left of the PSM
icon [3]. The PN/IE_1 network is created automatically.

Assign the PROFINET device name, IP address, and subnet mask to the PSM:

Right-click on the PSM icon.

Select the tab General.

Select PROFINET interface [X1] and then Ethernet addresses.

Enter the IP address 192.168.101.1 [4].

Enter the Subnet mask 255.255.255.0 [5].

Repeat steps 1–3 to add a DAM 510, ACM 510, ISD 510, or DSD 510.

In the Devices & networks window, select Topology view [1] and connect the devices by dragging and dropping the icons.
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Remove any existing MAIN [OB1] operation block:
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In the Project Tree, expand the Program blocks entry.

Right-click on operation block Main [OB1] [2] then select Delete in the drop-down menu.

Add a new MAIN [OB1] operation block [2] and create operation blocks for Startup [OB100] [3], and Synchronous Cycle [OB61]

[4]:

In the Project Tree, expand the Program blocks entry.

Double-click on Add new block.

In the Add new block window, select Organization block.

Select organization block MAIN [OB1] from the list.

Set the language to SCL and activate the radio button Automatic.

Click on OK.

Repeat for Startup [OB100] and Synchronous Cycle [OB61].

Verify SyncDomain:

Open Network view [1] and select the Ethernet subnet [2] in which the sync domain is set up.

Open the Ethernet subnet properties.

In the local navigation [4], select entry [Domain management → Sync domains → Sync-Domain_1].

In the �eld Sync Domain [5], change the name as desired.

In the �eld Send clock [6], select the desired value from the drop-down menu.

Activate the Default domain checkbox [7] to make this sync domain the default domain.
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Verify that all system components have the Sync slave role:
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Open Network view [1] and select the Ethernet subnet in which the sync domain is set up.

Open the Ethernet subnet [2] properties.
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In the local navigation [3], select entry [Domain management → Sync domains → Sync-Domain_1 → Device].

Select the IO devices.

Verify that all system components are present and set to Sync slave.

Select the telegram properties of each system component:
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Open Device view [1].

Select Danfoss Telegram [2].

In the Properties window [3], select the General tab [4] and then entry I/O addresses [5].

In the Input addresses section, activate the checkbox for Isochronous mode [6] then set �eld Organization block [7] to

Synchronous Cycle and �eld Process image [8] to PIP 1.

Repeat these settings in the Output addresses section [9].

Repeat this procedure for each system component.

Activate the isochronous mode for each system component:
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Open Device view [1].

In section Device overview [2], click on danfoss-psm-01 [3].

In the Properties window [4], select the General tab [5] and then menu entries [PROFINET interface [X1] → Advanced
options → Isochronous mode].

Activate the checkbox for Isochronous mode [6].

Repeat these settings for each system component.

Create the globalData Block FlexMotion_Data in which a structure for each system component will be allocated.
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In operation block Startup [OB100], check that the module access points have been allocated correctly:

Expand Program blocks in the Devices tab.

Double-click on Startup [OB100].

Type the settings in the screenshot ensuring that the module access points names match the name assigned automati-

cally by TIA. These can be found by opening menu [PLC tags → Show all tags] and then selecting the System constants

tab.
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De�ne the input and output telegram address for each system component by creating a tag table:

Select menu [PLC tags → FlexMotion], to open the FlexMotion_Telegram window.

De�ne the address of the incoming and outgoing telegram for each system component.
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In operation block Synchronous Cycle [OB61], enter the telegram read instructions as per the example below.
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In operation block Synchronous Cycle [OB61], enter the telegram write instructions as per the example below.
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6.16 Programming Guidelines for TIA
Recommendations for implementation:

Only assign the HwIdSubmodule variable in the appropriate structure of each device present at the beginning of the program.
Use the constant that is created automatically by TIA in menu [PLC tags → Show all tags → System Constants], for example,

danfoss-isd-01~Device_object_1~Module_access_point. Only assign this variable in the 1st PLC cycle for initialization. The struc-
tures to be used for each type of device are:

ISD 510: AXIS_REF_DDS

DSD 510: AXIS_REF_DDS

PSM 510: PSM_REF

DAM 510: DAM_REF

ACM 510: ACM_REF

Initialize parameters that usually do not change only once at the beginning of the program.

Call the appropriate functions for each device present in every PLC cycle:

ISD 510: DD_UpdateProcessInput_DDS and DD_UpdateProcessOutput_DDS

DSD 510: DD_UpdateProcessInput_DDS and DD_UpdateProcessOutput_DDS

SDM 511/SDM 512: DD_UpdateProcessInput_DDS and DD_UpdateProcessOutput_DDS

PSM 510: DD_UpdateProcessInput_PSM and DD_UpdateProcessOutput_PSM

DAM 510: DD_UpdateProcessInput_DAM and DD_UpdateProcessOutput_DAM

ACM 510: DD_UpdateProcessInput_ACM and DD_UpdateProcessOutput_ACM

Only create instructions and other program parts between calling up function blocks DD_UpdateProcessInput_xxx and DD_Up-

dateProcessOutput_xxx.

Call up function blocks that provide status or error information with Enable input at the beginning of the program.
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Use 1 instance of function block MC_Power_DDS for every axis to control its power stage. Call up this function block in every PLC
cycle.

Use 1 instance of function block DD_Power_PSM for every PSM 510 to control the DC-link voltage on the output lines. Call up
this function block in every PLC cycle.

Use 1 instance of function block DD_Power_DAM for every DAM 510 to control the DC-link voltage on the output lines. Call up
this function block in every PLC cycle.

Use 1 instance of function block DD_Power_ACM for every ACM 510 to control the DC-link voltage on the output lines. Call up
this function block in every PLC cycle

Call up function blocks that execute (motion) commands at the end of the program.

Do not use any UDTs, POUs, enumerations, or constants starting with the pre�x iDD_.

Do not change the reference to the axis on a function block while it is busy.

6.17 VLT® Servo Toolbox Software

6.17.1 Overview
The VLT® Servo Toolbox is a standalone PC software designed by Danfoss. It is used for parameterization and diagnostics of the

system modules. It is also possible to operate the devices in a non-productive environment.

N O T I C E

The VLT® Servo Toolbox software must be allowed for every �rewall pro�le (private/public/domain).

The VLT® Servo Toolbox contains several subtools that provide various functionalities.

Table 28: Important Subtools

Subtool Description

Scope For visualization of the tracing functionality of the servo drives, the Power Supply Module (PSM 510),
the Decentral Access Module (DAM 510), and the Auxiliary Capacitors Module (ACM 510).

Parameter list For reading/writing parameters.

Firmware update For updating the �rmware on the devices.

Drive control For operating the servo drives for testing purposes.

PSM control For operating the Power Supply Module (PSM 510) for testing purposes.

DAM control For operating the Decentral Access Module (DAM 510) for testing purposes.

ACM control For operating the Auxiliary Capacitors Module (ACM 510) for testing purposes.

CAM editor For designing CAM pro�les for the servo drives.

Con�guration parameter For setting up the motor and feedback parameters, and PID settings.

Drive commissioning For motor feedback adjustment and inertia measurement.

The detailed description of the VLT® Servo Toolbox functionality and the full parameter lists can be found in the VLT® Servo Drive

System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming Guide.

6.17.2 System Requirements
To install the VLT® Servo Toolbox software, the PC must meet the following requirements:

Supported hardware platforms: 32.bit, 64-bit.

Supported operating systems: Windows 7, Windows 8.1, Windows 10.

.NET framework version: 4.7.
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Minimum hardware requirements: 512 MB RAM, Intel Pentium 4 with 2.6 GHz or equivalent, 20 MB hard disk space.

Recommended hardware requirements: Minimum 1 GB RAM, Intel Core i5/i7 or compatible.

6.17.3 Installing the VLT® Servo Toolbox Software
Administrator rights are required to install the software with the Windows operating system. If necessary, contact your system ad-
ministrator.

Procedure

Check that your system meets the system requirements speci�ed in 6.17.2 System Requirements.

Download the VLT® Servo Toolbox installation �le from the Danfoss website.

Right-click on the .exe �le and select Run as administrator.

Follow the on-screen instructions to complete the installation process.

6.17.4 VLT® Servo Toolbox Communication

6.17.4.1 Overview
This chapter describes the Ethernet-speci�c network interface settings needed by the VLT® Servo Toolbox. There are 2 basic commu-

nication methods: direct communication and indirect communication. Their particular network settings are described in the respec-
tive subchapters.

Read and perform the steps with care. Incorrect network con�gurations can lead to loss of connectivity of a network interface.

6.17.4.2 Firewall
Depending on the �rewall settings and the �eldbus used, the messages sent and received by the VLT® Servo Toolbox may be

blocked by the �rewall on the VLT® Servo Toolbox host system. This may lead to a loss of communication and the inability to com-

municate with the devices on the �eldbus. Therefore, ensure that the VLT® Servo Toolbox is allowed to communicate through the

�rewall on the VLT® Servo Toolbox host system. Inappropriate changes to �rewall settings may lead to security issues.

N O T I C E

When using a dedicated network interface, the VLT® Servo Toolbox must be allowed to communicate speci�cally through

this network interface.

6.17.4.3 Indirect Communication

6.17.4.3.1 Overview
Communication between ISD 510/DSD 510 devices and the VLT® Servo Toolbox through a PLC is called indirect communication.

Ethernet-based �eldbus communication (marked A in the graphic) takes place between the PLC and the ISD 510/DSD 510 devices.
However, there is non-�eldbus communication between the PLC and the VLT® Servo Toolbox host system.

In the scenario shown, the PLC has the master function and uses cyclic communication with the devices. Therefore, not all function-
alities of the VLT® Servo Toolbox, for example the drive control, can be used.

The restrictions when using indirect communication are detailed in the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT®

Flexmotion™) Programming Guide.
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Illustration 97: Logical View of Indirect Ethernet-based Fieldbus Communicaton (Communication via PLC)

A Fieldbus

B VLT® Servo Toolbox host system

N O T I C E

The logical view only shows the connectivity from a high-level software perspective and does not re�ect the actual physical
topology of the network.

6.17.4.3.2 Network Settings for Indirect Communication
Any network interface can be used to communicate through a PLC. A dedicated network interface is not required.

When establishing the communication through a PLC, the VLT® Servo Toolbox con�gures a routing table using the selected Network

Address Translation (NAT). Adding a route to the Windows routing table requires administrator privileges. Therefore, administrator
credentials may be requested when initializing the connection.

6.17.4.3.3 Enabling Indirect Communication
Carry out the following steps to enable indirect communication.

N O T I C E
When observing the network packets via Wireshark®, checksum o�oading often causes confusion as the network packets to be

transmitted are handed over to Wireshark® before the checksums have been calculated. Wireshark® shows these empty check-

sums as invalid, even though the packets contain valid checksums when they leave the network hardware later. Use 1 of these 2

methods to avoid this checksum o�oading problem:

Turn o� the checksum o�oading in the network driver if possible.

Turn o� the checksum validation of the speci�c protocol in the Wireshark® preferences.

Disable IPv6 on the network interfaces used for communication on the PC:

Procedure

Open the Network and Sharing Center.

Select Change adapter settings.

Right-click on the network interface used for �eldbus communication and select Properties.

If the TCP/IPv6 is available for the network interface, disable it.
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6.17.4.3.4 Additional Settings for Indirect Communication with EtherCAT®
Set the IP address of the EtherCAT® Master:

Procedure

Open the TwinCAT® System Manager.

Select [I/O-Con�guration → I/O Devices → Device1 (EtherCAT®)] and check the IP-address in the Adapter tab. The IP-address

of the PLC's network adapter may not be a link-local address (so not in the range of 169.254.0.1 to 169.254.255.254).

If necessary, change the IP-address inside the IPv4 Protocol properties according to the given operating system. This can be

done on the controller locally or via Remote Desktop.

6.17.4.3.5 Activating the IP Routing in the EtherCAT® Master
The procedure described here may vary depending on the type of PLC and operating system installed.

Procedure

Open the TwinCAT® System Manager.

Click on Advanced Settings... via menu [I/O-Con�guration → I/O Devices → Device1 (EtherCAT)] in the EtherCAT tab.

Select EoE Support in the Advanced Settings window.

Enable Connect to TCP/IP Stack in the Windows Network section.

Enable IP Enable Router in the Windows IP Routing section.

Reboot the PLC for the changes to take e�ect.

6.17.4.3.6 Setting the IP Address of the EtherCAT® Slave
The procedure for setting the IP Address of the EtherCAT® slave is valid for:

ISD 510/DSD 510 servo drives

Power Supply Module (PSM 510)

Decentral Access Module (DAM 510)

Auxiliary Capacitors Module (ACM 510)

N O T I C E

The last number of the IP address is the ID that is used in the VLT® Servo Toolbox to identify the device.

Procedure

Open the TwinCAT® System Manager.

Click on Advanced Settings... under [I/O-Con�guration → I/O Devices → Device1 (EtherCAT) → Box 1 (VLT® Decentral Ac-

cess Module → Drive 2 (VLT® Integrated Servo Drive ISD 510)] in the EtherCAT® tab.

Select [Mailbox → EoE] in the Advanced Settings window.

Enable Virtual Ethernet Port and enter a valid IP-address.

Each slave in the con�guration requires an IP-address. This address is reassigned with every transition from INIT to Pre-Op-

erational state of the slave state machine. The IP communication of the slaves is deactivated per default.

6.17.4.3.7 Additional Settings for Indirect Communication with PROFINET®

6.17.4.3.7.1 Overview
Each PROFINET℠ device needs a device name and an IP address. The IP address and the device name are assigned by the I/O con-

troller, when the connection to the I/O device is established.

For the automatic detection of accessible nodes via a PG/PC interface with TCP/IP, connect the nodes to the same physical Ethernet
subnet as the PG/PC. If a node is located in a di�erent physical Ethernet subnet, the IP address of the sought node can be speci�ed.

To reach further nodes, accessible nodes provide the capability of adding IP addresses and subnets to the PG/PC interface. The new
IP addresses and subnets are then added to the Ethernet interface of the PG/PC.

6.17.4.3.7.2 Adding IP Addresses and Subnets

Procedure
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Open SIMOTION SCOUT®.

Select the menu [Project → Accessible nodes].

If accessible nodes are found in another subnet, the Add IP addresses / subnet masks window is displayed and shows them.
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Illustration 98: Accessible Nodes

Click on Yes to accept the addresses.

The IP address/subnet mask is now added.

N O T I C E

If >1 Danfoss servo drive is used in the same PROFINET® network, each servo drive must have a di�erent name and IP ad-

dress.

The last number of the IP address is the ID that is used in the VLT® Servo Toolbox software to identify the device.

When the Accessible nodes tab is closed, the addresses are retained. The newly added addresses are only discarded when
SIMOTION SCOUT® is closed.

N O T I C E

IP addresses and subnets can also be added using PRONETA.

6.17.4.4 Direct Communication

6.17.4.4.1 Overview
For Ethernet-based �eldbus communication (direct communication), the VLT® Servo Toolbox must use a dedicated network inter-

face on the VLT® Servo Toolbox host system. Do not use this network interface simultaneously for any other communication.
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Illustration 99: Logical View of Direct Ethernet-based Fieldbus Communication

A Ethernet-based �eldbus communication

B VLT® Servo Toolbox host system

W A R N I N G

The logical view only shows the connectivity from a high-level software perspective and does not re�ect the actual physical
topology of the network.

6.17.4.4.2 Network Settings for Direct Communication with Ethernet POWERLINK®
Disable all network protocols except TCP/IPv4 on the network interface used for direct Ethernet POWERLINK® communication. This

prevents other PC software or the operating system using this network interface for other tasks, such as �le and printer sharing and
network discovery. Disabling these protocols reduces the number of non-relevant packets sent over the network interface and thus
reduces the overall network load.

6.17.4.4.3 Disabling Unused Protocols on the Network Interface on the PC

Procedure

Open the Network and Sharing Center.

On the left, click on Change adapter settings.

Right-click on the network interface used for �eldbus communication and select Properties.

Uncheck all checkboxes except the one for Internet Protocol Version 4 (TCP/IPv4).

Disable the IPv4 Checksum o�oad on the network interfaces as described in 6.17.4.3.3 Enabling Indirect Communication.
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Illustration 100: Local Area Connection 2 Properties

6.17.4.4.4 Setting the Correct Ethernet POWERLINK® Master IP Address

Procedure

Open the Network and Sharing Center.

On the left, click on Change adapter settings.

Right-click on the network interface used for �eldbus communication and select Properties.

Click on Internet Protocol Version 4 (TCP/IPv4) (the checkbox must be checked) and then click on Properties.

Select Use the following IP address and use 192.168.100.240 as the IP address and 255.255.255.0 as the subnet mask. Leave
all other �elds empty.

e3
0b

h5
31

.1
0

Illustration 101: Internet Protocol Version 4 (TCP/IPv4) Properties

6.17.4.4.5 Network Settings for Direct Communication with EtherCAT®
Disable all network protocols except TCP/IPv4 on the network interface used for direct EtherCAT® communication. This prevents
other PC software or the operating system using this network interface for other tasks, such as �le and printer sharing and network
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discovery. Disabling these protocols reduces the number of non-relevant packets sent over the network interface and thus reduces
the overall network load.

6.17.5 VLT® Servo Toolbox Commissioning

6.17.5.1 Step 1: Opening the Main Window
The Main Window is the basis for all VLT® Servo Toolbox functionalities. It consists of the following components:

e3
0b

e3
11

.1
2

1

2

3

4

5

7

8

9

6

Illustration 102: Main Window

Table 29: Main Window Description

Leg-

end

num-

ber

Name Description

1 Menu bar Contains the general functionalities for saving and loading projects, managing connections, showing
and changing settings, managing open subtools, and showing help contents.

2 Tool bar Contains shortcuts for saving and loading projects, connecting to and disconnecting from networks,
automatic searching for online devices, and manually adding devices.

3 Online status
and state in-
formation

Online devices are indicated by a glowing light bulb next to the device ID.

An online device is a logical device for which a physical device exists that the VLT® Servo Toolbox is

connected to.

The color indicates the state of the device and is device-speci�c.
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Name Description

O�ine status
and state in-
formation

O�ine devices are indicated by a gray light bulb next to the device ID.

An o�ine device is a logical device without a corresponding physical device. An o�ine device can
represent a saved device con�guration or state, for example for o�ine analysis or troubleshooting.
It also contains pre-con�gured parameter values to be written to a physical device.

4 Available sub-
tools

A subtool is opened by double-clicking on its name in the Device Environment, or by selecting the en-

try and pressing the Enter key on the keyboard.

5 Device envi-
ronment

The Device Environment section of the Main Window lists all logical devices managed by the VLT® Servo

Toolbox, visualizes their states, and serves as the user interface for accessing the device functionalities.

The Device Environment window lists all available subtools for each added device.

See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming

Guide for further information on the subtools.

6 Workspace This is the space for hosting the subtools and its size depends on the Main Window size. The subtools
can be maximized, minimized, horizontally or vertically aligned, or cascaded.

7 Watchlist win-
dow

Evaluates the parameter values of 1 or more devices by cyclically reading them from the devices. Al-
lows parameter values to be logged and saved to a text �le. It is also possible to modify/write values in
the watchlist.

8 Output win-
dow

Shows operating information, warnings, and errors. Depending on the user settings, shows messages
of up to 3 di�erent logging levels (high, medium, and low). Used for showing advanced error and
warning information.

9 Status strip Shows the communication state of the VLT® Servo Toolbox. If connected to a network, it shows the

used hardware interface (for example, network adapter) and the network name.

6.17.5.2 Step 2: Connecting to Network
Pre-con�gure the appropriate communication settings to connect to a network (see 6.17.4.1 Overview).

Procedure

In the Main Window toolbar, click on the Connect to bus icon to open the Connect to Network window.

Select the �eldbus type and the network interface to connect to.

Click on OK to connect.

Verify that the connection is successful by checking the status strip at the bottom of the Main Window.
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Illustration 103: Connect to Network Window (Ethernet POWERLINK®)
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6.17.5.3 Step 3: Scanning for Devices

Procedure

After verifying that the VLT® Servo Toolbox is connected to the selected network, click on the Scan for Devices icon in the

toolbar to trigger the device scan procedure.

N O T I C E

If connected to an Ethernet POWERLINK® network in cyclic mode, select the scan range (minimum and maximum IDs) in the

next window to reduce the time needed for scanning. In all other cases, the complete ID range is scanned.

When the scan is complete, a list of available devices is shown in the Select Devices window. Select the devices to be added

to the Device Environment and click on OK.

All selected devices appear in the Device Environment window and automatically go online (indicated by a glowing light
bulb next to each device name).

6.18 Motion Library

6.18.1 Function Blocks
The PLC library provides function blocks that support the functionality of the servo system and comply with this standard:

PLCopen® Technical Speci�cation Function blocks for motion control (Formerly Part 1 and Part 2) Version 2.0 March 17, 2011.

In addition to the PLCopen® functionality, Danfoss o�ers further functions for the servo system.

The following PLCopen® characteristics apply to all function blocks:

Commanding (using the inputs)

Signaling (behaviour of the outputs)

General calling conventions

N O T I C E

See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming Guide for further informa-

tion on the available function blocks and their behavior.

6.18.2 Simple Programming Template
TwinCAT®:

A basic sample PLC application for starting up the servo system with 1 Power Supply Module (PSM 510), 1 Decentral Access Module

(DAM 510), and 2 axes is provided. The project DDS_ServoMotion_SampleProject can be downloaded from the Danfoss website.

Automation Studio™:

Detailed information on how to open the sample project within the ISD package in Automation Studio™ can be found in the Auto-

mation Studio™ Help. Open the B&R Help Explorer and go to [Programming → Examples → Adding sample programs] and follow

the instructions for library samples.

PROFINET®

The project DDS_ServoMotion_SampleProject is a basic sample PLC (C240PN) application for starting up the servo system with 1
Power Supply Module (PSM 510), 1 Decentral Access Module (DAM 510), and 2 axes.
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7 Operation

7.1 Operating Modes
The ISD 510/DSD 510 servo drives implement several modes of operation. The behavior of the servo drive depends on the activated
mode of operation. It is possible to switch between the modes while the servo drive is enabled. The supported modes of operation
are according to CANopen® CiA DS 402 and there are also ISD-speci�c modes of operation. All supported modes of operation are

available for EtherCAT®, Ethernet POWERLINK®, and PROFINET®. The various modes of operation are described in detail in the VLT®

Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming Guide.

Inertia meas-
urement
mode

This mode measures the inertia of an axis. It is used to measure the inertia of the servo drive and the external
load, and to optimize the control loop settings. The friction e�ects are eliminated automatically.

Pro�le veloc-
ity mode

In pro�le velocity mode, the servo drive is operated under velocity control and executes a movement with con-
stant speed. Additional parameters, such as acceleration and deceleration, can be parameterized.

Pro�le posi-
tion mode

In pro�le position mode, the servo drive is operated under position control and executes absolute and relative
movements. Additional parameters, such as velocity, acceleration, and deceleration, can be parameterized.

Pro�le tor-
que mode

In pro�le torque mode, the servo drive is operated under torque control and executes a movement with constant
torque. Linear ramps are used. Additional parameters, such as torque ramp and maximum velocity, can be para-
meterized.

Homing
mode

In homing mode, the application reference position of the servo drive can be set. Several homing methods, such
as homing on actual position, homing on block, limit switch, or home switch, are available.

CAM mode In CAM mode, the servo drive executes a synchronized movement based on a master axis. The synchronization
takes place by means of a CAM pro�le that contains slave positions corresponding to master positions. CAMs can
be designed graphically with the DDS Toolbox software, or can be parameterized via the PLC. The guide value can
be provided by an external encoder, virtual axis, or the position of another axis.

Gear mode In gear mode, the servo drive executes a synchronized movement based on a master axis by using a gear ratio
between the master and the slave position. The guide value can be provided by an external encoder, virtual axis,
or the position of another axis.

Cyclic syn-
chronous
position
mode

In cyclic synchronous position mode, the trajectory generator of the position is located in the control device, not
in the servo drive.

Cyclic syn-
chronous ve-
locity mode

In cyclic synchronous velocity mode, the trajectory generator of the velocity is located in the control device, not
in the servo drive.

AC1 In application class 1 (AC1) mode a main setpoint (for example speed setpoint) is used to control the servo drive
in PROFINET® IO. Speed control is handled entirely within the servo drive.

AC4 Application class 4 (AC4) de�nes an interface between the speed setpoint interface and actual position value in-
terface, where speed control is executed on the servo drive and position control on the controller. The motion
control for multiple axes is performed centrally, for example by numerical control (NC). The position control loop
is closed by the �eldbus. Clock synchronization is required to synchronize the clocks for the position control in
the controller and for the speed control in the drives (PROFINET® with IRT).

7.1.1 Motion Functions

Function Description

Digital CAM
switch

This functionality controls whether the digital output is enabled or disabled, depending on the axis position. It
performs a function comparable to switches on a motor shaft. Forward and backward movements of the axis
position are allowed. On and o� compensation and hysteresis can be parameterized.

Touch probe This functionality stores the position actual value at a rising or falling edge of the con�gured digital input.
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Function Description

Guide value The guide value is used in all synchronous modes of operation (CAM mode and Gear mode). It is used as the
master position within the synchronous modes.

7.2 Operating Status Indicators
The operating status of the ISD 510/DSD 510 servo drive, PSM 510, DAM 510, and ACM 510 is indicated via the LEDs on each device.

7.2.1 Operating LEDs on the ISD 510/DSD 510 Servo Drive

DEV STAT X1

X2

X3

NET STAT

LINK/ACT

Advanced
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Illustration 104: Operating LEDs on the ISD 510/DSD 510 Servo Drive

Table 30: Operating LEDs on the ISD 510/DSD 510 Servo Drive

LED Color Flash status Description

DEV STAT Green On Servo drive is in state Operation enabled

Flashing Auxiliary voltage is applied.

Red On Servo drive is in Fault or Fault reaction active state.

Flashing DC-link voltage is not applied.

NET STAT Green/red Fieldbus dependent Network status of the device (see corresponding �eldbus standard).

Link/ACT X1 Green – Link/activity status of Hybrid In (X1)

On Ethernet link established.

Flashing Ethernet link established and active.

O� No link.

Link/ACT X2 Green – Link/activity status of Hybrid Out (X2)

On Ethernet link established.
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LED Color Flash status Description

Flashing Ethernet link established and active.

O� No link.

Link/ACT X3
(1)

Green – Link/activity status of the Ethernet port (X3).

On Ethernet link established.

Flashing Ethernet link established and active.

O� No link.

1 Only for advanced servo drive with POWERLINK® or EtherCAT®.

7.2.2 Operating LEDs on the PSM 510

STATUS PSM

LINK/ACT

DEV

SVS ST

NET ST

X1

X2

e3
0b

g5
76

.1
1

Illustration 105: Operating LEDs on PSM 510

Table 31: Operating LEDs on PSM 510

LED Color Flash status Description

DEV Green On Device is in state Operation enabled.

Flashing Device is in state Standby or Power-up.

Red On Device is in state Fault or Fault reaction active.

Flashing Input mains is not applied.

SVS ST Green On 24 V safety supply is applied.

O� 24 V safety supply is not applied.

NET ST Green On Connected.

Orange On Online.

Red Flashing Initialization.

On Initialization failed or other error.
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LED Color Flash status Description

LINK/ACT X1

(Link/activity status of In)

Green On Ethernet link established.

Flashing Ethernet link established and active.

O� No link.

LINK/ACT X2

(Link/activity status of Out)

Green On Ethernet link established.

Flashing Ethernet link established and active.

O� No link.

7.2.3 Operating LEDs on the DAM 510

STATUS DAM

LINK/ACT

DEV

SVS ST

NET ST

AUX

X1

X2

X3

e3
0b

g5
77

.1
1

Illustration 106: Operating LEDs on DAM 510

Table 32: Operating LEDs on DAM 510

LED Color Flash status Description

DEV Green On Device is in state Operation enabled.

Flashing Device is in state Standby or Power-up.

Red On Device is in state Fault or Fault reaction active.

Flashing DC-link is not applied at the input.

SVS ST Green On 24 V safety supply is applied.

O� 24 V safety supply is not applied.

NET ST Green On Connected.

Orange On Online.

Red Flashing Initialization.

On Initialization failed or other error.

AUX Green On Auxiliary voltage is applied to the output connector.
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LED Color Flash status Description

(State of the auxiliary voltage)
O� Auxiliary voltage is not applied to the output connector.

Red On Auxiliary voltage undervoltage detected in the hardware.

LINK/ACT X1

(Link/activity of In)

Green On Ethernet link established.

Flashing Ethernet link established and active.

O� No link.

LINK/ACT X2

(Link/activity status of Hybrid Out)

Green On Ethernet link established.

Flashing Ethernet link established and active.

O� No link.

LINK/ACT X3

(Link/activity status of Out)

Green On Ethernet link established.

Flashing Ethernet link established and active.

O� No link.

7.2.4 Operating LEDs on the ACM 510

STATUS ACM

LINK/ACT

DEV

CAP ST

NET ST

X1

X2

e
3

0
b

g
5

7
8

.1
0

Illustration 107: Operating LEDs on ACM 510

Table 33: Operating LEDs on ACM 510

LED Color Flash status Description

DEV Green On Device is in state Operation enabled.

Flashing Device is in state Standby or Power-up.

Red On Device is in state Fault or Fault reaction active.

Flashing DC-link is not applied at the input.

CAP ST Green On Capacitors fully charged.

Flashing Capacitors charging/discharging.
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LED Color Flash status Description

O� Capacitors discharged.

NET ST Green On Connected.

Orange On Online.

Red Flashing Initialization.

On Initialization failed or other error.

LINK/ACT X1

(Link/activity of In)

Green On Ethernet link established.

Flashing Ethernet link established and active.

O� No link.

LINK/ACT X2

(Link/activity status of Out)

Green On Ethernet link established.

Flashing Ethernet link established and active.

O� No link.
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8 Functional Safety Concept

8.1 Functional Description
The servo system integrates the safety function Safe Torque O� (STO). The safety function is available in daisy-chain format, which is
possible between all system components except for ACM 510 (cables are not included). The hybrid cable passes the STO signal from
the Decentral Access Module (DAM 510) to all ISD 510/DSD 510 servo drives in the chain. Once STO is activated (safe state), no tor-
que is generated on the ISD 510 servo drives, or on any motors connected to DSD 510. Reset of the safety function and diagnostics
can be carried out via the PLC.

N O T I C E

Use the STO function when performing mechanical work on the servo system or a�ected area of a machine to avoid a me-
chanical hazard. However, the STO function does not provide electrical safety.

8.2 Safety Precautions

W A R N I N G
UNCONTROLLED MOVEMENT

External forces on the motor could cause an uncontrolled and hazardous movement that could result in death or serious injury.

Equip the motor with additional measures for preventing uncontrolled and hazardous movement, for example mechanical
brakes.

W A R N I N G
RISK OF ELECTRICAL SHOCK

The STO function does not isolate mains voltage to the servo system or auxiliary circuits. Failure to isolate the mains voltage sup-

ply and wait for the speci�ed discharge time to elapse could result in death or serious injury.

Only perform work on electrical parts of the servo system or the ISD 510/DSD 510 servo drives after isolating the mains volt-
age supply and waiting for the discharge time to elapse.

W A R N I N G
RISK OF RESIDUAL ROTATION

Due to failures in the power semiconductor of the drive, a residual rotation can result from a fault that could result in death or

serious injury. The rotation can be calculated to angle = 360°/(number of poles).

Take this residual rotation into consideration and ensure that it does not pose a safety risk.

W A R N I N G
LED STATUS RELIABILITY

Status indicators (LEDs) are not reliable for safety functions.

Only use status indicators for general diagnostics during commissioning and troubleshooting.

N O T I C E

After installing the STO function, perform a commissioning test. A passed commissioning test is mandatory after initial instal-
lation and after each change to the safety installation (see 8.8 Commissioning Test).

N O T I C E

If required, implement a manual reset function according to EN ISO 13849-1. For automatic restart without manual reset,
observe the requirements detailed in paragraph 6.3.3.2.5 of EN ISO 12100:2010 or equivalent standard.
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N O T I C E

Carry out a risk assessment to select the correct stop category for each stop function in accordance with EN 60204-1.

When designing the machine application, consider timing and distance for coast to stop (Stop Category 0 or STO). See
EN 60204-1 for further information.

All signals connected to the STO must be supplied by a PELV supply.

8.3 Quali�ed Personnel for Working with Functional Safety
The STO function can only be installed, programmed, commissioned, maintained, and decommissioned by quali�ed personnel.
Quali�ed personnel for the functional safety concept are quali�ed electrical engineers, or persons who have received training from
quali�ed electrical engineers and are suitably experienced to operate devices, systems, plant, and machinery in accordance with the
general standards and guidelines for safety technology.

Furthermore, they must:

Be familiar with the basic regulations concerning health and safety/accident prevention.

Have read and understood the safety guidelines given in this manual.

Have a good knowledge of the generic and specialist standards applicable to the speci�c application.

Users of power drive systems (safety-related) (PDS(SR)) are responsible for:

Hazard and risk analysis of the application.

The overall safety of the application.

Identifying safety functions required and allocating SIL or PL to each of the functions, other subsystems, and the validity of sig-
nals and commands from them.

Designing appropriate safety-related control systems, such as hardware, software, and parameterization.

8.4 Applied Standards and Compliance
Use of the STO function requires that all provisions for safety, including relevant laws, regulations, and guidelines, are satis�ed.

The integrated STO function complies with the following standards:

IEC 60204-1: 2016 Stop Category 0 – uncontrolled stop

EN 60204-1: 2018 Stop Category 0 – uncontrolled stop

IEC/EN 61508: 2010 SIL 2

IEC 61800-5-2: 2016 SIL 2

EN 61800-5-2: 2017 SIL 2

IEC 62061: 2005 and A1: 2012 and A2: 2015

EN 62061: 2005 and Cor.:2010 and A1: 2013 and A2: 2015

IEC/EN 62061: 2015 SIL CL2

EN ISO 13849-1: 2015 Category 3, PL d

EN ISO 13849-2: 2014

8.5 Abbreviations and Conventions
Table 34: Safety-related Abbreviations and Conventions

Abbrevia-

tion

Reference Description

Cat. EN ISO 13849-1 Category B, 1–4

DC – Diagnostic coverage

FIT – Failure in time

Failure rate: 1E-9/hour

HFT EN IEC 61508 Hardware fault tolerance
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Abbrevia-

tion

Reference Description

HFT = n means that n + 1 faults may lead to a loss of the safety function.

MTTFD EN ISO 13849-1 Mean time to failure – dangerous

Unit: years

PFH EN IEC 61508 Probability of dangerous failures per hour

Take this value into account if the safety device is operated in high demand mode or in contin-
uous operating mode, where the frequency of demands for operation made on a safety-related
system occurs more than once per year.

PL EN ISO 13849-1 Performance level

A discrete level used to specify the capability of safety-related parts of a system to perform
safety-oriented functions under foreseeable conditions. Levels: a–e.

SFF EN IEC 61508 Safe Failure Fraction [%]

Proportion of safe failures and detected dangerous failures of a safety function or a subsystem
as a percentage of all possible failures.

SIL EN IEC 61508

EN IEC 62061

Safety Integrity Level

STO EN IEC 61800-5-2 Safe Torque O�

8.6 Installation
Only Danfoss cables can be used for the installation of the servo system, however cables from other suppliers can be used for the

user connection to the STO terminal STO DAM (Pins 1 and 2) on the Decentral Access Module (DAM 510).

N O T I C E

If the application does not require the Safe Torque O� (STO) functionality, build a bridge by connecting +24 V from the con-

nector STO 1 IN: +24 V to STO 1 IN: +STO, and from STO 1 IN: –24 V to STO 1 IN: –STO.

Safety relays that have a plus and minus switching output signal can be directly connected to the servo system to activate STO.

The example in Illustration 108 shows the basic connection to be made for the STO function. A suitable safety device to switch it o�
is not supplied by Danfoss. The STO is activated by opening STO+ and STO–.

Table 35: Activation of STO Function

STO+ STO– STO function

24 V GND STO deactivated

Open GND STO activated

24 V Open STO activated

Open Open STO activated

N O T I C E

Do not exceed 30 V at the STO inputs.

STO is activated if the plus input is between –3 V and +3 V.

STO is deactivated if the plus input is between +21.6 V and +26.4 V.
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Illustration 108: Safety Relay with Plus and Minus Switching Output

Signals with test pulses must not have test pulses of >1 ms. Longer pulses may lead to reduced availability of the servo system.

8.6.1 Protective Measures

Install the ISD 510/DSD 510 system components with a protective rating of less than IP54 in an IP54 cabinet as per IEC 60529 or
in an equivalent environment. In special applications, higher IP protection may be necessary.

If external in�uences can a�ect the motor axis, for example suspended loads, use additional measures, such as a safety holding
brake, to eliminate hazards.

8.7 Application Example
An example of an application that can be put in Safe Torque O� mode by a safety circuit is shown in Illustration 109.

The safety circuits can be remote from each other and are not supplied from the VLT® Servo Drive System ISD 510/DSD 510.

Select the safety switch devices in accordance with the requirements of the application.

+24 VDC

GND

e
3

0
b

g
2

7
3

.1
0

8a

8b

53

42

1

X1

X2

X1

X2

9

7

6

Illustration 109: Application Example: Safe Torque O� Function

1 24 V DC supply

2 Safety device

3 Emergency stop button

4 Safety device contacts

5 Decentral Access Module (DAM 510)

6 Hybrid cable

7 Feed-in cable

8a Servo drive

8b Servo drive

9 Loop cable

8.8 Commissioning Test

N O T I C E

Perform a commissioning test for the whole servo system after installation of the STO function, after every change to the
installed function, or after a safety fault.

There are 2 ways to implement the commissioning test depending on the method used to program the PLC, however the steps of
the test are the same:
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Using the Danfoss Library or the TwinCAT® Library.

Bit-wise readout of the status.

8.8.1 Commissioning Test using Libraries
Depending on the application, 1 or both of the following libraries are required to program the commissioning test:

Danfoss Library

MC_ReadAxisInfo_DDS

MC_ReadStatus_DDS

MC_ReadAxisError_DDS

MC_Reset_DDS

TwinCAT® Library

MC_ReadStatus

MC_ReadAxisError

MC_Reset

Table 36: Commissioning Test using Libraries

Test steps Reason for the test

step

Expected result for Danfoss library Expected result for Twin-

CAT® library

1 Run the application (all
the servo drives are ena-
bled).

Check that the appli-
cation can run.

Application runs as expected. Application runs as expec-
ted.

2 Stop the application. – All servo drives are at speed 0 RPM. All servo drives are at speed
0 RPM.

3 Disable all the servo
drives.

– All servo drives are disabled. All servo drives are disabled.

4 Enable STO. Check that STO can
be activated without
error.

MC_ReadAxisInfo_DDS output SafeTor-

queO� = True for all servo drives on the
corresponding line.

–

5 Disable STO. Check that STO can
be deactivated with-
out error. No reset is
required.

MC_ReadAxisInfo_DDS output SafeTor-

queO� = False for all servo drives on the
corresponding line.

–

6 Run the application (all
the servo drives are ena-
bled).

– Application runs as expected. Application runs as expec-
ted.

7 Enable STO. Check that errors are
generated correctly
when STO is activated
while the servo drives
are running.

Motors are torque free. Motors coast
and stop after some time.

MC_ReadAxisInfo_DDS output SafeTor-

queO� = True

and

MC_ReadStatus_DDS output ErrorStop =
True

and

MC_ReadAxisError_DDS output AxisEr-

rorID = 0xFF80 on all enabled servo
drives.

Motors are torque free. Mo-
tors coast and stop after
some time.

For enabled motors:

MC_ReadStatus output Error-

Stop = True

and

MC_ReadAxisError output Axi-

sErrorID = 0xFF80 on all ena-
bled servo drives.

8 Try to run the applica-
tion (enable 1 or more
servo drives).

Checks that the STO
function is working
correctly.

Application does not run. Application does not run.
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Test steps Reason for the test

step

Expected result for Danfoss library Expected result for Twin-

CAT® library

9 Disable STO. Check that the STO
start is still inhibited
by the error signal.

MC_ReadAxisInfo_DDS output SafeTor-

queO� = False

and

MC_ReadStatus_DDS output ErrorStop =
True

MC_ReadStatus output Error-

Stop = True

10 Try to run the applica-
tion (enable 1 or more
servo drives).

Check whether reset
is required.

Application does not run. Application does not run.

11 Send a reset signal via

MC_Reset(_DDS).

– MC_ReadAxisInfo_DDS output SafeTor-

queO� = False

and

MC_ReadStatus_DDS output ErrorStop =
False

MC_ReadStatus output Error-

Stop = False

12 Try to run the applica-
tion (all servo drives are
enabled).

– Application runs as expected. Application runs as expec-
ted.

8.8.2 Commissioning Test using PROFINET® Devices
Table 37: Commissioning Test using PROFINET® Devices

Test steps Reason for the test step Expected result

1 Run the application (all the servo
drives are enabled).

Check that the application can run. Application runs as expected.

2 Stop the application. – All servo drives are at speed 0 RPM.

3 Disable all the servo drives. – All servo drives are disabled.

4 Enable STO. Check that STO can be activated
without error.

No errors are present. The successful STO acti-
vation can be checked on the LEDs on the devi-
ces.

5 Disable STO. Check that STO can be deactivated
without error. No reset is required.

No errors are present. The STO status can be
checked on the LEDs on the devices.

6 Run the application (all the servo
drives are enabled).

– Application runs as expected.

7 Enable STO. Check that errors are generated
correctly when STO is activated
while the servo drives are running.

Motors are torque free. Motors coast and stop
after some time.

Error 0x11E is shown in object 0x603F on all
servo drives.

8 Try to run the application (enable 1
or more servo drives).

Checks that the STO function is
working correctly.

Application does not run.

9 Disable STO. Check that the STO start is still in-
hibited by the error signal.

Error 0x11E is shown in object 0x603F on all
servo drives.

10 Try to run the application (enable 1
or more servo drives).

Check whether reset is required. Application does not run.
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Test steps Reason for the test step Expected result

11 Send a reset signal via the PLC. – STO error 0x11E is cleared in all servo drives.

12 Try to run the application (all servo
drives are enabled).

– Application runs as expected.

8.9 Operation of the STO Function
The STO function does not require any parameterization and is always enabled.

The ISD 510/DSD 510 servo drive provides STO status signals via the �eldbus.

All signals transmitted via the �eldbus are not part of the safety function and can only be used for operational purposes.

See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Programming Guide for:

General information on how to access and map data objects.

Information on a library provided to simplify the use of the �eldbus functions.

If STO is activated when the servo drive is disabled, and no attempt is made to enable the servo drive while STO is active, it is not
necessary to reset the STO function after reapplying supply to the STO terminals.

If STO is activated when the servo drive is enabled, an error code is issued.

8.9.1 Error Codes
If bit 3 of the statusword is set, this indicates any faults that occur on the servo drive. If the fault occurred because of the STO circuit,
the cause of the fault can be found in object 0x603F.

Table 38: Error Codes

Error code PROFINET®

error code

Classi�cation Description Reset

0xFF80 0x11E Fault STO activated while the servo drive was enabled, or an at-
tempt to enable the servo drive was made while STO was
activated.

Reset via the PLC.

0xFF81 0x11F Safety fault Servo drive internal diagnostic fault. Carry out a power cy-
cle.

0xFF85 0x120 Safety fault Internal STO supply on the power card is not within limits. Carry out a power cy-
cle.

Error code 0xFF80/0x11E can be a normal status of the application. In this case, the servo drive requires a reset signal from the PLC.
To use the STO function in an application that requires a control guard (see ISO 12100 for details), this reset information can be
given automatically by the PLC. All servo drives on the same line will display this fault at the same time. Carry out a check on the PLC
to compare the fault of all servo drives on 1 line.

Error code 0xFF81/0x11F means that there is a fault on the servo drive that can only be reset by carrying out a power cycle. Com-
plete the commissioning test after the power cycle. Operation of the servo system can only be resumed if the test is completed
successfully. If error code 0xFF81/0x11F or 0xFF85/0x120 is issued again, contact Danfoss Service.

8.9.2 Fault Reset
To reset faults, change bit 7 of the controlword from 0 to 1. See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT®

Flexmotion™) Programming Guide for further information.

8.10 Functional Safety Characteristic Data
Table 39: Functional Safety Characteristic Data

Data ISD 510/DSD 510 PSM 510 DAM 510

General information

Response time (from switching on the input until torque generation is disabled) <100 ms
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Data ISD 510/DSD 510 PSM 510 DAM 510

Lifetime 20 years

Data for EN/ISO 13849-1

Performance level (PL) d – –

Category 3 – –

Mean time to dangerous failure (MTTFD) >5000 years – –

Diagnostic coverage (DC) 60% – –

Data for EN/ISO 61508 and EN/IEC 62061

Safety integrity level (SIL) 2 – –

Probability of failure per hour (PFH) <4 x 10-9/h 0 /h 0 /h

Safe failure fraction (SFF) >95% 100% 100%

Subsystem classi�cation Type A

Functional test interval 1 year

N O T I C E

The PSM 510, DAM 510, and ACM 510 do not contribute to the dangerous failure rate of the Danfoss system and can there-
fore be excluded from safety-related calculations.

8.11 Maintenance, Security, and User Accessibility
Maintenance: Test the STO safety function at least once per year as follows:

Remove the STO input voltage.

Verify that the motors stop running.

Verify that no unexpected error codes appear.

Security: If security risks exist, take suitable measures to prevent them.

User accessibility: Restrict access to the ISD 510/DSD 510 servo drives and other system components if access to them could result in
safety risks.

AQ262449648484en-000201 / 175R1135154 | Danfoss A/S © 2020.10

Functional Safety Concept

VLT® Servo Drive System ISD 510/DSD 510

Operating Guide



•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

-

9 Diagnostics

9.1 Faults
If faults occur during the operation of the ISD 510/DSD 510 system, check:

The LEDs on the servo drives for general problems relating to communication or device status.

The LEDs on the PSM 510 and DAM 510 for general problems with communication, auxiliary supply, or STO voltage.

The error codes.

The error codes can be read using the VLT® Servo Toolbox software, the LCP, or the PLC. The LCP only shows faults relating to the

device it is connected to.

N O T I C E

If the fault cannot be eliminated by 1 of the measures listed in the troubleshooting tables, notify Danfoss Service.

Have the following information available to enable Danfoss to provide help quickly and e�ectively:

Type number

Error code

Firmware version

System setup (for example, number of servo drives, system modules, and lines).

System status when the fault occurred.

Ambient conditions.

9.2 Troubleshooting

9.2.1 Troubleshooting for the ISD 510/DSD 510 Servo Drives

9.2.1.1 Drive not Running/Starting Slowly
Possible Cause

Bearing wear.

Incorrect parameter settings.

Incorrect control loop parameters.

Incorrect torque settings.

Troubleshooting

Check the bearings and the shaft.

Check the parameter settings.

9.2.1.2 Drive Hums and Draws High Current
Possible Cause

Drive defective.

Troubleshooting

Contact Danfoss.

9.2.1.3 Drive Stops Suddenly and Restart is not Possible
Possible Cause

No drive communication.

Servo drive in error mode.

Troubleshooting

Check the �eldbus connection and the LEDs on the servo drive.
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9.2.1.4 Motor Rotating in Wrong Direction
Possible Cause

Mirror mode activated.

Troubleshooting

Check the parameter settings.

9.2.1.5 Motor not Generating Expected Torque
Possible Cause

Drive defective.

Parameter error.

Troubleshooting

Check the parameter settings.

Contact Danfoss.

9.2.1.6 Drive Screaming
Possible Cause

Incorrect calibration.

Faulty current measurement.

Incorrect control loop parameters.

Troubleshooting

Check the parameter settings.

Contact Danfoss.

9.2.1.7 Uneven Running
Possible Cause

Defective bearing.

Troubleshooting

Check the shaft.

9.2.1.8 Vibration
Possible Cause

Defective bearing.

Incorrect control loop parameters.

Troubleshooting

Check the shaft.

Check the parameter settings.

9.2.1.9 Unusual Running Noises
Possible Cause

Defective bearing.

Defects on connected mechanics.

Incorrect control loop parameters.

Troubleshooting

Check the shaft.

Check for loose mechanical components on the connected mechanics.

Check the parameter settings.
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9.2.1.10 Drive Speed Drops Sharply under Load
Possible Cause

Drive is running at current limit.

Drive is running with incorrect parameters.

Troubleshooting

Check the application.

Check the parameter settings.

9.2.1.11 Brake not Releasing
Possible Cause

Defective brake control.

Incorrect mechanical brake parameters.

Troubleshooting

Check the parameter settings.

Contact Danfoss.

9.2.1.12 Holding Brake not Holding the Servo Drive
Possible Cause

Mechanical brake defective.

Shaft load exceeds the holding torque of the brake.

Troubleshooting

Contact Danfoss.

9.2.1.13 Delayed Brake Engagement
Possible Cause

Software error.

Troubleshooting

Contact Danfoss.

9.2.1.14 Noises when Power-O� Brake is Engaged
Possible Cause

Mechanical brake damaged.

Troubleshooting

Contact Danfoss.

9.2.1.15 LEDs not Lighting Up
Possible Cause

No power supply.

Troubleshooting

Check the power supply.

9.2.1.16 Drive Protection Trips Immediately
Possible Cause

Short circuit.

Incorrect control loop parameters.

Troubleshooting

Check the wiring.

Contact Danfoss.

AQ262449648484en-000201 / 175R1135 | 157Danfoss A/S © 2020.10

Diagnostics

VLT® Servo Drive System ISD 510/DSD 510

Operating Guide



•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

9.2.2 Troubleshooting for the Servo System

9.2.2.1 LCP Display is Dark/Not Functioning
This fault applies to the ISD 510/DSD 510 servo drives, PSM 510, DAM 510, and ACM 510.

Possible Causes

Missing input power.

Missing or open fuses or circuit breaker tripped.

No power to the LCP.

Incorrect contrast setting.

Display is defective.

Troubleshooting
Table 40: Fault, LCP Display is Dark/Not Functioning

Possible cause Possible solution

Missing input power. Check the input power source.

Missing or open fuses or circuit breaker tripped. Check the fuses and circuit breaker.

No power to the LCP. Check the LCP cable for proper connection or damage.

Replace any faulty LCP or connection cables.

Incorrect contrast setting. Press [Status] + [▵]/[▿] to adjust the contrast.

Display is defective. Replace the faulty LCP or connection cable.

9.2.2.2 Open Power Fuses or Circuit Breaker Trip
This fault applies to the PSM 510 and DAM 510.

Possible Causes

Phase-to-phase short.

Short on backlink.

Short on hybrid cable.

Short on EXM 510 connector or cable.

Short on ISD 510/DSD 510 connector.

Troubleshooting

Check the cabling

Check for loose connections.

9.2.2.3 DC-link Voltage Too Low (Error 0x3220/0x104)
This fault applies to all system modules.

Possible Cause

Incorrect mains input supply.

Troubleshooting

Check that the supply voltage matches the allowed speci�cation.

9.2.2.4 Current Overload Trip (Error 0x2396/0x15C)
This fault applies to the PSM 510 and the DAM 510.
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Possible Causes

The sum of the servo drive current exceeds the maximum rating of the DAM 510.

The sum of the system modules' current exceeds the maximum rating of the PSM 510.

Short on backlink.

Troubleshooting

Check the servo drive current consumption.

Avoid simultaneous acceleration of all servo drives.

Decrease the acceleration value.

9.2.2.5 High Cont. Power Overload (Error 0x2313/0x161)
This fault applies to the PSM 510.

Possible Causes

The PSM 510 was operating at over 140% of the nominal power rating for too long.

Troubleshooting

Check the current consumption.

9.2.2.6 Continuous Power Overload (Error 0x2314/0x162)
This fault applies to the PSM 510.

Possible Causes

The PSM 510 was operating at 100–140% of the nominal power rating for too long.

Troubleshooting

Check the current consumption.

9.2.2.7 AUX Overcurrent (Error 0x2391/0x125)
This fault applies to the DAM 510.

Possible Causes

The servo drives are consuming more power on the UAUX line than allowed.

Troubleshooting

Check the number of attached servo drives with the shell diagrams in the VLT® Servo Drive System ISD 510, DSD 510, MSD 510

(VLT® Flexmotion™) Design Guide.

Avoid simultaneous lifting of the servo drive brakes.

9.2.2.8 AUX Overvoltage (Error 0x3292/0x133)
This fault applies to the DAM 510.

Possible Causes

Incorrect UAUX supply.

Troubleshooting

Check that the supply matches the auxiliary supply requirements.

9.2.2.9 AUX Undervoltage (Error 0x3294/0x135)
This fault applies to the PSM 510, DAM 510, and ACM 510.

Possible Causes

Incorrect UAUX supply.

Incorrect current dimensioning of the supply equipment.

Troubleshooting

Check that the supply matches the auxiliary supply requirements.

Check that the output power of the supply is su�cient.
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9.2.2.10 Mains Phase Loss (Error 0x3130/0x12F)
This fault applies to the PSM 510.

Possible Causes

A phase is missing on the supply side.

The voltage imbalance is too high.

Troubleshooting

Check the supply voltages and supply currents to the device.

9.2.2.11 Generic Application Error (Error 0x1000/ 0x100)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Possible Causes

A generic error has occurred in the application.

Troubleshooting

Contact Danfoss.

9.2.2.12 Grounding Fault
This fault applies to the PSM 510, DAM 510, and ACM 510.

Possible Causes

Grounding fault.

When 2 PSM510 modules are mounted in parallel and the maximum delay time for power-up is exceeded (see 6.6 Power-Up
Time).

Troubleshooting

Check for proper grounding and loose connections.

Check the hybrid cables for short circuits or leakage currents.

Check the EXM 510 connection and cable.

9.2.2.13 Brake Resistor Error
This fault applies to the PSM 510.

Possible Causes

Faulty brake resistor.

Internal/external brake resistor not connected.

Troubleshooting

Remove the power to the device, wait for the discharge time to elapse, then replace the brake resistor.

9.2.2.14 Brake Chopper Error
This fault applies to the PSM 510.

Possible Causes

Faulty brake chopper.

Brake chopper power exceeds the power cycle limit.

Incorrect parameterization.

Troubleshooting

Check the parameterization of the brake chopper.

Check the brake chopper connection.

Measure the resistance of the brake chopper and compare it with the parameter settings.

9.2.2.15 Internal Fan Error
This fault applies to PSM 510.
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Possible Causes

Fan is not mounted.

Fan is blocked.

Troubleshooting

Check if the fan is blocked.

Check the fan cables for proper connection or damage.

9.3 Error Codes for ISD 510/DSD 510 Servo System

9.3.1 No error (0x0000 / 0x0)
This error code is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 41: No error (0x0000 / 0x0)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0x0000 0x0 No error Error No error. –

9.3.2 Generic application error (0x1000 / 0x100)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 42: Generic err (0x1000 / 0x100)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x1000 0x100 Generic application error Error Generic application error. generic err

9.3.3 Overcurrent Trip (0x2310 / 0x101)
This error is valid for ISD 510/DSD 510.

Table 43: Overcurr out (0x2310 / 0x101)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0x2310 0x101 Overcurrent trip Error Overcurrent trip on output. overcurr trip

9.3.4 High cont. current overload (0x2311 / 0x15F)
This error is valid for DAM 510 and ISD 510/DSD 510.

Table 44: High current overload (0x2311 / 0x15F)

Code PROFINET® code Name Severity (warning/error/

trip lock)

Description LCP name

0x2311 0x15F High cont. current
overload

Error High continuous current over-
load error.

High curr ovld

9.3.5 Continuous current overload (0x2312 / 0x160)
This error is valid for DAM 510 and ISD 510/DSD 510.

Table 45: Continuous current overload (0x2312 / 0x160)

Code PROFINET® code Name Severity (warning/error/

trip lock)

Description LCP name

0x2312 0x160 Continuous current
overload

Error Continuous current over-
load error.

cont curr ovld
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9.3.6 High cont. power overload (0x2313 / 0x161)
This error is valid for PSM 510.

Table 46: High cont. power overload (0x2313 / 0x161)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x2313 0x161 High cont. power
overload

Warning, error High continuous power
overload error.

high pwr ovld

9.3.7 Continuous power overload (0x2314 / 0x162)
This error is valid for PSM 510.

Table 47: Continuous power overload (0x2314 / 0x162)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x2314 0x162 Continuous power
overload

Warning, error Continuous power over-
load error.

cont pwr ovld

9.3.8 Overcurrent short circuit (0x2320 / 0x163)
This error is valid for PSM 510 and DAM 510.

Table 48: Overcurrent short circuit (0x2320 / 0x163)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x2320 0x163 Overcurrent short
circuit

Trip lock Overcurrent short circuit er-
ror.

over curr short

9.3.9 Ground fault (0x2330 / 0x151)
This error is valid for PSM 510, DAM 510, and ISD 510/DSD 510.

Table 49: Ground fault (0x2330 / 0x151)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x2330 0x151 Ground fault Warning, error Discharge from output phases
to ground.

ground fault

9.3.10 AUX overcurrent (0x2391 / 0x125)
This error is valid for DAM 510.

Table 50: AUX overcurr (0x2391 / 0x125)

Code PROFINET®

code

Name Severity (warning/error/

trip lock)

Description LCP name

0x2391 0x125 AUX overcur-
rent

Error Current on the AUX line has reached
the overcurrent limit.

AUX overcurr

9.3.11 AUX user limit current (0x2393 / 0x127)
This error is valid for DAM 510.
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Table 51: AUX user limit current (0x2393 / 0x127)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x2393 0x127 AUX user limit
current

Error Current on the AUX line has reached
the user-de�ned limit for fault.

AUX curr limit

9.3.12 AUX user limit current warning (0x2394 / 0x128)
This error is valid for PSM 510 and DAM 510.

Table 52: AUX user limit current warning (0x2394 / 0x128)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x2394 0x128 AUX user limit cur-
rent warning

Warning Current on the AUX line has reached
the user-de�ned limit for warning.

AUX curr
warn

9.3.13 AUX supply failure (0x2395 / 0x129)
This error is valid for DAM 510.

Table 53: AUX supply failure (0x2395 / 0x129)

Code PROFINET®

code

Name Severity (warning/error/

trip lock)

Description LCP name

0x2395 0x129 AUX supply fail-
ure

Error AUX supply failure indicated by
hardware circuit..

AUX supply fail

9.3.14 Current overload trip (0x2396 / 0x15C)
This error is valid for DAM 510 and ISD 510/DSD 510.

Table 54: Current overload trip (0x2396 / 0x15C)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x2396 0x15C Current overload
trip

Error Current overload trip error. curr ovld trip

9.3.15 Power overload trip (0x2397 / 0x12B)
This error is valid for PSM 510.

Table 55: Power overload trip (0x2397 / 0x12B)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x2397 0x12B Power overload trip Error Power overload trip error. pwr ovld trip

9.3.16 Thermal overload motor (0x239B / 0x102)
This error is valid for ISD 510/DSD 510.

Table 56: Thermal overload motor (0x239B / 0x102)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x239B 0x102 Thermal overload
motor

Warning, error Thermal overload motor
error.

therm ovld mo-
tor
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9.3.17 Mains phase loss (0x3130 / 0x12F)
This error is valid for PSM 510.

Table 57: Mains phase loss (0x3130 / 0x12F)

Code PROFINET™

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x3130 0x12F Mains
phase loss

Error Mains phase loss detected.

This occurs when a phase on mains is missing, or
when the mains is imbalanced.

phase loss

9.3.18 DC link overvoltage (0x3210 / 0x103)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 58: DC link overvoltage (0x3210 / 0x103)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x3210 0x103 DC link overvolt-
age

Error DC-link voltage exceeds lim-
it.

UDC overvolt

9.3.19 DC link undervoltage (0x3220 / 0x104)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 59: DC link undervoltage (0x3220 / 0x104)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x3220 0x104 DC link under-
voltage

Error DC-link voltage below limit in Opera-

tion enabled state.

UDC undervolt

9.3.20 DC link charging error (0x3230 / 0x152)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 60: DC link charging error (0x3230 / 0x152)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x3230 0x152 DC link charg-
ing error

Error DC-link charging error. The maximum time
limit to charge the DC-link has been excee-
ded.

UDC charg-
ing

9.3.21 DC Link unbalanced (0x3280 / 0x153)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 61: DC Link unbalanced (0x3280 / 0x153)

Code PROFINET™

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x3280 0x153 DC Link un-
balanced

Trip lock DC-link voltage is unbalanced. This fault in-
dicates an internal malfunction of the DC-
link.

UDC unbal-
ance

9.3.22 UAUX high voltage (0x3291 / 0x132)
This error is valid for PSM 510, DAM 510, and ACM 510.
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Table 62: UAUX high voltage (0x3291 / 0x132)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x3291 0x132 UAUX high voltage Warning UAUX above warning limit. UAUX high volt

9.3.23 UAUX overvoltage (0x3292 / 0x133)
This error is valid for DAM 510.

Table 63: UAUX overvoltage (0x3292 / 0x133)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x3292 0x133 UAUX overvolt-

age

Error UAUX above overvoltage limit. UAUX overvolt

9.3.24 UAUX low voltage (0x3293 / 0x134)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 64: UAUX low voltage (0x3293 / 0x134)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0x3293 0x134 UAUX low voltage Warning UAUX below warning limit. UAUX low volt

9.3.25 UAUX undervoltage (0x3294 / 0x135)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 65: UAUX undervoltage (0x3294 / 0x135)

Code PROFINET® code Name Severity (warning/error/

trip lock)

Description LCP name

0x3294 0x135 UAUX undervolt-

age

Error UAUX below undervoltage

limit.

UAUX undervolt

9.3.26 DC link high voltage (0x3295 / 0x136)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 66: DC link high voltage (0x3295 / 0x136)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x3295 0x136 DC link high
voltage

Warning The DC-link voltage is higher than the
high-voltage warning limit.

UDC high volt

9.3.27 DC link low voltage (0x3296 / 0x137)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 67: UDC low voltage (0x3296 / 0x137)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x3296 0x137 DC link low
voltage

Warning The DC-link voltage is lower than the
low-voltage warning limit.

UDC low volt
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9.3.28 UAUX charging error (0x3297 / 0x154)
This error is valid for DAM 510.

Table 68: UAUX charging error (0x3297 / 0x154)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x3297 0x154 UAUX charging

error

Error Load error when UAUX is charging. The maxi-

mum time limit to charge the AUX line has
been exceeded.

UAUX charg
err

9.3.29 DC link shutdown error (0x3298 / 0x165)
This error is valid for DAM 510.

Table 69: DC link shutdown error (0x3298 / 0x165)

Code PROFINET® code Name Severity (warning/error/

trip lock)

Description LCP name

0x3298 0x165 DC link shutdown
error

Error Error when UDC is in shut-
down phase.

UDC shutdwn err

9.3.30 UAUX shutdown error (0x3299 / 0x155)
This error is valid for DAM 510.

Table 70: UAUX shutdown error (0x3299 / 0x155)

Code PROFINET® code Name Severity (warning/error/

trip lock)

Description LCP name

0x3299 0x155 UAUX shutdown

error

Error Error when UAUX is in shut-

down phase.

UAUX shtdwn
err

9.3.31 UAUX undervoltage hardware (0x329A / 0x156)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 71: UAUX undervoltage hardware (0x329A / 0x156)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x329A 0x156 UAUX undervoltage

hardware

Error UAUX undervoltage detected by

hardware circuit.

AUX undervol
HW

9.3.32 Device overtemperature (0x4210 / 0x157)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 72: Device overtemperature (0x4210 / 0x157)

Code PROFINET®

code

Name Severity (warn-

ing/error/trip

lock)

Description LCP name

0x4210 0x157 Device over-
temperature

Warning, error Triggered when the maximum temperature of the
main device component is exceeded.

PSM: Thyristor recti�er module.

DAM: Maximum temperature of both high side and
low side IGBTs.

overtemp
device
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9.3.33 Device under temperature (0x4220 / 0x138)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 73: Device under temperature (0x4220 / 0x138)

Code PROFINET®

code

Name Severity (warning/error/

trip lock)

Description LCP name

0x4220 0x138 Device under tem-
perature

Error The device is too cold to
operate.

undertemp de-
vice

9.3.34 Overtemperature: Control card (0x4291 / 0x106)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 74: Overtemperature: Control card (0x4291 / 0x106)

Code PROFINET®

code

Name Severity (warning/error/

trip lock)

Description LCP name

0x4291 0x106 Overtemperature:
Control card

Error Maximum temperature of con-
trol card exceeded.

overtemp CC

9.3.35 Overtemperature: Power card (0x4292 / 0x107)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 75: Overtemperature: Power card (0x4292 / 0x107)

Code PROFINET®

code

Name Severity (warning/error/

trip lock)

Description LCP name

0x4292 0x107 Overtemperature:
Power card

Warning, error Maximum temperature of pow-
er card exceeded.

overtemp PC

9.3.36 Inrush overtemperature DC link (0x4293 / 013C)
This error is valid for PSM 510, DAM 510, and ACM 510.

Table 76: Inrush overtemperature DC link (0x4293 / 0x13C)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x4293 0x13C Inrush overtem-
perature: DC link

Error Inrush fault.

Too many transitions into state Operation

enabled in a short time period.

UDC inrush

9.3.37 Inrush overtemperature AUX line (0x4294 / 0x13D)
This error is valid for DAM 510.

Table 77: Inrush overtemperature AUX line (0x4294 / 0x13D)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x4294 0x13D Inrush overtem-
perature AUX line

Error Inrush fault.

Too many power-ups of the AUX voltage
have occurred within a short time period.

UAUX in-
rush

9.3.38 Overtemperature: Motor (0x4310 / 0x108)
This error is valid for ISD 510/DSD 510.
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Table 78: Overtemperature: Motor (0x4310 / 0x108)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x4310 0x108 Overtemperature:
Motor

Error Overtemperature on mo-
tor.

overtemp motor

9.3.39 Charge switch failure voltage (0x5121 /0x158)
This error is valid for PSM 510.

Table 79: Charge switch failure voltage (0x5121 / 0x158)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x5121 0x158 Charge switch
failure voltage

Trip lock Indicates a malfunction of the in-
ternal charge circuit.

Chg switch
fail

9.3.40 EE Checksum Error (parameter missing) (0x5530 / 0x10A)
This error is valid for ISD 510/DSD 510.

Table 80: EE Checksum Error (parameter missing) (0x5530 / 0x10A)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x5530 0x10A EE Checksum Error (pa-
rameter missing)

Trip lock EEPROM checksum error or miss-
ing device parameter.

eeprom err

9.3.41 Parameter error (0x6320 / 0x10B)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 81: Param err (0x6320 / 0x10B)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x6320 0x10B Parameter error Trip lock A parameter has an invalid value. param err

9.3.42 Conf par ver (0x6382 / 0x15D)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 82: Con�guration parameters version error (0x6382 / 0x15D)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x6382 0x15D Con�guration param-
eters version error

Trip lock Con�guration parameter set version mis-
match: parameter set is not valid for this
device.

conf par
ver

9.3.43 Con�guration parameters limits error (0x6383 / 0x164)
This error is valid for PSM 510, DAM 510, and ACM 510.
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Table 83: Con�guration parameters limits error (0x6383 / 0x164)

Code PROFINET®

code

Name Severity (warn-

ing/error/trip

lock)

Description LCP name

0x6383 0x164 Con�guration pa-
rameters limits er-
ror

Trip lock ≥1 parameter in the con�guration parameter
set is out of limits: the parameter set is not val-
id for this device.

conf par
lim

9.3.44 Power EEprom con�guration error (0x6384 / 0x166)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 84: Power EEprom con�guration error (0x6384 / 0x166)

Code Name Severity (warning/

error/trip lock)

Description LCP name

0x6384 0x166 Power Eeprom con�g-
uration error

Trip lock The power device Eeprom is corrupt or
incompatible with this control board.

conf par EE-
PROM

9.3.45 Brake chopper failure (0x7111 / 0x141)
This error is valid for PSM 510.

Table 85: Brake chopper failure (0x7111 / 0x141)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x7111 0x141 Brake chop-
per failure

Warning, error The brake chopper is monitored during oper-
ation.

A brake failure has been detected by the
brake check function.

brake ch fail

9.3.46 Brake chopper overcurrent (0x7112 / 0x167)
This error is valid for PSM 510.

Table 86: Brake chopper overcurrent (0x7112 / 0x167)

Code PROFINET®

code

Name Severity (warning/error/

trip lock)

Description LCP name

0x7112 0x167 Brake chopper
overcurrent

Trip lock The brake chopper current ex-
ceeds the limit.

brake ch over-
curr

9.3.47 Brake chopper module overload (0x7181 / 0x142)
This error is valid for PSM 510.

Table 87: Brake resistor maximum power limit (0x7181 / 0x142)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP

name

0x7181 0x142 Brake chop-
per module
overload

Warning, error The power load of the brake chopper is monitored
during operation. This error appears when the maxi-
mum power limit of the brake chopper module is
reached.

mod ovl

9.3.48 External brake chopper overload (0x7182 / 0x143)
This error is valid for PSM 510.
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Table 88: External brake chopper overload (0x7182 / 0x143)

Code PROFI-

NET®

code

Name Severity (warn-

ing/error/trip

lock)

Description LCP name

0x7182 0x143 External
brake chop-
per over-
load

Warning, error The power load of the brake chopper is monitored during
operation.

Depending on the con�guration of external brake chopper

power monitoring this warning or fault appears when the
con�gured nominal external brake chopper power is
reached.

ext brake
ch ovl

9.3.49 Brake mains voltage too high (0x7183 / 0x159)
This error is valid for PSM 510.

Table 89: Brake mains voltage too high (0x7183 / 0x159)

Code PROFINET®

code

Name Severity (warn-

ing/error/trip

lock)

Description LCP name

0x7183 0x159 Brake mains
voltage too
high

Warning The mains voltage is too high.Due to this, the brake
chopper could be activated continuously depending

on the value entered in parameter brake chopper start

level.

brake ch
high volt

9.3.50 Internal position sensor error (0x7320 / 0x10C)
This error is valid for ISD 510/DSD 510.

Table 90: Internal position sensor error (0x7320 / 0x10C)

Code PROFINET®

code

Name Severity (warning/error/

trip lock)

Description LCP name

0x7320 0x10C Internal position sensor
error

Trip lock Absolute position sensor er-
ror.

int sensor err

9.3.51 External position sensor error (0x7380 / 0x10D)
This error is valid for DAM 510 and ISD 510/DSD 510.

Table 91: External position sensor error (0x7380 / 0x10D)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x7380 0x10D External position sensor
error

Error External encoder data could
not be read.

ext sensor err

9.3.52 Following error (0x8611 / 0x10E)
This error is valid for ISD 510/DSD 510.

Table 92: Following error (0x8611 / 0x10E)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x8611 0x10E Following error Warning, error A following error has occurred. following err
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9.3.53 Homing error on entering homing mode (0x8693 / 0x10F)
This error is valid for ISD 510/DSD 510.

Table 93: Homing error on entering homing mode (0x8693 / 0x10F)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x8693 0x10F Homing error on enter-
ing homing mode

Warning Could not enter homing mode
(for example velocity not 0).

Homing mode
fail

9.3.54 Homing error on start homing method (0x8694 / 0x110)
This error is valid for ISD 510/DSD 510.

Table 94: Homing error on start homing method (0x8694 / 0x110)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0x8694 0x110 Homing error on start
homing method

Warning Could not start homing method
(for example drive not in stand-
still).

Homing meth-
od fail

9.3.55 Homing error distance (0x8695 / 0x111)
This error is valid for ISD 510/DSD 510.

Table 95: Homing error distance (0x8695 / 0x111)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0x8695 0x111 Homing error dis-
tance

Warning Homing distance
reached.

Homing distance

9.3.56 Mechanical brake failure (0xFF01 / 0x112)
This error is valid for ISD 510/DSD 510.

Table 96: Mechanical brake failure (0xFF01 / 0x112)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0xFF01 0x112 Mechanical brake
failure

Trip lock No brake or wire failure. brake mech fail

9.3.57 Short circuit in mechanical brake control (0xFF02 / 0x113)
This error is valid for ISD 510/DSD 510.

Table 97: Short circuit in mechanical brake control (0xFF02 / 0x113)

Code PROFINET® code Name Severity (warning/error/

trip lock)

Description LCP name

0xFF02 0x113 Short circuit in mechani-
cal brake control

Trip lock Short circuit in brake
control.

brake mech
short

9.3.58 External interface power failure (0xFF0A / 0x114)
This error is valid for ISD 510/DSD 510.
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Table 98: External interface power failure (0xFF0A / 0x114)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0xFF0A 0x114 External interface pow-
er failure

Error External interface power sup-
ply failure.

ext IF pwr fail

9.3.59 Fan feedback inconsistent (0xFF21 / 0x145)
This error is valid for PSM 510.

Table 99: Fan feedback inconsistent (0xFF21 / 0x145)

Code PROFINET®

code

Name Severity (warning/error/

trip lock)

Description LCP name

0xFF21 0x145 Fan feedback in-
consistent

Warning Internal fan fault.

Internal fan not running/mounted.

fan feedback

9.3.60 Fan lifetime critical (0xFF22 / 0x15A)
This error is valid for PSM 510.

Table 100: Fan lifetime critical (0xFF22 / 0x15A)

Code PROFINET® code Name Severity (warning/error/

trip lock)

Description LCP name

0xFF22 0x15A Fan lifetime criti-
cal

Warning The theoretical lifetime of the fan
has been exceeded.

fan lifetime

9.3.61 Timing violation 1 (0xFF60 / 0x115)
This error is valid for ISD 510/DSD 510.

Table 101: Timing violation 1 (0xFF60 / 0x115)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF60 0x115 Timing violation 1 Trip lock Contact Danfoss. timing err 1

9.3.62 Timing violation 2 (0xFF61 / 0x116)
This error is valid for ISD 510/DSD 510.

Table 102: Timing violation 2 (0xFF61 / 0x116)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF61 0x116 Timing violation 2 Trip lock Contact Danfoss. timing err 2

9.3.63 Timing violation 3 (0xFF62 / 0x117)
This error is valid for ISD 510/DSD 510.

Table 103: Timing violation 3 (0xFF62 / 0x117)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF62 0x117 Timing violation 3 Trip lock Contact Danfoss. timing err 3

9.3.64 Timing violation 4 (0xFF63 / 0x118)
This error is valid for ISD 510/DSD 510.
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Table 104: Timing violation 4 (0xFF63 / 0x118)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF63 0x118 Timing violation 4 Trip lock Contact Danfoss. timing err 4

9.3.65 Timing violation 5 (0xFF64 / 0x119)
This error is valid for ISD 510/DSD 510.

Table 105: Timing violation 5 (0xFF64 / 0x119)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF64 0x119 Timing violation 5 Trip lock Contact Danfoss. timing err 5

9.3.66 Timing violation 6 (0xFF65 / 0x11A)
This error is valid for ISD 510/DSD 510.

Table 106: Timing violation 6 (0xFF65 / 0x11A)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF65 0x11A Timing violation 6 Trip lock Contact Danfoss. timing err 6

9.3.67 Timing violation 7 (0xFF66 / 0x168)
This error is valid for ISD 510/DSD 510.

Table 107: Timing violation 7 (0xFF66 / 0x168)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF66 0x168 Timing violation 7 Trip lock Contact Danfoss. timing err 7

9.3.68 Timing violation 8 (0xFF67 / 0x16B)
This error is valid for ISD 510/DSD 510.

Table 108: Timing violation 8 (0xFF67 / 0x16B)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF67 0x16B Timing violation 8 Trip lock Contact Danfoss. timing err 8

9.3.69 Timing violation 9 (0xFF68 / 0x16C)
This error is valid for ISD 510/DSD 510.

Table 109: Timing violation 9 (0xFF68 / 0x16C)

Code PROFINET® code Name Severity (warning/error/trip lock) Description LCP name

0xFF68 0x16C Timing violation 9 Trip lock Contact Danfoss. timing err 9

9.3.70 Firmware: Package description mismatch (0xFF70 / 0x11B)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.
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Table 110: Firmware: Package description mismatch (0xFF70 / 0x11B)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0xFF70 0x11B Firmware: Package de-
scription mismatch

Trip lock The �rmware found does not
match the package description.

FW pack err

9.3.71 Firmware: Power cycle needed (0xFF71 / 0x11C)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 111: Firmware: Power cycle needed (0xFF71 / 0x11C)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0xFF71 0x11C Firmware: Pow-
er cycle needed

Warning, error The �rmware update transfer is completed
but a power cycle is required before the
new �rmware is active.

need power-
cycle

9.3.72 Firmware: Update started (0xFF72 / 0x11D)
This error is valid for PSM 510, DAM 510, ACM 510, and ISD 510/DSD 510.

Table 112: Firmware: Update started (0xFF72 / 0x11D)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0xFF72 0x11D Firmware: Up-
date started

Warning, error Firmware update is in progress.

Warning changes to error when an attempt is
made to enable the device in this state.

FW update

9.3.73 Firmware: Update invalid (0xFF73 / 0x15B)
This error is valid for PSM 510 and DAM 510.

Table 113: Firmware: Update invalid (0xFF73 / 0x15B)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0xFF73 0x15B Firmware: Up-
date invalid

Error Invalid or corrupted �rmware package
update.

Last valid �rmware package has been loa-
ded.

FW upd invalid

9.3.74 STO active while drive enabled (0xFF80 / 0x11E)
This error is valid for ISD 510/DSD 510.

Table 114: STO active while drive enabled (0xFF80 / 0x11E)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0xFF80 0x11E STO active while
drive enabled

Error STO activated while drive was enabled
or tried to enable while STO active.

STO active

9.3.75 STO mismatch (0xFF81 / 0x11F)
This error is valid for ISD 510/DSD 510.
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Table 115: STO mismatch (0xFF81 / 0x11F)

Code PROFINET® code Name Severity (warning/error/

trip lock)

Description LCP name

0xFF81 0x11F STO mis-
match

Trip lock Dual diagnosis of STO voltage not
plausible.

STO mismatch

9.3.76 P_STO error (0xFF85 / 0x120)
This error is valid for ISD 510/DSD 510.

Table 116: P_STO error (0xFF85 / 0x120)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0xFF85 0x120 P_STO error Trip lock P_STO voltage on the power card ex-
ceeds the limits.

P_STO error

9.3.77 Guide value reversed (0xFF90 / 0x121)
This error is valid for ISD 510/DSD 510.

Table 117: Guide value reversed (0xFF90 / 0x121)

Code PROFINET®

code

Name Severity (warning/

error/trip lock)

Description LCP name

0xFF90 0x121 Guide value re-
versed

Error Position guide value went backwards
while the servo drive was in CAM mode.

guide val rev

9.3.78 Guide value implausible (0xFF91 / 0x122)
This error is valid for ISD 510/DSD 510.

Table 118: Guide value implausible (0xFF91 / 0x122)

Code PROFINET®

code

Name Severity (warning/error/

trip lock)

Description LCP name

0xFF91 0x122 Guide value im-
plausible

Error Increments between succeeding
values too large.

guide val impl

9.3.79 Sign of life error (0xFF95 / 0x14E)
This error is valid for ISD 510/DSD 510.

Table 119: Sign of life error (0xFF95 / 0x14E)

Code PROFINET® code Name Severity (warning/error/trip

lock)

Description LCP name

0xFF95 0x14E Sign of life error Error PROFINET® sign of life error. PNIO SOL error
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10 Maintenance, Decomissioning, and Disposal

10.1 Warnings

W A R N I N G
HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

Before working on the power or signal connectors (disconnecting or connecting the cable), or performing any maintenance
work, disconnect the Power Supply Module (PSM 510) from the mains and wait for the discharge time to elapse.

W A R N I N G
DISCHARGE TIME

The servo system contains DC-link capacitors that remain charged for some time after the mains supply is switched o� at the

Power Supply Module (PSM 510). Failure to wait the speci�ed time after power has been removed before performing service or

repair work could result in death or serious injury.

To avoid electrical shock, fully disconnect the Power Supply Module (PSM 510) from the mains and wait for the capacitors to
fully discharge before carrying out any maintenance or repair work on the servo system or its components.

Minimum waiting time (minutes)

15

10.2 Maintenance Tasks
The ISD 510/DSD 510 servo drives are largely maintenance free. Only the shaft seal on the ISD 510 (if used) is subject to wear. The
maintenance tasks must be performed by quali�ed personnel. No other tasks are required.

Table 120: Overview of Maintenance Tasks

Component Maintenance task Maintenance interval Instruction

Servo drive Carry out a visual inspection. Every 6 months Check for any abnormalities on the surface of
the servo drive.

Shaft seal on the ISD
510

Check the condition and
check for leakage.

Every 6 months(1) If damaged, replace the shaft seal.

Flange connection on
the ISD 510

Measure the resistance. Every 12 months. Measure the resistance of the �ange connec-
tion on the ISD 510.

Hybrid cable Check for damage and wear. Every 6 months If damaged or worn: Replace the hybrid ca-
ble.

Mechanical holding
brake (optional)

Check the brake. Every 6 months Ensure that the brake can achieve the hold-
ing torque.

Functional safety Perform a system power cycle
and check the STO function.

Every 12 months Activate STO and check the status with the
PLC.

System modules Check the fan. Every 12 months Check that the fan can turn and remove any
dust or dirt.

Carry out a visual inspection Every 6 months Check for any abnormalities on the surface of
the module.

1 A shorter interval may be necessary depending on the application. Contact Danfoss for more information.
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10.3 Inspection during Operation

10.3.1 ISD 510/DSD 510 Servo Drives
Carry out regular inspections during operation. Check the ISD 510/DSD 510 servo drives at regular intervals for anything unusual.

Pay particular attention to:

Unusual noises (ISD 510/DSD 510only).

Overheated surfaces (temperatures up to 100 °C can occur in normal operation).

Uneven running (ISD 510/DSD 510 only).

Strong vibrations.

Loose fastenings.

Condition of electrical wiring and cables.

Poor heat dispersion.

10.3.2 System Modules
Carry out regular inspections during operation.

Check:

The cooling vents are not blocked.

The fan is not making any unusual noises.

The condition of electrical wiring and cables.

10.4 Repair
Always contact the local Danfoss sales company for information about the repair policy.

10.5 ISD 510/DSD 510 Servo Drive Replacement

10.5.1 Dismounting the ISD 510/DSD 510 Servo Drive

Procedure

Disconnect the supply and wait for the discharge time to elapse.

Disconnect the electrical cables.

Dismount the servo drive.

Replace the servo drive with a servo drive of the same type. See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510

(VLT® Flexmotion™) Design Guide for part numbers.

10.5.2 Fitting and Commissioning the ISD 510/DSD 510 Servo Drive

Procedure

Check if preparation is required (see 4.6.1 ISD 510/DSD 510 Servo Drive).

Fit the servo drive (see 4.7.5.2 Clamping the ISD 510 Servo Drive).

Connect the hybrid cables (see 5.9.3 Connecting Hybrid Cables).

Connect the I/O and/or encoder cables (see 5.9.5.2 Connecting I/O and/or Encoder Cables to Port X3).

Con�gure the servo drive parameters according to the �eldbus used (see 6.3 EtherCAT® ID Assignment and 6.4 Ethernet
POWERLINK® ID Assignment).

Conduct a test run.

10.6 System Module Replacement

10.6.1 Dismounting the System Modules

Disconnect the mains and all auxiliary supplies from the PSM 510 and wait for the discharge time to elapse.

Disconnect the EMC plate on the bottom of the system modules. Do not dismount the connectors from the EMC plate.
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Illustration 110: Disconnecting the EMC Plate

Unplug the RJ45 connector [2] (only on DAM 510).

Unscrew the screw [4] on the EMC plate.

Press the clip [3] to release the EMC plate.

Unscrew the PE screw [1].

Disconnect the I/O shielding plate on the top of the system modules:

1

3

2

e3
0b

g8
14

.1
0

Illustration 111: Disconnecting the I/O Shielding Plate

Unplug the top connectors [1].

Unscrew the screw [2] on the I/O shielding plate [3].

Pull the I/O shielding plate upwards to remove it.

Release the securing clamp [1] at the top of the module.
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Illustration 112: Releasing the Securing Clamp

Tilt the module forward and remove it from the backplate.
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Illustration 113: Removing the Module

10.6.2 Fitting and Commissioning the System Modules
Check if preparation is required (see 4.6.2 System Modules).

Fit the system modules (see 4.7.7 Fitting Instructions for System Modules).

Connect the electrical cables (see chapter Electrical Installation).

Switch the system on (see 6.8 Switching on the ISD 510/DSD 510 System).
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Con�gure the system module's parameters according to the �eldbus used (see 6.3 EtherCAT® ID Assignment , 6.4 Ethernet
POWERLINK® ID Assignment, and 6.5 PROFINET® ID Assignment).

Conduct a test run.

10.7 Cable Replacement

10.7.1 Overview
Replace the cables when the rated number of bending cycles has been reached or the cable is damaged.

N O T I C E

Do not forcefully connect or �t the connectors. Incorrect connection causes permanent damage to the connectors.

10.7.2 Feed-In Cable Replacement

10.7.2.1 Disconnecting the Feed-In Cable

Procedure

Disconnect the Power Supply Module (PSM 510) from its power source (mains network and all auxiliary supplies).

Wait for the necessary discharge time to elapse.

Disconnect any cables connected to the X3, X4, or X5 ports on the ISD 510/DSD 510 servo drive for easier access to the
feed-in cable.

Disconnect the PE wire from the PE screw on the Decentral Access Module (DAM 510).

Disconnect the Ethernet connector.

Remove the EMC plate from the DAM 510.

Open the cable binder holding the STO cable.

Open the cable binder holding the feed-in cable on the DAM 510.

Loosen the feed-in cable connectors on the DAM 510.

Disconnect the feed-in cable from the DAM 510.

Loosen the threaded ring of the connector on the servo drive.

Disconnect the feed-in cable from the servo drive.

10.7.2.2 Replacing the Feed-In Cable
Replace the feed-in cable with a cable of identical type and length. See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510

(VLT® Flexmotion™) Design Guide for part numbers.

10.7.2.3 Connecting the Feed-In Cable
Connect the female connector of the feed-in cable to the male connector of the 1st servo drive.

Turn the threaded rings of the connectors hand tight.

Ensure that there is no mechanical tension on the cables.

Insert the feed-in cable wires into the correct connector on the EMC plate at the bottom of the Decentral Access Module
(DAM 510).

Secure the feed-in cable with a cable binder.

Secure the STO cable with a cable binder.

Mount the EMC plate on the DAM 510.

Connect the Ethernet connector to the DAM 510.

Connect the PE wire to the PE screw on the DAM 510.

Reconnect any cables that were connected to the X3, X4, or X5 ports.

10.7.3 Loop Cable Replacement

10.7.3.1 Disconnecting the Loop Cable

Procedure

Disconnect the Power Supply Module (PSM 510) from its power source (mains network) and all auxiliary supplies.
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2.

3.

4.

5.

1.

2.

3.

4.

5.

6.

1.



2.

Wait for the necessary discharge time to elapse.

Disconnect any cables connected to the X3, X4, or X5 ports on both ISD 510/DSD 510 servo drives for easier access to the
loop cable.

Loosen the threaded rings of the loop cable connectors on both servo drives.

Disconnect the loop cable from the servo drives.

10.7.3.2 Replacing the Loop Cable
Replace the loop cable with a cable of identical type and length. See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510

(VLT® Flexmotion™) Design Guide for part numbers.

10.7.3.3 Connecting the Loop Cable
Connect the male connector of the loop cable to the female connector on the servo drive.

Connect the female connector of the loop cable to the male connector on the adjacent servo drive.

Turn the threaded rings hand tight on both servo drives.

Ensure that there is no mechanical tension on the cables.

Tighten the threaded rings of the connectors on both servo drives.

Reconnect any cables that were connected to the X3, X4, or X5 ports on both servo drives.

10.8 Fuse Replacement in Decentral Access Module (DAM 510)
If a single fuse blows, replace all the fuses with fuses from the same batch (fuse CAT number 5012006.25, SIBA).

Procedure

Remove the screws [1] and remove the cover.

1

e
3

0
b

g
8

0
0

.1
0

Illustration 114: Opening the Cover on DAM 510

Use a screwdriver to remove the fuses and replace them with the same number of identical type fuses (see 5.5.1 Fuses).
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

3.
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g
8

0
1

.1
0

Illustration 115: Removing the Fuse

Replace the cover and tighten the screws. The tightening torque is 2 Nm.

10.9 Fan Replacement

e
3

0
b

g
8

1
7

.1
0

Illustration 116: Fan Replacement on 50 mm Modules

e
3

0
b

g
8

1
8

.1
0

Illustration 117: Fan Replacement on 100 mm Modules
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1.

2.

3.

-

N O T I C E

See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Design Guide for further information on

fan types.

Procedure

Use a screwdriver as a lever to release the fan holder.

Remove the fan.

Replace the fan with an identical type fan.

10.10 Product Returns
Danfoss products can be returned for disposal at no charge. A prerequisite for this is that they are free of deposits, such as oil,
grease, or other types of contamination that hampers disposal. Furthermore, foreign materials or third-party components cannot be
included with the returned product.

Ship the products free on board to the local Danfoss sales company.

10.11 Recycling
Take metals and plastics to recycling stations.

The servo drives and system modules are classi�ed as electronic waste, and the packaging is classi�ed as packaging waste.

10.12 Disposal
Devices containing electronic components cannot be disposed of as normal domestic waste.

Dispose of the servo drives and system modules as hazardous waste, electrical waste, recyclable waste, and so on, in accordance
with applicable local regulations.
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11 Speci�cations

11.1 Nameplates

11.1.1 Nameplate on ISD 510/DSD 510 Servo Drive
Check the nameplate and compare it with the order data. Use the part number for reference. The part number uniquely identi�es
the drive type.

Ensure that the nameplate is clearly legible.

The servo drives can be identi�ed externally only by the original Danfoss nameplate.

The following data is shown on the servo drive nameplate:

e3
0b

g8
28

.1
0

VLT ISD 510

Input1: 560-680VDC 3.4A             Input2: 24-48VDC 0.3A

Ambient: 5... 40˚C / 41...104˚F
Enclosure: IP54      Class F

PART NO: 136X6382
SERIAL NO: 001301Q170

 00:1B:08:22:D5:E8

136X6382001301Q170
Made in Italy

Danfoss A/S 6430 
Nordborg, Denmark

SCCR: 5kA
Internal Motor Overload Protection 105%
E134261 Power Conversion Equipment

Mnom: 6.0Nm Nnom: 3000rpm Pnom: 1.9kW fout: 0...590Hz

ISD510AT06C0D6E54FM1PNSXXTF108SXN30BKXSX 
1

2

4
3

5
6

7

8
9

Mmax: 29.9Nm I0: 4.9A M0: 8.6Nm

VAI

Illustration 118: Example of a Nameplate on the ISD 510 Servo Drive

1 Typecode

2 Supply voltage

3 Nominal torque

4 Maximum torque

5 Ambient temperature range

6 Protection rating

7 Auxiliary input voltage

8 Output frequency

9 Rated speed
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e3
0b

g8
27

.1
0VLT DSD 510

Input1: 560-680VDC 8.3A             Input2: 24-48VDC 1.0A

Ambient: 5˚... 40˚C / 41˚... 104˚F
Enclosure: IP67

PART NO: 136L3447
SERIAL NO: 018601Q050

 00:1B:08:20:E1:BF

136L3447018601Q050
Made in Italy

Danfoss A/S 6430 
Nordborg, Denmark

SSCR: 5kA
Internal Motor Overload Protection 105%
E134261 Power Conversion Equipment

Uout: 3x 0-Input1 VAC Inom: 8.0A Pnom: 4.4kW fout: 0...590Hz

DSD510AC08A8D6E67FRXPLSXXTF2S2XXXXXXXXSX
1

2

4
3

5
6

7

9
8

Umax: 3x 0-Input1 VAC Imax: 21.0A Pmax: 11.5kW

VAI

Illustration 119: Example of a Nameplate on the DSD 510 Servo Drive

1 Typecode

2 Supply voltage

3 Output voltage

4 Maximum voltage

5 Ambient temperature range

6 Protection rating

7 Output frequency

8 Peak power

9 Peak current

11.1.2 Nameplate on the System Modules

11.1.2.1 Example Nameplate on the Front of the System Modules
Ensure that the nameplate is clearly legible.

The following data is shown on the nameplate on the front of the system modules:

VLT PSM 510

DANGER

PART NO:     175G0166

SERIAL NO:  966001Q368

OUTPUT: Pnom: 30kW

Notes:

MAC PSM
X1 IN:

X2 OUT:

15 MIN

00:1B:08:15:B3:XX
00:1B:08:15:B3:XX

00:1B:08:15:B3:XX

e3
0b

g2
76

.1
01

2

3
4

5

6

7

8

9
Motor over-temperature sensing is required

Illustration 120: Example Nameplate on the Front of the System Modules
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1 Danfoss logo

2 System module name

3 Part number

4 Serial number

5 Output

6 Data matrix

7 Notes

8 MAC addresses

9 Warning symbols

11.1.2.2 Example Nameplate on the Side of the System Modules
The following data is shown on the nameplate on the side of the system modules:

Illustration 121: Example Nameplate on the Side of the System Modules for PSM 510

1 Type code

2 Supply voltage

3 Output voltage

4 Maximum power

5 Ambient temperature range

6 Protection rating: IP20 according to IEC/EN 60529
(except connectors which are IP00)

7 UAUX supply

8 Short-circuit current rating

9 Rated power

11.2 Characteristic Data

11.2.1 Characteristic Data for ISD 510 Servo Drive without Brake
Table 121: Characteristic Data for Servo Drive without Brake

Speci�ca-

tions

Unit Size 1,

1.5 Nm

Size 2,

2.1 Nm

Size 2,

2.9 Nm

Size 2,

3.8 Nm

Size 3,

5.2 Nm

Size 3,

6.0 Nm

Size 4,

11.2 Nm

Size 4,

13.0 Nm(1)

Rated speed
nN

RPM 4600 4000 2900 2400 3000 3000 2000 –

Rated tor-
que MN

Nm 1.5 2.1 2.9 3.8 5.2 6.0 11.2 –

Rated cur-
rent IN

A DC 1.4 1.7 1.8 3.6 3.4 4.7 –
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Speci�ca-

tions

Unit Size 1,

1.5 Nm

Size 2,

2.1 Nm

Size 2,

2.9 Nm

Size 2,

3.8 Nm

Size 3,

5.2 Nm

Size 3,

6.0 Nm

Size 4,

11.2 Nm

Size 4,

13.0 Nm(1)

Rated power
PN

kW
[hp]

0.72 [0.98] 0.88 [1.20] 0.94
[1.28]

1.6 [2.18] 1.9 [2.58] 2.3 [3.13] –

Standstill
(stall) torque
M0

Nm 2.3 2.8 3.6 4.6 6.6 8.6 13.3 –

Standstill
(stall) cur-
rent I0

A DC 2.1 2.3 2.1 2.2 4.6 4.9 5.6 –

Peak torque
Mmax

Nm 6.1 7.8 10.7 12.7 21.6 29.9 38.6 –

Peak current
(rms value)
Imax

A DC 5.7 6.4 17.7 19.8 21.2 –

Rated volt-
age

V DC 565–680 ±10%

Inductance
L ph-ph

mH 18.5 26.8 32.6 33.9 11.9 11.4 18.0 –

Resistance
R ph-ph

Ω 9.01 7.78 8.61 8.64 2.35 2.10 2.26 –

Voltage con-
stant EMK

V/
krpm

70.6 80.9 111.0 132.0 92.7 112.0 158.8 –

Torque con-
stant Kt

Nm/A 1.10 1.26 1.72 2.04 1.22 1.51 1.82 –

Inertia Kgm2 0.000085 0.00015 0.00021 0.00027 0.00062 0.00091 0.0024 –

Protective
measures

– Overload, short-circuit, and ground fault protection.

Maximum
output fre-
quency

Hz 590

Shaft diame-
ter

mm
[inch]

14 [0.55] 19 [0.75] 24 [0.94] 32 [1.26]

Pole pairs – 4 5

Flange size mm
[inch]

76 [2.99] 84 [3.31] 108 [4.25] 138 [5.43]

Functional
safety

– STO

Cooling – Via �ange

Mounting – Via �ange

Weight kg
[lbs]

3.5 [7.7] 4.0 [8.8] 5.0 [11.0] 6.0 [13.2] 8.3 [18.3] 10.0
[22.0]

13.8 [30.4] –

1 In preparation
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11.2.2 Characteristic Data for ISD 510 Servo Drive with Brake
Table 122: Characteristic Data for Servo Drive with Brake

Speci�ca-

tions

Unit Size 1,

1.5 Nm

Size 2,

2.1 Nm

Size 2,

2.9 Nm

Size 2,

3.8 Nm

Size 3,

5.2 Nm

Size 3,

6.0 Nm

Size 4,

11.2 Nm

Size 4,

13.0 Nm(1)

Brake iner-
tia

Kgm2 0.0000012 0.0000068 0.000021 0.000072 –

Brake
weight

kg [lbs] 0.34 [0.75] 0.63 [1.39] 1.1 [2.42] 2.0 [4.41] –

1 In preparation

11.2.3 Characteristic Data for DSD 510 Servo Drive
Table 123: Characteristic Data for DSD 510

Speci�cations Unit DSD 510

Input

DC-link V DC 565–680 ±10%

DC-link capacitance μF 10

UAUX V DC 24/48 ±10%

UAUX current consumption (at 24 V DC) A DC 1

UAUX current consumption (at 48 V DC) A DC 0.5

Output

Output number of phases – 3

Output voltage V AC VIN PSM

Rated current IN A DC 12.0 with mounting plate(1), 8.0 standalone

Rated power PN kW [hp] 4.4 [5.9] with mounting plate

Peak current (rms value) Imax A rms 21.0

Nominal switching frequency kHz 4/5

Possible switching frequency kHz 8/10

Derating of nominal and peak current with 8 kHz switching frequency % 62.5

Derating of nominal and peak current with 10 kHz switching frequency % 55

Protective measures – Overload, short-circuit, and ground fault pro-
tection.

Maximum output frequency Hz 590

Functional safety – STO

Cooling – Via mounting surface

Mounting – Screw-mounted via base

Number of motor connectors – 1
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Speci�cations Unit DSD 510

Weight kg [lbs] 2.85 [6.28]

Dimensions

(W x H x D)

mm 107.8 x 330.5 x 84

1 Dimensions: 470 x 270 x 10 mm [18.5 x 10.6 x 0.4 inch]

11.2.4 Characteristic Data for Power Supply Module (PSM 510)
Table 124: Characteristic Data for PSM 510

De�nition Unit Power size 1 Power size 2 Power size 3

Input

Mains input voltage V AC 400–480 ±10%, 3-phase (see 5.2 Electrical Environmental Conditions)

Input current @ UMIN A 20 34 50

Input power VA 12.5 22 32

UAUX input voltage V DC 24/48 ±10%

UAUX current consumption at 24 V DC A DC 2.0

UAUX current consumption at 48 V DC A DC 1.0

Output

DC-link voltage V DC 565–680 ±10%

DC-link capacitance µF 1800

Rated current IN A 20 40 60

Rated power PN kW 10 20 30

Peak power Pmax t <3.0 s) kW 20 40 60

Internal brake resistor(1)

Peak power Pmax kW 8

Rated power PN W 150

Nominal resistance Ω 15

External brake resistor

Peak power Pmax kW 60

Rated power PN kW 7.5

Minimum resistance Ω 10

General

Protective measures – Overload, short-circuit, and ground fault protection

Line �lter in accordance with EN 61800-3 – Category C3

Cooling – Integrated fan
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De�nition Unit Power size 1 Power size 2 Power size 3

Mounting – Wall-mounted on backplate using backlink connector

Weight kg 6

Dimensions (W x H x D) mm 137.3 x 406.3 x 270

1 An external brake resistor can be connected.

11.2.5 Characteristic Data for Decentral Access Module (DAM 510)
Table 125: Characteristic Data for DAM 510

De�nition Unit Power size 1 Power size 2

Input

DC-link V DC 565–680 ±10%

DC-link capacitance µF 660

Maximum input current A DC 15 24

UAUX V DC 24/48 ±10%

UAUX current consumption at 24 V DC A DC 0.5

UAUX current consumption at 48 V DC A DC 0.3

Output

Output voltage V DC VOUT PSM

Output current DC-link A DC 15 25

Peak current DC-link (rms value) t <1.0 s Arms 30 for <1 s 48 for <1 s

Output current UAUX A DC 15

General

Protective measures – Overload, short-circuit, and ground fault protection

Cooling – Natural convection

Mounting – Wall-mounted on backplate using backlink connector

Weight kg 3.05

Dimensions (W x H x D) mm 84.3 x 471 x 270

11.2.6 Characteristic Data for Auxiliary Capacitors Module (ACM 510)
Table 126: Characteristic Data for ACM 510

De�nition Unit Value

DC-link V DC 565–680 ±10%

DC-link capacitance µF 2750

UAUX V DC 24/48 ±10%

UAUX current consumption at 24 V DC A DC 0.5
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De�nition Unit Value

UAUX current consumption at 48 V DC A DC 0.3

Cooling – Natural convection

Mounting – Wall-mounted on backplate using backlink connector

Weight kg 3.54

Dimensions (W x H x D) mm 84 x 371 x 270

11.3 Dimensions

11.3.1 ISD 510 Servo Drive Flange Dimensions

Size Flange thickness [mm]

Size 1, 1.5 Nm 7

Size 2, 2.1 Nm –

Size 2, 2.9 Nm 8

Size 2, 3.8 Nm 8

Size 3, 5.2 Nm 10.8

Size 3, 6.0 Nm 10.8

Size 4, 11.2 Nm 13.8

Size 4, 13.0 Nm(1) –

1 In preparation

11.3.2 Dimensions of ISD 510 Servo Drive
All dimensions are in mm (in).
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Illustration 122: Dimensions of ISD 510 Size 1, 1.5 Nm
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Illustration 123: Dimensions of ISD 510 Size 2, 2.1 Nm
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Illustration 124: Dimensions of ISD 510 Size 2, 2.9 Nm
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Illustration 125: Dimensions of ISD 510 Size 2, 3.8 Nm
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Illustration 126: Dimensions of ISD 510 Size 3, 5.2 Nm
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Illustration 127: Dimensions of ISD 510 Size 3, 6.0 Nm
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Illustration 128: Dimensions of ISD 510 Size 4, 11.2 Nm
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11.3.3 Dimensions of DSD 510 Servo Drive
All dimensions are in mm (in).
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Illustration 129: Dimensions of DSD 510 Servo Drive

11.3.4 Dimensions of Power Supply Module (PSM 510)
All dimensions are in mm (in).
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Illustration 130: Dimensions of PSM 510
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11.3.5 Dimensions of Decentral Access Module (DAM 510)
All dimensions are in mm (in).
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Illustration 131: Dimensions of DAM 510

11.3.6 Dimensions of Auxiliary Capacitors Module (ACM 510)
All dimensions are in mm (in).
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Illustration 132: Dimensions of ACM 510

11.3.7 Dimensions of Expansion Module (EXM 510)
All dimensions are in mm (in).
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Illustration 133: Dimensions of EXM 510
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11.4 Motor Overload Protection

N O T I C E

Internal motor overload protection operates at 105% of the motor full load current.

Instruct DSD 510 with nominal motor current (full load current according to the motor technical label) to use the protection
properly.

DSD 510 incorporates internal overload protection in the following multiples of current setting:

Table 127: Multiples of Current Setting

Multiple of current setting Maximum trip time

7.2 20 s

1.5 8 min

1.2 2 hrs

11.5 Motor Overtemperature Protection
The internal motor overload protection implemented does not have thermal memory retention or speed sensitivity.

N O T I C E

Internal motor overtemperature protection is not incorporated in DSD 510, so motor overtemperature sensing is required.
DSD 510 has an input for motor temperature sensor.

A temperature sensor is integrated in ISD 510.

N O T I C E

Use a motor with reinforced insulation between the thermistor and the motor windings (tested with 4300 V DC and 8000
Vpeak impulse).

11.6 Hybrid Cable Protection
The AUX 24/48 V has 3 levels of protection:

Software (seconds timing range): The control boards opens the 24/48 V AUX if an overload is present (>15 A).

Hardware (microseconds timing range): Opens automatically if a short circuit of >36 A is present.

Hardware: A 20 A non-replaceable SMD (surface-mounted device) fuse in case the �rst 2 protective measures fail.

11.7 Permitted Forces on the ISD 510 Servo Drive Shaft
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Illustration 134: Permitted Forces
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The maximum axial and radial load while assembling the motor and for any mechanical device connected to the shaft, must not
exceed the values shown in Table 128. The shaft must be loaded slowly and in a constant manner: Avoid pulsating loads.

N O T I C E

The bearing could be permanently damaged if the maximum permitted forces are exceeded.

Table 128: Maximum Load Ratings

Motor size Maximum radial force (Fr) in N Maximum axial force (Fa) in N

Size 1 450 1050

Size 2 900 1700

Size 3 830 1740

Size 4 1940 2200

The maximum radial load ratings are based on the following assumptions:

The servo drives are operated with peak torque of the longest member of the frame size.

Fully reversed load is applied to the end of the smallest diameter standard mounting shaft extension.

In�nite life with standard 99% reliability.

Safety factor = 2

11.8 Connectors on the ISD 510/DSD 510 Servo Drive

11.8.1 X1 and X2: Hybrid Connector (M23)
The hybrid cable provides the supply (mains and auxiliary), the communication lines, and the safety supply for each line of servo
drives. Input and output connectors are connected inside the servo drive.
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Illustration 135: Pin Assignment of X1 Male Hybrid Connector (M23)
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Illustration 136: Pin Assignment of X2 Female Hybrid Connector (M23)

Table 129: Pin Assignment of X1 and X2 Hybrid Connectors (M23)

Pin Description Notes Rating/parameter

A UDC- Negative DC supply Operating voltage: 565–680 V DC, maximum 778 V

Negative DC supply (maximum -15 A/25 A)

B UDC+ Positive DC supply Operating voltage: 565–680 V DC, maximum 778 V

Positive DC supply (maximum 15 A/25 A)

C AUX+ Auxiliary supply 24-48 V DC±10%, 15 A

Absolute maximum 55 V DC
D AUX- Auxiliary supply ground

PE PE PE connector 15 A

2 STO+ Safety supply 24 V DC ±10%, 1 A

3 STO- Safety supply ground

5 TD+ Positive Ethernet transmit According to standard 100BASE-T

6 RD- Positive Ethernet receive

7 TD- Negative Ethernet transmit

8 RD+ Negative Ethernet receive

11.8.2 X3: 3rd Ethernet Connector (M8, 4 pole)
The ISD 510/DSD 510 advanced servo drives have an additional �eldbus port (X3) for connecting a device that communicated via
the selected �eldbus.
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Illustration 137: Pin Assignment of X3 3rd Ethernet Connector (M8, 4 pole)
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Table 130: Pin Assignment of X3 3rd Ethernet Connector (M8, 4 pole))

Pin Description Notes Rating/parameter

1 TD+ Positive Ethernet transmit According to standard 100BASE-T

2 RD+ Positive Ethernet receive

3 RD- Negative Ethernet receive

4 TD- Negative Ethernet transmit

11.8.3 X4: I/O and/or Encoder Connector (M12, 8 pole)
The X4 connector is available on the ISD 510/DSD 510 advanced servo drives and can be con�gured as:

Digital output

Digital input

Analog input

24 V supply

External encoder interface (SSI or BiSS)
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Illustration 138: Pin Assignment of X4 M12 I/O and/or Encoder Connector

Table 131: Pin Assignment of X4 M12 I/O and/or Encoder Connector

Pin Description Notes Rating/parameter

1 Digital output Switched 24 V as digital output or supply (24 V/150 mA) Nominal voltage: 24 V ±15%

Maximum current: 150 mA

Maximum switching frequency: 100 Hz

2 Ground Ground isolated -

3 Input 1 Analog/Digital input Digital input:

Nominal voltage: 0-24 V

Bandwidth: ≦ 100 kHz

Analog input:

Nominal voltage: 0-10 V

Input impedance: 5.46 kΩ

Bandwidth: ≦ 25 kHz

4 /SSI CLK Negative SSI/BiSS clock out SSI:

Bus speed: 0.5  Mbit with 25 m cable

BiSS:

Ful�lls the RS485 speci�cation.

Maximum cable length (SSI & BiSS): 25 m

5 SSI DAT Positive SSI/BiSS data in

6 SSI CLK Positive SSI/BiSS clock out

7 Input 2 Analog/Digital input Digital input:

Nominal voltage: 0-24 V

Bandwidth: ≦ 100 kHz
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Pin Description Notes Rating/parameter

Analog input:

Nominal voltage: 0-10 V

Input impedance: 5.46 kΩ

Bandwidth: ≦ 25 kHz

8 /SSI DAT Negative SSI/BiSS data in SSI:

Bus speed: 0.5  Mbit with 25 m cable

BiSS:

Ful�lls the RS485 speci�cation.

Maximum cable length (SSI & BiSS): 25 m

11.8.4 X5: LCP Connector (M8, 6 pole)
The X5 connector is used to connect the LCP directly to the ISD 510/DSD 510 advanced servo drives via a cable.
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Illustration 139: Pin Assignment of X5 LCP Connector (M8, 6 pole)

Table 132: Pin Assignment of X5 LCP Connector

Pin Description Notes Rating/parameter

1 Not connected – –

2 /LCP RST Reset Active at ≦0.5 V

3 LCP RS485 Positive RS485 signal Speed:

38.4 kBd

The levels ful�ll the RS485 speci�cation.
4 /LCP RS485 Negative RS485 signal

5 GND GND –

6 VCC 5 V supply for LCP 5 V ±10% at 120 mA maximum load

11.8.5 X6: Standard/HIPERFACE DSL Motor Connector
The standard/HIPERFACE DSL motor connector is an M23 female connector.
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Illustration 140: Pin Assignment of X6 Motor Connector
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Table 133: Pin Assignment of X6 Motor Connector

Pin Description Notes Rating/parameter

1 U Motor phase U Nominal voltage: 400–480 V ±10% (see 11.2.3 Characteristic Data for DSD
510 Servo Drive)

Conductor cross-section: 2.5 mm2PE PE Protective earth

3 W Motor phase W

4 V Motor phase V

A Brake+ Used to connect the motor's
mechanical brake (if present).

Nominal voltage: 24 V

Maximum (peak) voltage: 48 V ±10%

Conductor cross-section: 0.75 mm2
B Brake–

C Data–(1) HIPERFACE DSL negative line –

D Data+(1) HIPERFACE DSL positive line –

1 The data+/– signals are only present on the HIPERFACE DSL variant, otherwise both are not connected.

11.8.6 X7: Motor Feedback Connector
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Illustration 141: Pin Assignment of X7 Motor Feedback Connector

Table 134: Pin Assignment of X7 Motor Feedback Connector

Pins Description Resolver BISS B HIPERFACE EnDat 2.1 and 2.2 Rating/parameter

1 RESSIN X – X (1) Resolver positive sine input

2 GND – X X X GND

3 RESCOS X – X (1) Resolver positive cosine input

4 VEE – X X X +5/11 V(2)

5 RXTX – X X X Encoder positive data signal

6 \RESSY X – – – Resolver negative exciter output

7 TEMP+ X X X X Motor temperature sensor input

8 ENC_CLK – X – – Encoder positive clock signal

9 \RESSIN X – X (1) Resolver negative sine input

10 – – – – – –

11 \RESCOS X – X (1) Resolver negative cosine input

12 – – – – – –
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Pins Description Resolver BISS B HIPERFACE EnDat 2.1 and 2.2 Rating/parameter

13 \RXTX – X X X Encoder negative data signal

14 TEMP– X X X X Motor temperature sensor input

15 \ENC_CLK – X – – Encoder negative clock signal

16 – – – – – –

17 RESSY X – – – Resolver positive exciter output

1 The SINE and COSINE signals are optional for EnDat

2 The supply switched automatically between 5 V and 11 V depending on which feedback type is selected.

11.9 Connectors on the System Modules

11.9.1 Backlink Connector
The backlink connector is located at the top of the backside of all the ISD 510 system modules.
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Illustration 142: Pin Assignment of Backlink Connector

Table 135: Pin Assignment of Backlink Connector

Pin Description

1 24/48 V

2 GND

3 FE: Functional earth

4 DC–

5 DC+
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11.9.2 Brake Connectors
Brake connectors are located on the Power Supply Module (PSM 510).

11.9.2.1 Brake Resistor Connector on PSM 510
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Illustration 143: Brake Connector on PSM 510

Table 136: Pin Assignment of Brake Connector on PSM 510

Pins (left to

right)

Description Notes Ratings

1 DC+/R+ Used for connecting a brake re-
sistor.

Nominal voltage: 560–800 V DC

Maximum brake current: 80 A

Conductor cross-section range: 0.75–16 mm2 (AWG 18–AWG 4)
2 R–

N O T I C E

The maximum length of the brake cable is 30 m (shielded).

11.9.3 Ethernet Connectors
Ethernet connectors are located on all the system modules.
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Illustration 144: Ethernet Connector

N O T I C E

Only PELV potential can be connected to the digital inputs and outputs.

11.9.3.1 Ethernet Connectors on PSM 510 and ACM 510
Table 137: Ethernet Connectors on PSM 510 and ACM 510

Connector name Description Pins Ratings

X1 IN Ethernet IN 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

According to standard 100BASE-T.

X2 OUT Ethernet OUT1
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11.9.3.2 Ethernet Connectors on DAM 510
Table 138: Ethernet Connectors on DAM 510

Connector name Description Pins Ratings

X1 IN Ethernet IN 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

According to standard 100BASE-T.

X2 OUT Ethernet OUT1 (connection to hybrid cable)

X3 OUT Ethernet OUT2

11.9.4 I/O Connectors

11.9.4.1 I/O Connector on PSM 510/ACM 510
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Illustration 145: I/O Connector on PSM 510 (I/O PSM) and ACM 510 (I/O ACM)

Table 139: Pin Assignment of I/O Connector on PSM 510/ACM 510

Pins Description Notes Rating/parameter

1 DIN1– Digital input Input voltage: 0–30 V DC

High (logic "1") voltage: 15–30 V DC

Low (logic "0") voltage: <5 V DC

Maximum input signal frequency: 50 Hz

Maximum input current at 48 V: 11 mA

Maximum input resistance: 4.5 KΩ

2 DIN1+

3 DIG_OUT– Digital output Maximum voltage between terminals: 24 V DC or AC

Maximum current: 1 A

Maximum output switching frequency: 50 Hz
4 DIG_OUT+

The conductor cross-section range is 0.2–1.5 mm2 (AWG 24–AWG 16).

N O T I C E

Only PELV potential can be connected to the digital inputs and outputs.

11.9.5 UAUX Connector
The UAUX connector is located on the Power Supply Module (PSM 510).
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Illustration 146: UAUX Connector

Table 140: Pin Assignment of UAUX Connector

Pins

(left to

right)

De-

scrip-

tion

Notes Rating/parameter

1 24 V
AUX

Used for 24–48 V DC in-
put to the Power Supply
Module (PSM 510).

Nominal input voltage: 24 V/48 V DC ±10%

Nominal current: Depends on the number of servo drives in the application.

Maximum current: 50 A

Maximum cross-section: 16 mm2

Maximum cable length: 3 m

Conductor cross-section range 0.75–16 mm2, solid or �exible (AWG 18–AWG 4)

2 GND

N O T I C E

Only PELV potential can be connected to the UAUX input.

11.9.5.1 24/48 V Cable Cross Sections for PSM 510

Minimum cable cross section for CE (minimum 70 °C, Cu) 16 mm2

Minimum cable cross section for UL (minimum 60 °C, Cu) 4 AWG

11.9.6 LCP Connector (M8, 6-pole)
The LCP connector is located on the front of all the system modules. It used to connect the LCP directly via a cable.
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Illustration 147: LCP Connector (M8, 6 pole)

Table 141: Pin Assignment of LCP Connector

Pins Description Notes Rating/parameter

1 Not connected – –

2 /LCP RST Reset Active at ≦0.5 V

3 LCP RS485 Positive RS485 signal Speed:

38.4 kBd

The levels ful�ll the RS485 speci�cation.
4 /LCP RS485 Negative RS485 signal
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Pins Description Notes Rating/parameter

5 GND GND –

6 VCC 5 V supply for LCP 5 V ±10% at 120 mA maximum load

N O T I C E

Only PELV potential can be connected to the LCP input.

11.9.7 AC Mains Connector
The AC mains connector is located on the bottom of the Power Supply Module (PSM 510).
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Illustration 148: AC Mains Connector

Table 142: Pin Assignment of AC Mains Connector

Pins

(left to

right)

Descrip-

tion

Notes Rating/parameter

1 L3 Used to connect
L1/L2/L3

Nominal voltage: 400–480 V AC ±10%

Nominal power: 30 kW

Maximum cross-section: 16 mm2 (AWG 4)

Conductor cross-section range 0.75–16 mm2, solid or �exible (AWG 18–AWG 4)

2 L2

3 L1

11.9.7.1 Mains Cable Cross-Sections for PSM 510
Table 143: Mains Cable Cross-Sections for PSM 510

PSM 510 (10 kW) PSM 510 (20 kW) PSM 510 (30 kW)

Minimum cable cross-section for CE 4 mm2

(minimum 70 °C, Cu)

16 mm2

(minimum 70 °C, Cu)

16 mm2

(minimum 90 °C, Cu)

Minimum cable cross-section for UL AWG 10

(minimum 60 °C, Cu)

AWG 6

(minimum 60 °C, Cu)

AWG 4

(minimum 75 °C, Cu)

11.9.8 Relay Connector
The relay connector is used for a user-de�ned reaction and is located as follows:

Power Supply Module PSM 510: 1 relay connector

Auxiliary Capacitors Module ACM 510: 1 relay connector

N O T I C E

Only PELV potential can be connected to the relay outputs.
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11.9.8.1 Relay Connector on PSM 510/ACM 510
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Illustration 149: Relay Connector on PSM 510/ACM 510

Table 144: Pin Assignment of Relay Connector on PSM 510 (REL PSM) and ACM 510 (REL ACM)

Pins Description Notes Rating/parameter

11 NC Normally closed, 24 V DC Nominal current: 2 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)
12 NO Normally open, 24 V DC

13 COM Common

11.9.9 STO Connectors

11.9.9.1 STO Connectors on PSM 510
There is 1 input and 1 output STO connector on the Power Supply Module (PSM 510).
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Illustration 150: STO Output Connector on PSM 510
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Illustration 151: STO Input Connector on PSM 510

Table 145: Pin Assignment of STO Connectors on PSM 510

Connec-

tor name

Pins De-

scrip-

tion

Notes Rating/parameter

STO PSM 1 STO– Used for STO output
voltage to the input of
the other system
modules.

Nominal voltage: 24 V DC ±10%

Nominal current: Depends on the number of servo drives in the applica-
tion.

Maximum current: 1 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO+

3 STO– Used for STO input
voltage.

4 STO+

N O T I C E

Only PELV potential can be connected to the STO inputs.

11.9.9.2 STO Connectors on the DAM 510

11.9.9.2.1 STO Connectors on the Top of DAM 510
There is 1 input and 1 output STO connector on the top of the Decentral Access Module (DAM 510).
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Illustration 152: STO Output Connector on the Top of DAM 510
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Illustration 153: STO Input Connector on the Top of DAM 510

Table 146: Pin Assignment of STO Connectors on the Top of DAM 510

Connec-

tor name

Pins De-

scrip-

tion

Notes Rating/parameter

STO DAM 1 STO– Used for STO output
voltage to the input of
the other system
modules.

Nominal voltage: 24 V DC ±10%

Nominal current: Depends on the number of servo drives in the applica-
tion.

Maximum current: 1 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)

2 STO+

3 STO– Used for STO input
voltage.

4 STO+

N O T I C E

Only PELV potential can be connected to the STO inputs.

11.9.9.2.2 STO Connector on the Bottom of DAM 510
There is 1 output STO connector on the bottom of the Decentral Access Module (DAM 510). The output is for the hybrid cable.
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Illustration 154: STO Connector on the Bottom of DAM 510

Table 147: Pin Assignment of STO Connector on the Bottom of DAM 510

Connec-

tor name
Pins

(left to

right)

De-

scrip-

tion

Notes Rating/parameter

STO DAM 1 STO+ Used for the STO
output from the
DAM to the hybrid
cable.

Nominal voltage: 24 V DC ±10%

Nominal current: Depends on the number of servo drives in the appli-
cation.

Maximum current: 1 A

Conductor cross-section range: 0.2–1.5 mm2 (AWG 24–AWG 16)

Plug terminal tightening torque: 0.22–0.25 Nm

2 STO–

11.9.10 UDC Connector
The UDC connector is located on the bottom of the Decentral Access Module (DAM 510).
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Illustration 155: UDC Connector

Table 148: Pin Assignment of UDC Connector

Pins

(left to

right)

De-

scrip-

tion

Notes Rating/parameter

1 UDC+ Used to connect the DC-link voltage
from the Decentral access Module
(DAM 510) to the hybrid cable for the
ISD line.

Nominal voltage: 560–800 V DC

Nominal current: Depends on the number of servo drives in the
application.

Maximum current: 25 A

Conductor cross-section range: 0.2–6 mm2 (AWG 24–AWG 10)

Plug terminal tightening torque: 0.5–0.8 Nm

2 UDC–

11.9.11 AUX Connector
The AUX connector is located on the bottom of the Decentral Access Module (DAM 510).
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Illustration 156: AUX Connector

Table 149: Pin Assignment of AUX Connector

Pins

(left to

right)

Description Notes Rating/parameter

1 AUX+

(24/48 V)

Used to connect the AUX output
from the Decentral access Module
(DAM 510) to the hybrid cable for
the servo drive line.

Nominal voltage: 24/48 V DC ±10%

Nominal current: Depends on the number of servo drives in the
application.

Maximum current: 15 A

Conductor cross-section range: 0.2–2.5 mm2 (AWG 24–AWG 12)

Plug terminal tightening torque: 0.5–0.6 Nm

2 AUX– (GND)

N O T I C E

Only PELV potential can be connected to the AUX output.

11.9.12 External Encoder Connectors
This connector is used to connect an external encoder to DAM 510. It provides a guide value for CAM mode and Gear mode.The
external encoder connector is located on the Decentral Access Module (DAM 510) as follows:

DAM 510: E DAM

5 1

69 e3
0b

g4
61

.1
0

Illustration 157: External Encoder Connector

Table 150: External Encoder Connectors

Connector

name

Description Pins Ratings/Notes

E DAM Used to connect the ex-
ternal encoder to
DAM 510.

See Table
151.

Nominal voltage: 24 V DC, isolated (see Table 151)

Nominal current: Depends on the number of servo drives in the applica-
tion.

Maximum current: 150 mA (see Table 151)

Ful�ll the following speci�cations:

BISS/SSI
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Table 151: Pin Assignment of External Encoder Connectors (X1/X2)

Pins Description Notes

SSI/BiSS

Notes

1 24 V 24 V DC ±10% (used for powering the encoder) Maximum current: 150 mA

2 – – –

3 – – –

4 RS422 RXD Positive data Bus speed:

SSI: Up to 10 Mhz clock frequency with 30 m cable.

BiSS: Ful�lls the RS485 speci�cation.
5 RS422 TXD Positive data

6 GX Isolated ground.

If encoders are powered externally, the ground of the
external supply must be connected to GX.

–

7 – – –

8 /RS422 RXD Negative data Bus speed:

SSI: 0.5 Mbit with 25 m cable.

BiSS: Ful�lls the RS485 speci�cation.
9 /RS422 TXD Negative data

N O T I C E

Only PELV potential can be connected to the external encoder.

11.9.13 Expansion Module Connector

e3
0b

h3
90

.1
0

DC+ DC- GND
24 V
48 V

Illustration 158: Expansion Module Connector

Table 152: Pin Assignment of Expansion Module Connector

Pins

(left to

right)

Descrip-

tion

Note Rating/parameter

1 DC+ Shield the DC cables
using the cable tie on
the EXM 510 EMC
plate.

Nominal voltage: 560–800 V DC

Nominal current: Depends on the number of servo drives in the application.

Maximum current: 62 A
(1)

Conductor cross-section range: 0.75–16 mm2, solid or �exible (AWG 18–AWG 4)

Only use with ferrule without plastic sleeve with CRIMPFOX 16 S.

Use shielded conductors for UDC (DC+, DC–).

Plug terminal tightening torque: 1.7–1.8 Nm

2

3 DC–

4

5 FE (func-
tional
earth)

–

6 GND –
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Pins

(left to

right)

Descrip-

tion

Note Rating/parameter

7 24/48 V –

1 The maximum current rating for 1 pair of EXM is 62 A. In systems with 2 PSM 510 modules, 2 pairs of EXM 510 modules can be used to achieve a

maximum current rating of 124 A.

11.9.13.1 Cable Cross Sections for EXM 510
Table 153: Minimum Cable Cross Sections for EXM 510 Cables

Cable CE UL

DC+/DC– 16 mm2 (minimum 70 °C, Cu) 6 AWG (minimum 75 °C, Cu)

24 V, functional PE 16 mm2 (minimum 70 °C, Cu) 6 AWG (minimum 90 °C, Cu)(1)

1 Minimum 75 °C is allowed if less than 45 A are measured on the cable.

11.10 General Speci�cations and Environmental Data

11.10.1 ISD 510/DSD 510 Servo Drive
Table 154: General Speci�cations and Environmental Conditions for ISD 510/DSD 510

Speci�cation Value

Vibration test Random vibration: 7.54 g (2h/axis according to EN 60068-2-64)

Sinusoidal vibration:0.7 g (2h/axis according to EN 60068-2-6)

Maximum relative humidity Storage/transport: 5–93% (non-condensing)

Stationary use: 15–85% (non-condensing)

Ambient temperature Operating: 5–40 °C nominal, up to 55 °C with derating

Transport: –25 to +70 °C

Storage: –25 to +55 °C

Installation altitude No limitation up to 1000 m above sea level.

Maximum 2000 m above sea level with derating.

9% derating up to 2000 m with normal supply voltage, 3-phase AC 400 V.

EMC standard for emission and immunity EN 61800-3

EMC immunity functional safety EN 61800-5-2 Annex E

Pollution degree 2

Overvoltage category III

IP ratings See 11.11.1 Protection Ratings for ISD 510 Servo Drive and 11.11.2 Protection Ratings
for DSD 510 Servo Drive.
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11.10.2 System Modules
Table 155: General Speci�cations and Environmental Conditions for System Modules

Speci�cation Value

Protection rating IP20 according to IEC/EN 60529 (except connectors, which are IP00).

W A R N I N G
RISK OF ELECTRICAL SHOCK

The IP20 rating of the PSM 510, DAM 510, and ACM 510 modules is not ful�lled if

the modules are not connected to the backplate. This may result in death or seri-

ous injury.

Do not touch the backplate when a module is removed from the backplate.

Vibration test Random vibration: 1.14 g (2h/axis according to EN 60068-2-64)

Sinusoidal vibration: 1.0 g (2h/axis according to EN 60068-2-6)

Maximum relative humidity Storage/transport: 5–95% (non-condensing)

Stationary use: 5–93% (non-condensing)

Ambient temperature range Operating: 5–40 °C nominal, up to 55 °C with derating (see Illustration 159)

Transport: –25 to +55 °C

Storage: –25 to +55 °C

Installation altitude Nominal current up to 1000 m above sea level.

Derating of output current (1% / 100 m) from 1000 m to 3000 m.

Operation above 3000 m is not permitted.

EMC standard for emission and immunity EN 61800-3

EMC immunity for functional safety EN 61800-5-2 Annex E

Degree of pollution according to EN
60664-1

2

Overvoltage category according to
EN/IEC 61800-5-1

III
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Illustration 159: Derating
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11.11 Protection Ratings

11.11.1 Protection Ratings for ISD 510 Servo Drive

e
3

0
b

e
7

2
4

.1
1

IM B5 IMV1 IMV3

Illustration 160: Mounting Positions

Table 156: Protection ratings for ISD 510 Servo Drive

Mounting position of servo drive (according to DIN 42 950) IP rating (according to EN 60529)

Housing All positions IP65/IP67

Shaft without shaft seal IM B5 & IM V1 IP54

IM V3 IP50

Shaft with shaft seal IM B5 & IM V1 IP65

IM V3 IP60

N O T I C E

Install and connect the ISD 510 servo drives as described in this manual to achieve the ratings detailed in Table 156 in the
�nal application.

The ISD 510 servo drives are certi�ed by UL as recognized components.

11.11.2 Protection Ratings for DSD 510 Servo Drive
All DSD 510 variants have a protection rating of IP65/IP67.

N O T I C E

Install and connect the DSD 510 servo drives as described in this manual to achieve the IP65/IP67 rating in the �nal applica-
tion.

The DSD 510 servo drives are certi�ed by UL as recognized components.

11.12 Cables

N O T I C E

See the VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotion™) Design Guide for cable dimensions and

drawings.

11.12.1 Hybrid Cable PE
Table 157: Hybrid Cable PE

Item Description Cross section

Hybrid cable PE Used to connect the PE wire from the hybrid cable to the PE screw on the Decentral
Access Module (DAM 510).

Maximum cross-section:
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Item Description Cross section

2.5 mm2/4.0 mm2

11.13 Storage
Store the servo system components in a dry, dust-free location with low vibration (ve� ≦0.2 mm/s).

The storage location must be free from corrosive gases.

Avoid sudden temperature changes.

Long-term Storage
To recondition the electrolytic capacitors, servo drives and system components not in service must be connected to a supply source
once per year to allow the capacitors to charge and discharge. Otherwise the capacitors could su�er permanent damage.
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VLT Servo Drive Systems Glossary

A
A-�ange The A side is the shaft side of the servomotor.

ACM Auxiliary Capacitors Module.

Ambient temperature The temperature in the immediate vicinity of the servo system or compo-
nent.

Automation Studio™ Automation Studio™ is a registered trademark of B&R. It is the integrated

software development environment for B&R controllers.

Axial force The force in newton acting on the rotor axis in the axial direction.

B
B side The rear side of the servo drive with the plug-and-socket connectors.

B&R Multi-national company, specializing in factory and process automation
software and systems for a wide range of industrial applications.

Bearings The ball bearings of the servomotor.

Beckho�® Beckho�® is a registered trademark of and licensed by Beckho� Automation

GmbH, Germany.

Brake Mechanical holding brake on the servo drive.

C
CANopen® CANopen® is a registered community trademark of CAN in Automation e.V.

CE European test and certi�cation mark.

CIA DS 402 Device pro�le for drives and motion control. CIA® is a registered community

trademark of CAN in Automation e.V.

Clamping set A mechanical device, which, for example, can be used to secure gears to a
motor shaft.

Connector (M23) Servo drive hybrid connector.

Cooling Decentral servo drives are cooled by natural convection (without fans). All
system modules except the DAM 510, ACM 510, and EXM 510 are cooled by
an internal fan.

D
DAM Decentral Access Module

DC voltage A direct constant voltage.

DC-link Each servo drive has its own DC-link, consisting of capacitors.

DC-link voltage A DC voltage shared by several servo drives connected in parallel.

DSD Decentral Servo Drive

E
EPSG Ethernet POWERLINK® Standardization Group.

ETG EtherCAT® Technology Group

EtherCAT® EtherCAT® (Ethernet for Control Automation Technology) is an open high-

performance Ethernet-based �eldbus system. EtherCAT® is registered trade-

mark and patented technology, licensed by Beckho� Automation GmbH,
Germany.
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Ethernet POWERLINK® Ethernet POWERLINK® is a deterministic real-time protocol for standard

Ethernet. It is an open protocol managed by the Ethernet POWERLINK®

Standardization Group (EPSG). It was introduced by Austrian automation
company B&R in 2001.

F
Feed-in cable Hybrid connection cable between the Decentral Access Module (DAM 510)

and ISD 510/DSD 510 servo drive.

Feedback system The feedback system measures the rotor position.

Fieldbus Communication bus between controller and servo axis and system mod-
ules; in general between controller and �eld nodes.

Firmware Software in the unit; runs on the control board.

Function block Device functionalities are accessible via the engineering environment soft-
ware.

I
IGBT The insulated-gate bipolar transistor is a 3-terminal semiconductor device,

primarily used as an electronic switch to combine high e�ciency and fast
switching.

IRT Isochronous Real-Time.

ISD Integrated Servo Drive

ISD servomotor Designates the ISD servomotor (without the drive electronics).

Installation elevation Installation elevation above normal sea level, typically associated with a de-
rating factor.

L
LCP Local control panel.

Loop cable Hybrid connection cable between 2 decentral servo drives, with 2 M23 con-
nectors.

M
M12 connector Connector (X4) for connecting I/O and/or encoder on the B side of the ad-

vanced version of the ISD 510/DSD 510 servo drive.

M23 connectors Connectors (X1 & X2) for connecting the hybrid feed-in and loop cables on
the B side of the standard and advanced version of the ISD 510/DSD 510
servo drive.

M8 connectors Fully functional real-time Ethernet port (X3) on the B side of the advanced
version of the ISD 510/DSD 510 servo drive. Connector (X5) for connection
of the LCP to the B side of the advanced version of the ISD 510/DSD 510
servo drive.

MSD Multi-axis Servo Drive

Motor shaft Rotating shaft on the A side of the servo motor, typically without a key
groove.

Multi-turn encoder Describes an absolute encoder, in which the absolute position remains
known after several revolutions.

P
PELV Protected extra low voltage is an electricity supply voltage in a range which

carries a low risk of dangerous electrical shock.
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PLC A programmable logic controller is a digital computer used for automation
of electromechanical processes, such as control of machinery on factor as-
sembly lines.

PLCopen® The name PLCopen® is a registered trademark and, together with the

PLCopen® logos, is owned by the association PLCopen®. PLCopen® is a ven-

dor- and product-independent worldwide association, that de�nes a stand-
ard for industrial control programming.

POU Program organization unit. This can be a program, function block, or func-
tion.

PSM Power Supply Module.

PWM Pulse width modulation.

R
RCCB Residual current circuit breaker.

RT Real-time.

Radial force The force in newton acting at 90° to the longitudinal direction of the rotor
axis.

Resolver A feedback device for servomotors, typically with 2 analog tracks (sine and
cosine).

S
SIL 2 Safety Integrated Level II.

SSI Synchronous serial interface.

STO Safe Torque O� function. On activation of STO, the ISD 510 servo drive is no
longer able to produce torque in the motor.

Safety (STO) A servo drive safety circuit that switches o� the voltages of the driver com-
ponents for the IGBTs.

Scope Scope is part of the DDS Toolbox software and is used for diagnosis. It ena-
bles internal signals to be depicted.

Single-turn encoder Describes an absolute encoder, in which the absolute position for 1 revolu-
tion remains known.

Standstill (servo drive) Power is on, there is no error in the axis, and there are no motion com-
mands active on the axis.

System modules This term includes the Power Supply Module (PSM 510), the Decentral Ac-
cess Module (DAM 510), and the optional Auxiliary Capacitors Module
(ACM 510).

T
TwinCAT® TwinCAT® is a registered trademark of and licensed by Beckho� Automation

GmbH, Germany. It is the integrated software development environment
for controllers from Beckho�.

U
UAUX Auxiliary supply, provides power to the control electronics of the ISD 510/

DSD 510 servo drives and the Power Supply Module (PSM 510), Decentral
Access Module (DAM 510), and Auxiliary Capacitors Module (ACM 510).

V
VLT® Servo Toolbox A Danfoss pc software tool used for parameter setting and diagnostics of

VLT® Servo Drive systems
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W
Wireshark® Wireshark® is a network protocol analyzer released under the GNU General

Public License version 2.
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